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Seccion 1

Acerca de la Guia del Usuario Xojo

Esta Guia de Usuario Xojo tiene como objetivo describir Xojo
tanto a los recién llegados a Xojo como a aquellos que ya
cuentan con una experiencia considerable en el entorno.

La Guia del Usuario esta dividida en varios “libros”, cada uno de
los cuales se centra en una area concreta de Xojo:
Fundamentos, Interfaz del Usuario, Framework y Despliegue.

La Guia del Usuario esta organizada de modo que se presentan
los temas en el orden en el que se suelen utilizar generalmente.

El libro Fundamentos comienza con el Entorno de Desarrollo
Integrado de Xojo (IDE) y contindia con el Lenguaje de
Programacion Xojo, Mddulos y Clases. Finaliza con el capitulo
sobre Estructura de la Aplicacion.

El libro Interfaz del Usuario cubre los Controles y las Clases
utilizadas en las aplicaciones Desktop y Web.

El libro Framework se contruye sobre |lo ya aprendido en los
libros Interfaz del Usuario y Fundamentos. Cubre las principales
areas de Xojo como: Archivos, Texto, Graficos y Multimedia,
Bases de Datos, Impresidn e Informes, Comunicacion y Redes,

Concurrencia y Depuracion. Finaliza con dos capitulos sobre
Compilar tus Aplicaciones y el capitulo sobre caracteristicas
Avanzadas del Framework.

El libro Despliegue cubre estas areas: Desplegar tus
Aplicaciones, Despliegue Multiplataforma, Despliegue Web,
Migrar desde otras Herramientas, Gestion del Codigo y
Aplicaciones de Ejemplo.

Copyright

Todos los contenidos son copyright 2014 de Xojo, Inc.Todos los
derechos reservados. Prohibido reproducir parcial o en su
totalidad los archivos relacionados por cualquier via (electronica,
fotocopia, grabacion o cualquier otra), sin el consentimiento
previo por escrito del editor.

Marcas registradas

X0jo es una marca registrada de Xojo, Inc. Todos los derechos
reservados.

Este libro indica nombres de producto y servicios que son
conocidas marcas registradas, o bien marcas de servicios de sus



respectivos propietarios. Se utilizan en este libro solo con vistas
editoriales. Ademas, aquellos términos que puedan ser marcas,
marcas registradas o bien servicios registrados se indican con su
inicial en mayusculas, si bien Xojo, Inc. no puede aseverar la
precisién de dicha informacién. El uso de un término en este libro
no deberia ser visto como una alteracidon de la marca, marca
registrada o marca de servicio. Xojo, Inc. no esta asociado con
los productos o proveedores mencionados en este libro.



Seccion 2

Convenciones

La Guia utiliza capturas de pantalla obtenidas en las versiones de « Aquello que deba de escribirse aparecera entrecomillado, co-
Xojo de Windows, OS Xy Linux. El disefio de interfaz y el conjun- mo por ejemplo “GoButton”.

to de caracteristicas es practicamente idéntico en todas ellas, por
lo que las diferencias entre plataformas son cosméticas y tienen
que ver con las diferencias entre las interfaces graficas.

+ Algunos pasos indican que introduzcas lineas de codigo en el
Editor de Cddigo. Apareceran en este tipo de caja:

- Tipo en Negrita se utiliza para destacar la primera vez que se ShowURL (SelectedURL.Text)
utiliza un término y para resaltar conceptos importantes. Ade-
mas, los titulos de los libros, como Guia de Usuario Xojo, se

indican en cursiva. Al introducir cddigo, observa las siguientes reglas:

- Cuando se indique que selecciones un elemento en los me- + Escribe cada linea impresa en una linea distinta en el Editor
nas, veras algo como “elige File » New Project”. Esto es equi- de Codigo. No unas dos o mas lineas en la misma linea o bien
valente a “elige New Project en el men File.” dividas una linea larga en dos 0 mas lineas.

- Los atajos de teclado consisten en una secuencia de teclas * No afnadas espacios adicionales donde no se incluyan en el
que deben de pulsarse en el orden indicado. En Windows vy Li- codigo mostrado.

nux, la tecla modificadora es Ctrl; en OS X, la tecla modificado-

_ _ « Por supuesto, también puedes copiar y pegar el codigo.
ra es 3 (Comando). Por ejemplo, cuando veas el atajo “Citrl

+0” 0 “38-07, significa que ha de pulsarse la tecla Control en Cuando ejecutas tu aplicacion, Xojo busca errores de sintaxis, Si
Windows o Linux y pulsar a continuacion la tecla “O”, o bien los encuentra, los muestra en un panel en la parte inferior de la
pulsar la tecla 3 en OS X'y pulsar a contunuacion la tecla “O”. ventana principal para que los revises.

Suelta la tecla modificadora solo después de haber pulsado la
tecla de atajo.
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Capitulo 1

Introduccion

Bienvenido a Xojo, la forma mas sencilla de crear
aplicaciones multiplataforma de escritorio y web.
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Seccion 1

Acerca de Xojo

Xojo facilita y simplifica el desarrollo de potentes aplicaciones
multiplataforma de escritorio, web e iOS. Si eres un recién
llegado al mundo de la programacion, encontraras que el
lenguaje de programacion de Xojo es facil de aprender. Si eres
un programador experimentado, veras que el lenguaje es potente
y robusto. En cualquier caso, observaras que lograras avanzar
en un periodo de tiempo realmente breve.

Xojo cuenta con un constructor de interfaces graficas de usuario
(“GUI”) que te permite crear la interfaz gréafica de tu aplicaciéon
sin necesidad de programar (o bien con algo de codigo). Si
sabes como arrastrar y soltar, puedes crear una interfaz. Xojo
proporciona un completo conjunto de controles de interfaz y
también puedes crear tus propios controles.

El lenguaje de programacion de Xojo es un lenguaje de
programacion orientado a objetos compilado, facil de
comprender. Esto significa que utiliza el mismo tipo de
arquitectura moderna empleado por la mayoria de los lenguajes
de programcion empleados en la actualidad (como C++,
Objective-C y Java). Los lenguajes de programacion orientados a
objetos facilitan la escritura y depuraciéon dado que el cddigo se

escribe como bloques independientes que se pueden asimilar a
los objetos del mundo real.

Xojo hace que el desarrollo de aplicaciones resulta mas rapido y
facil en comparacion con los lenguajes tradicionales al eliminar la
necesidad de que se deba aprender cdmo acceder a la interface
de programacion de aplicaciones para el sistema operativo. Esta
Interface de programacioén de aplicaciones (API) esta compuesta
por miles de comandos, ninguno de los cuales has de aprender
cuando creas aplicaciones con Xojo.



Seccion 2

Instalar Xojo

Xojo tiene los siguientes requerimientos hardware y de sistema
operativo:

OS X
IDE

Estos son los requerimientos para desarrollar con Xojo en OS X:

| Soportade |

OS X Lion 10.7 o posterior

OS X Mavericks 10.9 o
posterior para desarrollo iOS

2 GB RAM

Aplicaciones compiladas

Xojo puede crear aplicaciones para cualquier Macintosh Intel con
estas versiones de OS X:

0OS X10.70 0OS X10.70
posterior posterior
Instalacion

Descarga la version mas reciente desde el sitio web de Xojo:

http://www.xojo.com/download/

La descarga consiste de un archivo de imagen de disco (DMG)
sobre el que has de hacer doble clic para abrirlo en el Finder.

Selecciona la imagen de disco en el Finder y arrastra la carpeta
Xojo desde la imagen de disco hacia tu carpeta de Aplicaciones.
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Windows
IDE

Estos son los requerimientos para desarrollar con Xojo en
Microsoft Windows:

Soportado

Windows Vista o posterior

2 GB RAM

Visor PDF para la documentacion

Aplicaciones Compiladas

Xojo puede crear aplicaciones que funcionan sobre estas
versiones de Windows:

Windows

Windows XP SP 3 x86

Windows Vista x86 o x64

Windows 7 x86 o0 x64

Windows 8 x86 o x64

Windows 8.1 x86 o x64

Instalacion

Ejecuta el instalador de Windows para instalar Xojo sobre

Windows.

Linux

IDE

Estos son los requerimientos para desarrollar con Xojo en Linux:

Soportado

Linux Mint 16 o posterior

Ubuntu 10.04 o posterior

Debian 6.0 o posterior

OpenSUSE 11.3 o posterior

Fedora 13 Desktop o posterior

CentOS 6.0 o posterior

2GB RAM
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Aplicaciones Compiladas

Xojo puede crear aplicaciones que funcionan sobre distribuciones
Linux que cumplan estos requerimientos:

Soportado

Linux Mint 16 o posterior

Ubuntu 10.04 o posterior

Debian 6.0 o posterior

OpenSUSE 11.3 o posterior

Fedora 13 Desktop o posterior

CentOS 6.0 o posterior

Linux 64-bit e Informacion de Libreria

Xojo y las aplicaciones creadas con Xojo precisan de estas
librerias:

« GTK+ 2.20 (desktop)

« glib 2.0 (web y consola)

glibc-2.11

libstdc++.50.6.0.13

libicu 4.2+

libwebkitgtk-1.0.0 o libgtkhtml (para HTMLViewer)

En las distribuciones Linux de 64-bit, tendras que asegurarte de
que estén instaladas las librerias que proporcionan
compatibilidad de 32 bits para ejecutar Xojo y las aplicaciones
creadas con Xojo. Por lo general alguno de estos comandos
funcionan sobre Ubuntu:

sudo apt-get install ia32-1libs

sudo apt-get install ia32-libs-multiarch

Las nuevas versiones de Ubuntu pueden precisar de pasos
adicionales:
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sudo dpkg --add-architecture 1386
sudo apt-get update

sudo apt-get install ia32-libs-multiarch

Para mas informacién sobre soporte multiarquitectura:

https://wiki.debian.org/Multiarch/HOWTO

Para determinar qué librerias son utilizadas por Xojo, puedes
utilizar el comando Idd:

ldd Xojo

Web

Las aplicaciones web consisten de dos partes, el componente
servidor y la interfaz de usaurio que funciona en un navegador
web. El componente servidor tiene los mismos requerimientos
que la plataforma para la cual estas compilando.

Las aplicaciones web soportan los siguientes navegadores web:

Navegadores Web Soportados

Chrome

Firefox

Safari

Internet Explorer 8+

Safari Movil (i0S)

Chrome para dispositivos Android

iI0S

Solo la version de Xojo para OS X puede abrir y crear apps iOS.

También hay que tener en cuenta otra serie de requerimientos del

IDE:

« OS X Mavericks 10.9 o posterior
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« Xcode 6.1 (para el Simulador iOS)

Las apps iOS creadas con Xojo funcionan sobre estas versiones
de iOS:

- i0S7

- i0S 8

Se soportan estos dispositivos iOS:
- iPhone 4S y posteriores

- Todos los iPad mini

- iPad 2 y posteriores

- iPod touch (modelo actual)

Se precisa de una cuenta de pago como Desarrollador Apple iOS
para:

- Enviar las apps creadas a la App Store

14



Seccion 3

Primeros Pasos

Conectar con el Xojo ID
Debes conectar utilizando tu cuenta Xojo para que Xojo utilice

tus licencias.

Figura 1.1. VVentana de conexion Xojo ID

Sign in to your Xojo account

If you have a Xojo ID, sign in with it here. If you have used Feedback or
the Xojo website, you already have a Xojo ID. If you do not have a Xojo
ID, click New Xojo ID.

Xojo ID: |

Password: |

New Xojo ID

[ Cancel ]\ Signin |

Introduce tu Xojo ID y contraseia y haz clic en el botdn Sign
para acceder. Una vez realizado, se aplicaran cualesquiera
licencias asociadas con la cuenta.

Puedes consultar tus licencias en la pestana Licenses de la
ventana About. Apareceran las licencias disponibles junto con la

fecha en la que expiraran y el email con el que estan registradas.

Utiliza el botdn Download para forzar a que Xojo compruebe la
disponibilidad de

nuevas licencias. ) . :
Figura 1.2. Pantalla de Licencias en la

También puedes ventana About

utilizar el botén Add
para afadir — s

Console 12/4/13 paul@realsoftware.com
Database Servers 12/4/13 paul@realsoftware.com

m an u al m e nte Web 12/4/13 paul@realsoftware.com

Desktop 12/4/13 paul@realsoftware.com

archivos de licencia.
El boton Remove

desvincula las ) [ emove

licencias. [_aon T

Puedes acceder a tu

cuenta de usuario en

el sitio web de Xojo para ver las licencias disponibles, descargar
archivos de licencia y para comprar o renovar licencias.

http://www.x0jo.com

Guia Rapida y Tutoriales
Si eres un recién llegado al mundo de la programacion deberias

de comenzar con la Guia Rapida y continuar con el Tutorial, ya
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sea para aplicaciones Desktop o Web. Estas guias te
proporcionaran una buena referencia sobre Xojo y te introduciran
en el lenguaje de programacion.

A continuacion, lee la Guia de Usuario Xojo. Esta guia te
proporciona informacién detallada sobre Xojo, su lenguaje de
programacion, los controles de interfaz de usuario, el framework
y otras caracteristicas. Cuando precises detalles sobre un control
o comando del lenguaje especifico, consulta la Referencia del
Lenguaje en linea:

http://docs.xojo.com
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Seccion 4

Ayuda en Linea

Inicio Répido, Tutoriales y Guia del Usuario Utiliza las flechas de la cabecera para retroceder o avanzar por
Las gufas de Inicio Rép|do, los Tutoriales y la Guia de Usuario los elementos visitados. El boton Home te lleva de nuevo a la
Xojo se incluyen en formato PDF. Estos libros estan ubicados en pagina con el listado
la carpeta Documentation y de categorias y - 14 Yolo L mof

., : : igura 1.4. Xojo Language Reference
tambien son accesibles desde el ) ) subcategorias. W?nd oW J guag

, : Figura 1.3. Menu Help de
menu Help en Xojo. Xoi ) 00

OJO Cuando estés P @O @

. . . arc D | 1A \ 1
Si preﬂeres leer estos libros con Newin s teme - programando también atogory Discusion S L —
. . . T N , ), Category:Language Reference
iBooks para iOS o iBooks para e contaras con una i e
Mac, puedes encontrarlos en la s S ayuda sensible al = .

Introduction to Programming . ::;:m changes B.yc:'::er:\e B.yAIanys e
iBooks Store (busca “Xojo”) o la contexto. Selecciona o g
Wiki de Documentacion. el elemento en el L e
Editor de Cédigo para o | o
Referencia del Lenguaje el que desees obtener e -
La Referencia del Lenguaje esta incorporada en Xojo. Para ayuda y haz clic Peges ncatgory Languege Reerence!
acceder a ella, selecciona Help » Language Reference (F1 en derecho (Control-clic A e, PR
-Acgs o . :gunemMeihodName G
Windows y Linux o 8-? en OS X) o usa el boton Help en la barra en OS X). Aparecera e Emmm
de herramientas. Haz clic sobre el nombre de una categoria para un menu contextual. e o
ver las subcategorias, y haz clic sobre una subcategoria para ver Selecciona la entrada
los elementos del lenguaje. Haz clic sobre un elemento para “Help for temName” y Xojo abrira la Referencia de Lenguaje
desplegar la informacion. para el elemento deseado. También puedes mantener pulsada la
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tecla Comando (tecla Control en Windows y Linux) al tiempo que
haces doble clic sobre un elemento para acceder a la Referencia
del Lenguaje asociada.

Cuando accedes normalmente a la Referencia del Lenguaje
desde Xojo, estaras accediendo a la versiéon en linea para contar
con la documentacion mas actualizada. Pero habra ocasiones en
las que quieras consultar la Referencial del Lenguaje sin que
estés en linea. Cada revision de Xojo incorpora una copia de la
Referencia del Lenguaje.

Para acceder a la Referencia del Lenguaje local, selecciona Edit
- Options (o0 Xojo » Preferences en OS X) y elige la pagina

General. La seccion “When seeking help” permite indicar si se
desea usar la documentacion en linea o la incorporada.

Figura 1.5. Elegir la Referencia del Lenguaje en linea o la
incorporada.

When seeking help: () Use built-in documentation
(*) Go online for most recent documentation

En OS X, también puedes mantener pulsada la tecla Opcién
cuando accedes a la Referencia del Lenguaje en el menu Ayuda
para modificar temporalmente este ajuste.

Usar la Wiki de Documentation
Ademas de la documentacion accesible desde Xojo, también hay

una Wiki de Documentacion accesible desde el navegador web:
http://docs.xojo.com.

La wiki contiene la Referencia del Lenguaje, articulos, consejos y
otra informacion de utilidad.

Figura 1.6. Pagina Inicio en
la Wiki de Documentacion.

S1oam
-
Page Discussion Read View source View history Go J ( search |
&7 MainPage
0).
:
@ Wherever properties and me to

Language Reference

ailable in PDF and iBooks (for iPad) formats. You can access the

QuickStarts
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Seccion 5

Proyectos de Ejemplo

Xojo incluye una amplia variedad de proyectos de ejemplo que + Desktop

demuestran muchas de sus caracteristicas y funciones.
* Files

Los Proyectos de Ejemplo estan disponibles usando la ventana

. L . *  Framework
Project Chooser que aparece cuando se inicia Xojo (consulta el

Capitulo 2, Seccion 1 «  Graphics and Multimedia

para informacion
Figura 1.7. Selector de Proyecto, - Language Features

adicional sobre el )
mostrando los ejemplos.

Selector de Proyecto). . Platform-Specific

Los proyectos de - Printing and Reporting

ejemplo estan

agrupados en estas - Sample Applications

» {2 Printing and Reporting
» {3 Sample Applications

carpetas:

+ Text

« Advanced : :
+ Unit Testing

«  Communication

- Web
- Console _ _ _

Cuando seleccionas un proyecto de ejemplo, Xojo abre una
« Database copia del mismo. Puedes modificar y guardar esta copia en

cualquier ubicacién que desees.
+ Design Patterns
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Seccion 6

Feedback

Informacion de Contacto
Método de

Informacion de Contacto

Atencion al Cliente/Ventas: custserv@xojo.com

Email
Soporte Técnico: productsupport@xojo.com
Web https://www.x0jo.com/support/
Xojo, Inc.
Correo PO Box 162181

Austin, TX 78716

Informar de Bugs y Solicitud de

Caracteristicas
Si crees haber encontrado un bug en Xojo o tienes una solicitud

de caracteristica, por favor haznoslo saber. El mejor modo de
informar sobre bugs o de realizar solicitudes de caracteristicas
es con la aplicacién Feedback (http://www.xojo.com/feedback/).

Feedback esta disefiado para recopilar toda la informacion
necesaria que nos permite trazar bugs e implementar solicitudes

de caracteristicas. Por cada bug o solicitud de caracteristica
reportada (denominada case), recibiras un mensaje de
confirmacion por correo electronico con el nimero de caso.

Cuando se actualizan los casos, recibes un email informando
sobre el cambio.

Puedes ejecutar la aplicacién Feedback E'g[‘g;a 1.8.
Feedback directamente desde Xojo. Solo has Feedback.

de seleccionar Help » Xojo Feedback o hacer

clic en el boton Feedback de la barra de
herramientas. Si ya tienes instalado Feedback,

esta accion abrira la aplicacion. Si aun no has
instalado Feedback, se abrira tu navegador por
omision en la pagina de Feedback.

Si no tienes email, puedes enviarnos tus informes de bugs y
solicitudes de caracteristicas por correo o bien por fax.

Crear buenos Casos de Feedback
Cuando creas un caso de Feedback, lo mejor que puedes hacer

es proporcionar informacién detallada.
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A continuacién estan las descripciones de los campos que has
de completar cuando crees un caso de Feedback:

Summary

Proporciona un resumen descriptivo del problema. Debe describir
el problema en cuestion.

Ejemplos:

Un mal Resumen Un buen Resumen

Xojo se cuelga en Linux 64-
bit al no encontrar librerias
de 32-bit

Xojo se cuelga

Listbox no funciona cuando

Listbox no funciona hay méas de 64 columnas

Product

Selecciona el producto Xojo relacionado con el caso.

Category

Algunos productos tienen categorias. Selecciona la categoria
mas relacionada con este caso.

Case Type

Los casos suelen ser bien Bug o Feature Request.

Details

Proporciona una informacién mas detallada del caso. En el caso
de un bug, proporciona detalles concretos sobre cédmo reproducir
el bug. Algunas cuestiones importantes a incluir:

« El problema que ha ocurrido.
+ Los pasos a realizar para reproducir el problema.
+ Lo que esperabas que ocurriese.

Para la Solicitud de Caracteristicas, incluye informacién sobre lo
que necesitas llevar a cabo. Procura evitar las sugerencias
relativas a la implementacion.

Workarounds

Si has encontrado alguna alternativa para evitar el problema, por
favor incliyelo aqui. Esto ayudara a otros que también puedan
haberse topado con el problema.

Attachments

El mejor modo de demostrar un bug es incluyendo un proyecto
de ejemplo. Por favor, toma un momento para realizar un
proyecto de ejemplo que muestre el problema y adjuntalo.

Include System Data

Feedback puede recopilar informacion sobre tu sistema, como el
sistema operativo, version de Xojo, plugins y mucho mas. Por
favor, permite que Feedback incluya dicha informacién.
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Capitulo 2
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Seccion 1

Selector de Proyecto

El Selector de Proyecto
La ventana del Selector de Proyecto aparece cada vez que se

ejecuta Xojo y cuando seleccionas File » New Project.

Figura 2.1. El Selector de Proyecto.
N O O U 5. 1122 3 8+ S —

Application Name: Il l

Company Name: IMy Company |

Application Identifier: I com.mycompany.myapp |

New Projects
El Selector de Proyecto permite decidir rapidamente con qué

proyecto quieres trabajar. Puedes elegir entre crear un nuevo
proyecto de Escritorio, Web, Consola o iOS.

Recent Projects

Puedes ver los proyectos utilizados ultimamente y elegir cual de
ellos quieres abrir.

Templates

Las Plantillas son proyectos de Xojo guardados en la carepta
Templates junto con la aplicacidon Xojo.

Si tienes un grupo de modulos, clases o cualquier otro elemento
utilizado con frecuencia, afadelos a un proyecto y guardalo en la
carpeta Templates. Cuando abras una plantilla, obtendras un
nuevo proyecto que ya contenga todos los elementos de uso

frecuente.

Xojo incluye plantillas para crear Aplicaciones de Servicio,
Aplicaciones CGl y Aplicaciones de Consola dirigidas por
Eventos.
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Examples

La seccion Examples te permite ver los proyectos de ejemplo
incluidos con Xojo. Los ejemplos te muestran como puedes
utilizar determinadas caracteristicas y funciones de Xojo.

Cuando seleccionas un ejemplo, se abre en un nuevo proyecto
para que puedas ejecutarlo, editarlo o guardarlo donde desees.

Abrir un Archivo Existente

Puedes abrir un proyecto Xojo existente haciendo clic en el boton
Open an Existing File button. Aparecera un dialogo de seleccion
de archivo que te permitira elegir el archivo a abrir.

También puedes arrastrar un proyecto Xojo sobre el icono de
aplicacion Xojo (en el Dock o sobre el Escritorio) o bien haciendo
doble clic sobre un proyecto de Xojo.
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Seccion 2

Espacio de trabajo

IDE

Xojo es un Entorno de Desarrollo Integrado (IDE). Esto significa
que todos sus componentes (editor de disefio, editor de cédigo,
compilador, y depurador) estan integrados en un Unico paquete.
En los lenguajes de programacion convencionales, estos
elementos suelen corresponderse con diferentes aplicaciones.

Figura 2.2. El Espacio de Trabajo de Xojo.
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Cuando abres Xojo por omision todos los elementos del
proyecto estan organizados en una Unica ventana denominada el
Espacio de trabajo. Dentro de esta ventana puedes navegar
entre los elementos de proyecto haciendo clic sobre sus
nombres. También puedes elegir abrir items de proyecto en sus
propias pestanas.

Puedes tener mas de un proyecto abierto a la vez; cada uno
mostrando su propio espacio de trabajo.

Espacio de trabajo
La ventana principal que se ve tras seleccionar un proyecto se

denomina el Espacio de trabajo. Es dentro de esta ventana
donde tiene lugar todo el desarrollo de Xojo. Puedes abrir
multiples ventanas de espacio de trabajo para un Unico proyecto

usando File » New Workspace, lo que puede resultar util cuando

se utilizan multiples pantallas.
El Espacio de trabajo consta de estas areas:
- Barra de Herramientas

- Navegador
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- Editor
- Libreria/Inspector

« Paneles

Figura 2.3. Barra de herramientas del Espacio de trabajo.
L Btnd >% @0 % 0

lelp Feedback Library Inspector

Estas son las areas descritas en las proximas secciones.

Barra de Herramientas del Espacio de Trabajo

La barra de herramientas en la parte superior de la pantalla
principal se denomina barra de herramientas del Espacio de
trabajo. Incluye estos botones:

« Insert
Muestra un menu de elementos que pueden anadirse al
proyecto o proyecto seleccionado.

- Back
Utilizado para regresar al ultimo elemento mostrado en la
pestana.

- Forward
Avanza por el histérico de navegacion de la pestana.

« Run
Utilizado para ejecutar tu proyecto en “modo depuracion”.

- Build
Crea una compilacién autonoma de la aplicacién para las
plataformas indicadas.

« Help
Muestra la ventana de Referencia del Lenguaje.

« Feedback
Abre |la app Feedback.

- Library
Alterna la vista de la Libreria.

« Inspector
Alterna la vista del Navegador.

Puedes ocultar la barra de herramientas seleccionando View »
Hide Toolbar.

Modo de Pantalla Completa

En OS X también puedes hacer clic sobre el botdn de “pantalla
completa” de la ventana, para que el Espacio de trabajo pase a
modo de pantalla completa.

En modo de pantalla completa se ocultan la barra de menus
principal y el titulo de la ventana. Para ver la barra de menus
principal, mueve el cursor en la parte superior de la pantalla. Para
salir del modo de pantalla completa, haz clic sobre el icono de
pantalla completa en la barra de menus.
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Seccion 3

Navegador

¢ Qué es el Navegador?
El Navegador es el area de la barra lateral izquierda que permite

navegar por el proyecto. El Navegador tiene estas secciones:
Contents, Run, Profiles y Build Settings.

La seccion Contents contiene )
Figura 2.4. Navegador.

los elementos del proyecto

L , Q Filter B[

anadidos con el boton Insert, ( i

como ventanas, paginas web, = untitled i
CONTENTS

clases, menus y carpetas. 5
» & Ao

i Windowl

» [EJ MainMenuBar

Puedes hacer clic en los items

de proyecto en Contents para

verlos editarlos. o I B

.~ Shared
Cuando se selecciona un item, 0 osx
puedes utilizar las teclas de | Windows

| Linux

cursor para moverte por los @ This Computer

elementos..

La seccion Run solo esta disponible en la pestafa del Debugger
al ejecutar el proyecto.

La seccion Profiles solo aparecer cuando tienes activado el
perfilador (Profiler) y ejecutas tus apps en modo de depuracion
para obtener los datos de perfilado.

La seccion Builds Settings contiene toda la informacion
relacionada con la compilacion, incluyendo las plataformas de
destino para las que se va a compilar (junto con sus ajustes) y
los pasos activos de compilacion utilizados por Build Automation
(Automatizacion de Compilacion).

Filter

El Navegador tiene un

campo Filter en la parte Figura 2.5. Usar el Filtro.

superior que puede Q Add o)l
utilizarse para filtrar los & EEDesktop <« >
CONTENTS

contenidos mostrados en (@) strings.Addinvoice

(«3) Strings.Address

(«3) Strings.Add

(«3) Strings.AddressLowercase

iTJ CustomerDetailsWindow.Controls.AddressField

|__| CustomerDetailsWindow.Controls.AddInvoiceButton
[=] InvoiceDetailsWindow.Controls.AddItemButton

|3y ChartWindow.LoadData

|=| OrdersDatabase.AddInvoiceltem

|=| OrdersDatabase.AddInvoice

la seccion Contents.
Utiliza el Filtro para ver de
forma rapida elementos
concretos del proyecto.
Por ejemplo, si sabes que
tienes un método
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denominado “AddInvoice”, pero no recuerdas en qué clase o
ventana esta, solo has de teclear “Add” en el campo Filter. El
Navegador mostrara cualquier elemento de proyecto que incluya
“Add” en su nombre (método, nombre de control, constante o
propiedad).

Entonces puedes hacer clic sobre el item de proyecto para verlo
o editarlo.

Barra de Salto
El Navegador muestra los items en un listado jerarquico. El

ambito de lo mostrado queda controlado por la Barra de Salto.
Por omision todo el proyecto esta visible, de modo que la Barra
de Salto muestra el

nombre de .
Figura 2.6. Uso de la Barra de Salto.
proyecto. .
|| AboutWindow ~ 4 >
] La
Cuando haces [ Layour
Vv @y Controls
doble clic sobre un Aa Infolabel

» |[Z] LogoCanvas
» || OKButton
» Aa VersionLabel

item que es padre,
|la Barra de salto
cambia para
mostrar el padre
(esto se suele denominar “profundizar en” en el item de
proyecto). Ahora se muestran en el Navegador sélo los elementos
que son hijos del Padre seleccionado.

Nota: El ajuste “Double click opens item in new tab” de las Preferencias
modifica este comportamiento. Cuando dicho ajuste esta activo, al hacer

doble clic se abre el elemento en una nueva pestalla, de modo que usa
Opcion+38 al hacer doble clic sobre un elemento de proyecto para
profundizar en él (en Windows y Linux, usa Shift-Control).

Haz clic en el nombre en la Barra de Salto para ver todo el

histérico y saltar con rapidez a un elemento concreto del

historico.

La Barra de Salto es increiblemente
potente cuando se utiliza con
pestanas, dado que te permite
centrar la pestafna en el elemento
concreto sobre el que estas
trabajando.

Contents
La seccion Contents muestra los

items de tu proyecto.

Puedes hacer clic sobre los items de
proyecto en esta seccion para verlos
o editarlos.

Figura 2.7. Navegador
con multiples elementos
seleccionados.

& EEDesktop ~ <4 >
CONTENTS
» & App
v (] User Interface
> e Strings
» |E5 MainMenuBar

» || AboutWindow

» (. Controls
» @@ Chart
» (. Graphics
» () Database

Cuando se selecciona un elemento, puedes utilizar las teclas de

cursor para mover la seleccion entre elementos.

Puedes hacer las cosas habituales como borrar, copiar o pegar

elementos de proyecto. También puedes arrastrar elementos de

proyecto para reorganizarlos o para moverlos entre elementos de

proyecto.
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Por ejemplo, puedes arrastrar un método desde una clase a otra
clase para moverlo.

Ademas, es posible )
Figura 2.8. Seccion Run mostrada en

una nueva Pestana.
) EddiesElectronics & E

i | =08 [

seleccionar

multiples objetos.

Por ejemplo,

puedes seleccionar " | < > | private ¢
una Clase y una ® EddiesElectrc - Dim cus
Ventana y - custome
arrastrarlos a una

Carpeta.

Run

La seccidon Run aparece en una

pestafna separada cuando se Figura 2.9. Seccion

ejecuta el proyecto, causando que Perfiles.
el nombre de la App aparezca en el PROFILES
Depurador. En el caso de que debas v = Pf°ﬁ'°5

E ofnle Data -~

de navegar a otra seccion del

proyecto, haciendo clic en esta

pestafia mientras que se ejecuta el programa, volvera a mostrar
el depurador.

Profiles
Si ejecutas tu app con Profiling (perfilado) activado, aparecera la

seccion Profiles al salir de la aplicacidon. Puedes revisar los
resultados del Perfilador en esta seccidn.

Build Settings

La seccion Build Settings se utiliza

Figura 2.10. Build
Targets con el Build de
Windows seleccionado
y mostrando los Pasos
de Compilacion.

BUILD SETTINGS

para ver y modificar la informacion
necesaria para compilar y ejecutar
tu proyecto.

., . ., -~ Shared
La seccion Build tambien muestra —
v [] OSX
las diversas opciones de OS de $%2 Build
salida disponibles. “This [ 2} CopyFilesMac
Computer” esta seleccionado por v [/ windows
_y . . §%% Build
omision y contiene los ajustes para
B o Q CopyFilesWin
la plataforma que estés utilizando. S
v [J Linux
§% Build

Activa la casilla de verificacion
Q CopyFilesLinux

asociada con otros destinos para [ This Computer

crear una compilacion para ella la
proxima vez que compiles el proyecto. Haz clic sobre un destino
de compilacion para modificar sus ajustes en el Inspector.

La seccidon Build también es donde puedes gestionar los Build
Steps (Pasos de Compilacion). Ahades nuevos Pasos de
Compilaciéon usando el botdn o menu Insert. Pueden anadirse
nuevos Pasos de Compilacién al area Contents, pero no se
ejecutaran en ese caso. Para activar un Paso de Compilacidn,
arrastralo sobre el OS de destino apropiado. Los pasos que estan
antes del paso “Build” por defecto tendran lugar antes de
compilar el proyecto, y los pasos situados tras él tendran lugar
una vez que se haya compilado el proyecto.
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Para desactivar un Paso de Compilacion, arrastralo fuera del
Target nuevamente hacia el area de contenidos.

Figura 2.11. Espacio de trabajo con multiples pestanas.

eo0e EEDesktop

super [Window [z]

Behavior

Placement | Default 3]

visible @I

Full Screen  (7) OFF

Live Resize (@
Implicit Instance @I
Size

Width [370 Height [g7 |
Min Width ]ﬁ Min Height /54—'
Max Width ]W\ Max Height ’W‘

Frame

Type | Sheet Window +
Title | search Customers
eable (7) OFF

QAN

Los Pasos de Compilacion correspondientes a proyectos pre-
Xojo se situan automaticamente en el destino apropiado cuando
se abre el proyecto.

Pestanas
Una pestana es simplemente otra vista de tu proyecto. Cuando

creas una nueva pestafa obtienes nuevas areas del Navegador y
del Editor.

Puedes navegar a cualquier parte que desees en la pestana, tal y
como harias si no hubiese pestafas. Todo funciona exactamente
del mismo modo, salvo que ahora tienes varias vistas del
proyecto, cada una mostrando su propia informacion.

Las pestanas pueden ser un modo genial de tener a mano
aquellos elementos utilizados con mas frecuencia, especialmente
cuando se utilizan en combinacion con la Barra de salto.

Para abrir un proyecto en una pestana utiliza el menu contextual
y seleccionar “Open in New Tab”. También puedes usar Opcién
+38 al hacer doble clic sobre un elemento de proyecto para
abrirlo en una nueva pestana (en Windows y Linux, usa Shift-
Control). También existe una preferencia para abrir los elementos
de proyecto en una nueva pestana al hacer doble clic sobre ellos.

Nota: El ajuste “Double click opens item in new tab” de las Preferencias
modifica el anterior comportamiento. Cuando esta activo, al hacer doble clic
se abre el elemento sobre una nueva pestana. Usa Opcion+38 al hacer
doble clic sobre un elemento para profundizar en sus contenidos (en
Windows y Linux, usa Shift-Control).

Figura 2.12. Barra de Pestanas con rebase.

BasePushButton
ChartWindow
DataPoint

Las pestanas pueden estar blogueadas o desbloqueadas. Una
pestafna blogueada no cambiara sus contenidos cuando hagas
clic sobre los resultados del Filtro o la Busqueda, asi como

30



cuando utilices Go To Location. En estos casos se utilizara una
nueva pestana (o la préxima disponible que esté desbloqueada).

Haz clic sobre la pequefia “x” de la pestafa para cerrarla. Mantén
pulsado Opcidén (en OS X) o Alt (en Windows o Linux) para cerrar
todas las pestafias excepto la situada mas a la izquierda.

Si abres mas ventanas de las que pueden mostrarse en la barra
de pestanas, aparecera un icono de “rebase” en el que podras
hacer clic para acceder al menu que contiene el resto de
pestanas disponibles. Al seleccionar una pestana en el listado se
sustituye la que esté activa en ese momento.

Puedes cambiar entre pestafias usando 38 +Shift+[ o 3 +Shift+].

Anadir Elementos de Proyecto
Usa el botdn Insert de la barra de herramientas o el menu Insert

para afadir nuevos elementos de proyecto.

También puedes afnadir nuevos elementos de proyecto
arrastrando un control directamente desde la Biblioteca (Library)
hacia el Navegador. Esto crea una subclase del control.

Nota: Los elementos de proyecto no pueden nombrarse “Xojo”.

Xojo comparte los siguientes elementos de proyecto tanto para
los proyectos de escritorio como web:

« Class

» Class Interface

ContainerControl

File Type Set

Folder

Module

Database

Build Steps

- Copy Files

- Script

« External Script

Estos elementos son especificos de los proyectos de escritorio:
« Menu Bar

-+ Report

- Toolbar

- Window

Estos elementos son especificos de los proyectos web:
- Web Page

- Web Dialog

31



- Web Style

Go To Location
Si conoces su nombre, puedes saltar a un elemento especifico

del proyecto utilizando la caracteristica Go To Location (Ir a
Ubicacion).

Elige Project » Go To Location para acceder a la ventana

correspondiente. Introduce el nombre del item de proyecto al que
quieras ir y pulsa Return (o haz clic en Go). El Navegador lo
seleccionara.

Imprimir
Puedes imprimir tu codigo fuente usando File » Print en el mend.

Cuando tengas elementos de proyecto seleccionados solo se
imprimiran estos.

Si no existe una seleccion, se imprimira todo el proyecto.

Usar Elementos de Proyecto en el Navegador
Puedes hacer clic derecho (Control-Clic en OS X) sobre cualquier

elemento del proyecto en el Navegador para acceder al menu
contextual. En el menu contextual tienes las siguientes opciones:

- Add to
Utiliza este comando para afadir cédigo como manejadores de
evento, métodos, propiedades, etc, al elemento de proyecto.

« Inspect

Muestra el Inspector para el elemento de proyecto.

« Cut/Copy

Corta o copia el elemento de proyecto al portapapeles.

- Paste

Pega un elemento de proyecto del portapapeles al Navegador,

andiéndolo al proyecto.

« Delete

Borra el elemento de proyecto. Para llevarlo al portapapeles,

utiliza Cut.

+ Duplicate

Crea una copia del elemento de proyecto en el Navegador.

« Make External/Internal

Los items externos se pueden utilizar para compartir elementos

de proyecto entre proyectos. Dirigete a la Guia de Desarrollo,

Capitulo 5 para obtener informacion adicional sobre los

elementos de proyecto.

« Encrypt/Decrypt
Dirigete a la Seccién 10,
“Tipos de Proyecto,
Formatos y Plantillas”
para obtener informacion
adicional sobre el cifrado

Figura 2.13. Ventana Ir a
Ubicacion.

p
. Go To Location

Go to location:

[ Go

J [ Cancel
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d iptado de | | tos d to. :
y aesencriptado de los elementos de proyecto Figura 2.15. Ventana de Comportamiento

del Inspector.

- Export
Usa esta opcidn para exportar un elemento de proyecto a un CustomPushButton? Property List:
Declaration Default Value Enumerations
archivo. Este es un modo util de compartir un elemento con < Veible as Boolean  True [ None :]
HelpTag as String
@ AutoDeactivate as ... True Va... Label
otra persona. o ButtonStyle as Butt... 0 : )
Font
@ TextFont as String  System
™ TextSize as Single 0
H @ TextUnit as FontUnits 0
Figura 2.14. VVentana para o ot as Fon
Implementar Interface. © italic as Boolean
@ Underline as Boolean
This refactoring adds an intert . ¢ intert Initial State
Culsstéfn::l‘;nB?ﬁt:nZsr::rle"s‘:nt:fih!:n(azgse ‘(:e ::erh:;zsdedared [ InitialParent
by that interface to the class. Behavior
[ RecordSetInterface ™
( Reports.Dataset
( SQLiteBackuplinterface
D S - (Ganei ) [0k

tuplelnterface
WebEventThread
Writeable

[ Include "#error" in the source of each method

de proyecto. Las interfaces se cubren en el Capitulo 5, Seccion

| cancel | | oK | 5.
. Print - Inspector Behavior
Imprime todo el cédigo fuente del elemento de proyecto. Abre la lista del Inspector Behavior (Comportamiento del

Inspector) donde puedes personalizar las propiedades que se

» New Subclass mostrara en el Inspector para las clases y controles afiadidos

Crea una nueva clase en el Navegador que utiliza el item de en los disefios. Puedes optar por mostrar las propiedades para

proyecto como su superclase.. tus clases y subclases personalizadas, asi como ocultar las

. Implement Interface propiedades que se suelen mostrar por lo general. Anade

Te permite seleccionar una interfaz que contenga los métodos a nuevas propiedades utilizando el boton "+ situado en la parte

implementar para la clase. Cuando seleccionas la interfaz (o inferior izquierda del listado de propiedades. Activa o desactiva

interfaces) a afadir, los métodos de la interfaz se afiaden al item la casilla de verificacion asociada al nombre de la propiedad

para determinar si sera visible en el Inspector. También puedes
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indicar valores por defecto para cualquiera de las propiedades
mostradas. Arrastra las propiedades del listado para
reordenarlas o cambiar su grupo en el Inspector. Usa la seccidn
Enumerations para anadir una lista de valores que pueda utilizar
el usuario mediante un menu desplegable.

Edit Super Class
Muestra la (super) clase padre de la clase actualmente
seleccionada. Este item solo aparece para las subclases.
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Seccion 4

Editores de diseino de Ventana y Pagina Web

Disenar tu Interfaz de Usuario
Los editores de disefio de ventana y pagina web son los

principales editores utilizados para el disefio de la interfaz de
usuario de la aplicacion.

Area de Diseno
El Area de Disefio (Layout Area) puedes mostrar tanto una

ventana como una pagina web, en funcion del tipo de proyecto.
En cualquier caso, afiades controles a este area arrastrandolos
desde la Biblioteca o el Navegador hasta el Area de Disefio.

Barra de Herramientas
El Editor de Diseno tiene su propia barra de herramientas con las

Figura 2.16. Barra de Herramientas del Editor de Diseno.

siguientes caracteristicas de izquierda a derecha:

Anadir
El botdn Add se utiliza para afadir elementos relacionados con el
codigo en la ventana o pagina web. Esto incluye:

Manejador de Evento (consulta el apartado sobre Event
Handler a continuacion)

Manejador de Menu
Método

Nota

Propiedad
Propiedad Calculada
Constante

Delegado
Enumeracion
Definicion de Evento
Método Externo
Popiedad Calculada Compartida

Método Compartido
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« Propiedad Compartida

« Estructura

Ver Diseno

Este boton esta agrupado junto con Ver Cédigo como un
conmutador. Cuando se ve el diseno, este es el botdn
seleccionado.

Cuando no se esta viendo un disefo, puedes hacer clic en este
botdn para volver al Editor de Disefio para ver el ultimo elemento
sobre el que estuvieses trabajando.

Ver Codigo

Este boton esta agrupado con Ver Disefio como un conmutador.
Cuando se ve un disefio se puede usar este boton para volver al
Editor de cddigo del ultimo elemento editado.

Definir Valor por Defecto

Este boton te permite definir el valor por

cambios accidentales en Figura 2.18. Mostrar Medidas.

la interfaz mientras que

se esté viendo.

Mostrar Orden de
Tabulacion
Muestra el orden de
tabulacién de cada
control en el Editor de
Orden de Tabulacion.
Los controles del disefio aparecen en el editor segin su orden de
tabulacion. Puedes arrastrar los controles para cambiar su orden
de tabulacién en el disefio.

@- Mostrar Medidas

El botdn Mostrar Medidas facilita la revision del disefio. Cuando

se activa puedes mover el ratdn sobre los controles para ver

medidas, como la distancia del control sobre la parte superior de
la ventana o pagina web. Selecciona varios

defecto para varios controles. Consulta la Figura 2.17. Editor de Orden de controles para ver multiples medidas, como las
Tabulacion. i i
entrada sobre Valores por Defecto a o distancias entre los controles.
.00 Tab Order Editor
ContlnuaCIén- ustomerList
<L:abell -( l#;Strings.Las(N‘alme) Orden
[ LastNameField
.. AaLfabeIZ -(#-Strings.FirstName)
Bloquear Posicidn el Los botones de Orden (Adelantar, Traer
El botén Bl Posicid i E;ﬁ{;‘;‘iﬁmgs.atw delante, Atrasar y Llevar al fondo) se utilizan
oIon BoAUEar FOSIEIon se Hiflea bara o~ s s para modificar el orden de capa de los
bloquear los controles de modo que no se pa sl Fins 2 e
X8 Lo — #Strings Emall) controles sobre el diseno.
puedan mover. Puedes usar esta L EmaifFeld
Aa Label8 -( #Strings.Phone )
s . . ilJ PhoneField
caracteristica para evitar que se produzcan o TaxableCheck - #Strings. Taxable ) Completar

[ cancel | | OK ]

36



Los botones Completar Ancho y Completar Altura expanden el
control seleccionado para que cubran el espacio restante de su
contendor.

Alineacion
Los botones de Alineacion (Alinear Izquierda, Alinear Derecha,

Alinear Superior y Alinear Inferior) se utilizan para alinear los
diferentes controles del disefo, el uno respecto del otro.

Espaciar

Los botones Espaciar Horizontal y Espaciar Vertical alinean los
controles seleccionados para
distribuirlos de forma equitativa.

Figura 2.19. Ventana
con un Timer en la
Bandeja.

Bandeja

Algunos controles anadidos al
disefio no forman parte en realidad
de la ventana o la pagina web, tal y
como ocurre por ejemplo en el
caso del Timer.

Cuando anades este tipo de
controles al disefo aparece
automaticamente una Bandeja (Shelf) en la parte inferior del
Editor de Disefno y el control se muestra sobre esta. En las
aplicaciones Web, los Didlogos Web también aparecen en esta
bandeja.

En las aplicaciones de escritorio, una barra de herramientas
anadida a una ventana
aparece en la bandeja.

Figura 2.20. Definir el valor por
defecto de un PushButton.

Valores por

Defecto
Se puede definir el

Lintitled

Set PushButtonl Caption

valor por defecto de un
control en el Editor de
Diseno pulsando la
tecla Retorno con el
control seleccionado, o bien haciendo clic en el botén del Lapiz
que aparece cuando mueves el ratdn sobre un control, o
haciendo clic en el boton Set Default Value de la barra de
herramientas en el Editor de Disefio. Esta accion abre una ventan
pop-out para introducir el valor por defecto. Por ejemplo, en el
caso de un PushButton puedes introducir su etiqueta. Para cerrar
la ventana pop-out, pulsa Retorno, haz clic fuera de dicha
ventana o haz clic en el botdon “Set Default Value” de la barra de
herramientas del Editor de Disefo.

Manejadores de Evento
Para anadir un manejador de evento a tu control, haz clic en el

botdn Add y selecciona Event Handler.

Esta accion abre Add Event Handler Dialog en el que se
muestran los eventos disponibles para el control (o la ventana o
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pagina web si

esta fuese la Figura 2.21. Didlogo para afnadir Manejador

seleccionada). de Evento.
HaZ CI|C en Add Event Handler to Window1l
aximize he window is about to open.
Cada even‘tO minimize " "
MouseDown
MouseDrag
para ver la MouseEnter
MouseExit
descripcion. Mouselp.
MouseWheel
. oved
Selecciona Open
Paint
uno o mas Resizing
Restore | Cancel | | oK \

eventos y haz
clic en OK
para crear los Manejadores de

Figura 2.22. Navegador

Evento correspondientes. Tambien mostrando Manejadores

puedes pulsar #-A (Ctrl+A en de Evento.
Windows y Linux) para elegir todos CONTENTS
: A
los manejadores de evento y % App
- v |_| Windowl
anadirlos de una vez. s

v @w Controls

. , v | PushButtonl
Los Manejadores de Evento estan =

en el Navegador bajo el control v “k Event Handlers
seleccionado. Haz clic sobre un “k Open
manejador de evento para ver su » |=| Methods

cddigo. » |E5 MainMenuBar

Guias de alineacion
A medida que muevas los controles por el disefio veras otras

guias de alineacién que te ayudaran a ajustar su posicion.

Para desactivar las guias de alineacion, mantén pulsada la tecla
Comando mientras arrastres (Control en Windows y Linux).

Controles del Usuario (Subclases de Control)
Puedes acceder a controles de usuario (subclases de los

controles incluidos) desde el grupo Project Controls en la
Biblioteca.

O bien puedes arrastrar simplemente la subclase desde el
Navegador sobre el Area de Disefio.

Usar los Controles en el Diseno
Puedes hacer clic derecho (Control-Clic en OS X) sobre cualquier

control del disefio para acceder al menu contextual. En dicho
menu encontraras las siguientes opciones:

- Add to
Usa este comando para seleccionar “Add Event Handler” desde
el submenu para afiadir manejadores de evento al control.

« Inspect
Muestra el Inspector para el control.

« Cut/Copy
Corta o Copia el control.

+ Paste
Pega un control del portapapeles en el diseno.

38



« Delete
Borra el control. Para llevarlo al portapapeles, usa Cut.

Duplicate

Crea una copia del control en el disefio. También puedes crear
una copia de un control haciendo clic sobre él al tiempo que
mantienes pulsada la tecla Comando (Shift+Control en
Windows y Linux) mientras arrastras el raton.

Print
Imprime todo el cddigo fuente correspondiente a los
manejadores de evento del control.

New Subclass
Crea una nueva clase en el Navegador en la que se utilice el
control como su superclase.

Select All
Selecciona todos los controles del diseno.

Select

Este subment contiene todos los controles del disefio. Usalo
para encontrar y seleccionar un control por su nombre o bien
para seleccionar un control que no sea visible en el diseno
debido a la solapacién de capas.

Lock/Unlock Position
Blogue el control seleccionado en su posicidn para evitar que
se pueda mover de forma accidental durante el disefio de la

plantilla. Para mover el control deberas de desbloquearlo
previamente.

« Edit Superclass
Si el control tiene una superclase, entonces este comando te
lleva directamente a la superclase para que puedas editarla.
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Seccion 5

Biblioteca e Inspector

Biblioteca

La Biblioteca contiene todos los controles disponibles de serie y

que pueden afadirse en el disefio. También
contiene todos los elementos de proyecto
que pueden utilizarse.

Para ver la Biblioteca, haz clic en el botdn
Library de la barra de herramientas,

selecciona View - Library en el menu o

pulsa el atajo de teclado (36-L en OS X, Ctrl-
L en Windows y Linux). La Biblioteca se abre
en la franja derecha del espacio de trabajo
por defecto, pero también puedes definir en
las preferencias que se abra como paleta
flotante.

La Biblioteca te permite agrupar los
controles usando varios criterios. Por
defecto, los controles se muestran en un
tamano grande, pero también puedes
cambiar el tamano, anadir cabeceras de
grupo y cambiar el orden usando el icono de

Figura 2.23.
Biblioteca
mostrando los
controles web.

(Q search D)

o m =
B m f (B

.Vul
(Ne @

X Ffe) @ [z3]
ITs) b 11§ @O
L
m

Aa Aa | |

oooooo

rueda dentada situado en la parte superior de la Biblioteca. Los
Ajustes de visualizacion son:

Large Icons

Large Icons and Labels

Small Icons and Labels

Large Icons and Descriptions

Show Group Banners

Sort Alphabetically

Situando el ratén sobre cualquier control muestra su descripcidn
en el Area de Descripcién situada en la parte inferior de la
ventana. Si no precisas ver la descripcion, puedes cambiar el
tamano de dicha area para ocultarla.

También puedes buscar los controles. Usando el menu
desplegable de la parte superior de la Biblioteca puedes optar
por mostrar solo los controles de un grupo concreto. O bien
puedes utilizar el campo Search, también en la parte superior,
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para buscar y mostrar los controles por nombre o tipo. Por
ejemplo, escribe “button” para ver todos los controles de tipo
boton.

Puedes arrastra controles desde la Biblioteca sobre el Editor de
Disefo en el caso de que soporte el control seleccionado.
También puedes arrastrar controles directamente al Navegador
para crear una subclase de forma inmediata. Por ultimo, también
puedes hacer doble clic sobre el control para anadirlo tanto al
Navegador (como subclase) o bien al Editor de Disefo, en
funcidn de cual de estos tenga el foco.

Inspector
El Inspector muestra informacidn sobre la seleccion actual. Esto

pueden ser propiedades de controles en un Editor de Diseno,

elementos de proyecto en el Navegador, o bien Ajustes de
Compilacién, métodos o propiedades

Figura 2.24. cuando se utiliza el Editor de Cddigo.

Inspector Mostrando
Propiedades para un El Inspector comparte su espacio con

metodo. la Biblioteca en la columna derecha del

Method Name | LoadCustomersByiD | v | espacio de trabajo. Para mostrar el

Parameters  id As String

Inspector, haz clic en el botdn
Inspector en la barra de herramientas,

selecciona View » Inspector en el

e menu o utiliza el atajo de teclado (38-I
cope | Public v . .
seope L2 en OS X, Ctrl-l en Windows y Linux).

Lo que ves en el Inspector depende de lo
que hayas seleccionado. En el caso de los
controles en el editor de disefio, veras todas
las propiedades disponibles para el control
seleccionado.

Estas propiedades estan agrupadas por
tema para facilitar el que encuentres aquello
que estés buscando. El Inspector puede
mostrar mas de una pestana en la parte
superior en funcion de lo que se esté
viendo.

Los items mas comunes estan incluidos en
la pestana “ID” y los usados con menos
frecuencia (o los elementos avanzados),
estan en la pestafa de la “rueda dentada”.

Figura 2.25.
Inspector
Mostrando
Propiedades
para una
WebToolbar.

ID

Name | MainToolbar
Super |WebToolbar e

Scope | Public ™|

Styles

Style | None
ButtonStyle | None

ButtonDisabledStyle | None

J
J
J
ltemStyle | None 3|
ToggledStyle | None 4|

J

ToggledDisabledStyle | None

Control Set

ber Of | None

Position

Left |0 Top |0

Width | 900 Height |56

Appearance
visible @I
Enabled M

Cursor | Automatic |

Locking

HelpTag s
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Paletas Figura 2.27.

Por defecto, tanto la Biblioteca como el Biblioteca como
Inspector aparecen en la columna derecha Paleta.
. , @ Library - o0

de la ventana y no de forma simultanea.
Puedes conmutar entre la Biblioteca y el Bu;E Q Sewch )
Inspector usando View » Toggle Palettes en D o =
el menu. B

i
Si prefieres situar la Biblioteca y el m & e
Inspector en cualquier otra parte, y tener inpts

o

ambos en pantalla de forma simultanea,

entonces has de utilizar las preferencias

7
- F §

para definirlas como ITE @)
Figura 2.26. Paletas. °° Aa | A
Inspector | Aa Ad
como Paleta. En el area General de ] -
= Preferences (Options - -
L en Windows y Linux)
: :
- e cambia “Show Library

Styles

i and Inspector” de “In
ButtonDisabledStyle
ItemStyle

the project window” a “As floating palettes”.

ToggledStyle

zl[zl[zl[z][z][z
giglsls!s|e
slallz2 223

ToggledDisabledstyle

Control Set

Member Of | None v ‘

Position

Left [0 Top |0 |
Width | 900 Height | 56

Locking




Seccion 6

Editor de Codigo

Para programar una aplicacion escribes cédigo utilizando el

lenguaje de programacion Xojo incluido en el Editor de Cddigo, y

que tiene este aspecto:

Figura 2.28. Editor de Codigo.

SSeep i e e S S

Editinvoice

- [If Invoicelist.ListIndex >= © Then

// If an dinvoice 1is selected, open the InvoiceDetailsWindow

// to let the user edit the existing invoice information

5 Dim iw As New InvoiceDetailsWindow

5 iw.EditInvoice(InvoiceList.Cell(Invoicelist.ListIndex, 0), mCurrentCl
B iw.ShowModalWithin(Self)

- ' If dw.InvoiceNumber <> "' Then
// The user made a change, so reload the invoice list and
// reselect the current €invoice
= LoadInvoices(iw.InvoiceNumber)
End If
End If

Parameters

L —

Puedes asociar codigo a casi cualquier elemento del proyecto,

como ventanas, paginas web, controles, clases, mddulos, etc.

Barra de Herramientas
El Editor de Cédigo tiene su

propia barra de herramientas
con las siguientes funciones,
disponibles de izquierda a Cadigo.

derecha:

Figura 2.29. Barra de
Herramientas del Editor de

Anadir
El botén Afadir se utiliza para afadir elementos relacionados
con el codigo a la ventana o pagina web. Esto incluye:

+ Manejador de Evento

« Manejador de Menu

« Método
* Nota
* Propiedad

« Propiedad Calculada

« Constante

+ Delegado

« Enumeracion

+ Definicién de Evento

+ Propiedad Calculada Compartida

«  Método Compartido
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« Propiedad Compartida
« Estructura
 Cladsula Using

Ver Diseno

Este boton esta agrupado con Ver Codigo y actia como un
conmutador.

Cuando se esta viendo codigo, haz clic en este botdn para
cambiar a la vista de disefio en la que veras el Ultimo elemento en
el que estuvieses trabajando.

Ver Codigo

Este botdn esta agrupado con Ver Disefio y actla como un
conmutador. Cuando se esta viendo cddigo este sera el botdn
seleccionado.

Cuando no estés viendo codigo, haz clic en este botdn para
cambiar al Editor de Cddigo en el que veras el Editor de Codigo
del Ultimo elemento que estuvieses editando.

Comentar/Descomentar

Utiliza este botdn para descomentar el codigo seleccionado en el
editor de codigo. Si no hay cddigo seleccionado, entonces se
comentara la linea en curso.

Si el codigo ya estuviese comentado, entonces esta accidn
descomentara el cddigo.

Analizar Item

Utiliza Analizar Item para validar el codigo fuente del elemento de
proyecto en curso. Esta funcidn detecta los errores de
compilacion y ofrece advertencias (como las variables no
utilizadas).

Puedes controlar qué advertencias han de mostrarse al analizar
un elemento de proyecto utilizando la ventana Analysis Warnings.

Selecciona Project »
Analysis Warnings en el Figura 2.30. \Ventana de
menu y elige las Advertencias de Analisis.
advertencias que quieras ssue Type

™ Item1 is deprecated
mostrar.

™ Item1 is deprecated. You should use Item2 instead

™ Old-style constructor methods are no longer support...
™ Unknown pragma name

(| Converting from Item1 to Item2 causes a possible los...
[ Converting from Item1 to Item2 causes the sign infor...
[ Performing a Item1 comparison on floating-point val...
™ Custom warning string

™ Item1 is an unused local variable

™ Item1 is an unused method parameter

™ Item1 is an unused event parameter

™ This property shadows one already defined by Item1
™ This constant shadows one already defined by Item1

| Close |
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Caracteristicas de Edicion
El Editor de Cddigo tiene varias caracteristicas disefiadas para

facilitar la escritura de codigo.

Resaltado de Sintaxis

El Editor de Cddigo
resalta el codigo fuente a

Figura 2.31. El Autocompletado

medida que escribes. En
las Preferencias puedes
cambiar los colores
utilizados por defecto para las palabras clave, cadenas, enteros,
comentarios, etc.

Autoindentado

El Editor de Cddigo indenta automaticamente el cddigo a medida
que lo escribas. Se indentan automaticamente estructuras como
If/Then, While/Do,

Select/Case y otros  Figura 2.32. Resaltado de sintaxis y

comandos. autoindentado.
Dim customerSearch As New SearchWindow

El cddigo indentado customerSearch.ShowModalWithin(Self)

se denomina bloque If customerSearch.SearchText <> "" Then
JORT LoadCustomers (customerSearch.SearchText)
de codigo. Puedes End If

identificar un bloque
de codigo en el

Editor de Cddigo porque tiene un signo “-” a su izquierda.
Puedes hacer clic sobre este para recoger el bloque de cédigo

ofrece “Folderltem” al escribir “Fol”.

Dim f As New FolderItem...

(cambiando a un “+’), ocultando asi todo el cédigo contenido por
el bloque. El cédigo continuara funcionando como parte del
proyecto, pero no sera visible en el Editor de Codigo. Haz clic
sobre “+” para desplegar el bloque de cédigo nuevamente.

Autocompletado

A medida que escribas en el Editor de Cddigo veras con
frecuencia tres puntos suspensivos tras el texto tecleado. Esto
indica que el Editor de Codigo tiene algunas sugerencias de
autocompletado. Cuando veas los puntos suspensivos, pulsa la
tecla tabulador para acceder a un listado con los comandos
disponibles. El autocompletado es inteligente y muestra los
comandos

relevantes en Figura 2.33. Area de Ayuda de Sintaxis

funcion del | [ DIE

Editinvoice

contexto del

If Invoicelist.ListIndex >= © Then
// If an dnvoice is selected, open the InvoiceDetailsWindow
// to let the user edit the existing invoice information
Dim iw As New InvoiceDetailsWindow

cddigo.

iw.ShowModalWithin(Self)

Ayuda de
Sintaxis

If diw.InvoiceNumber <> "'" Then
// The user made a change, so reload the invoice list and
// reselect the current €invoice
LoadInvoices(iw.InvoiceNumber)

End If

Hay una pequena End If
area en la parte

inferior del Editor
de Codigo que se

(1, 21) Listbox.Listindex As Integer

iw.EditInvoice(InvoiceList.Cell(InvoicelList.ListIndex, 0), mCurrentCu

usa para mostrar

ayuda de sintaxis. Dicha area muestra signaturas de métodos,
declaraciones y otra informacion sobre el codigo situado bajo el
cursor del raton.
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Puntos de parada y marcadores

El margen en la izquierda del Editor de Cddigo se utiliza para
definir puntos de parada y marcadores.

Un punto de parada es una linea de codigo que detendra la
ejecucion cuando tu app se ejecute en el depurador. Un
marcador supone un modo rapido de saltar a una parte concreta

de cddigo. Junto a cada linea de codigo veras un guién (“-”) en el

margen indicando que se trata de una linea que puede tener un
punto de parada o un marcador. Haz clic sobre el guién para
conmutar el estado de un punto de parada. El punto de parada
activo se indica mediante un pequefio circulo de color rojo. Haz
Opcion-clic en OS X o Control-clic en Windows/Linux para
conmutar el estado de un marcador. El marcador se indica
mediante un pequefo grafico representativo. Si la linea contiene
tanto un marcador como un punto de parada, entonces el
indicador aparecera como un pequeno grafico de marcador de
color rojo.

El menu Project » Breakpoint incluye opciones para definir el

estado de los puntos de parada, mostrar todos los puntos de
parada o bien eliminar todos los puntos de parada. De igual

modo, el menu Project » Bookmarks tiene opciones para cambiar

el estado de un marcador, mostrar todos o bien eliminarlos.

Menu Contextual

Puedes hacer clic derecho (o control-click) sobre una variable,
método, propiedad, clase o cualquier elemento de tu proyecto

para acceder al menu contextual, el cual contiene varias
caracteristicas Utiles:

+  Cut/Copy/Paste/Delete
Proporciona la funcionalidad habitual de cortar, copiar, pegar y
borrar.

Select All
Selecciona todo el texto en el editor de codigo.

« Comment
Comenta (o descomenta) el cddigo seleccionado.

* Insert Color
Abre la ventana del Selector de Color y te permite elegir un
color que se anade al editor de cddigo como un literal de
color.

+ GoTo
Salta a la definicion del elemento seleccionado en el editor de
codigo. Esto funciona para las variables, métodos, clases y
cualquier otro elemento que hayas creado en tu proyecto.
También puedes saltar con rapidez haciendo doble clic sobre
una variable, método o clase al tiempo que mantienes pulsada
la tecla comando (OS X) o control (Windows y Linux).

«  Switch To
Cambia a otro evento, método o propiedad.
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Standardize Format
Aplica reglas de formato estandar al texto seleccionado.

Wrap in If/End If
Envuelve el cédigo seleccionado en un bloque de cédigo If
Then / End If.

Wrap in Do/Loop
Envuelve el cédigo seleccionado en un bloque de codigo Do /
Loop.

Wrap in While/Wend
Envuelve el cédigo seleccionado en un bloque de cddigo
While / Wend.

Convert to Method
Mueve el codigo seleccionado a su propio método y te lleva a
dicho método.

Convert to Constant
Mueve la seleccion a su propia constante y te lleva a dicha
constante.

Define Missing Method

Crea un nuevo método utilizando el método actual como
nombre del método. Si has proporcionado parametros se
afaden automaticamente sus tipos a la definicidon del método.

« Clean invisible ascii characters
Al cortar y pegar cddigo algunos caracteres ASCII invisibles
pueden confundir al Editor de Cddigo. Utiliza este comando
para limpiar el texto seleccionado.

* Turn Break Point On/Off
Conmuta el estado del punto de parada para la linea de
codigo en curso.

+ Help for / Open Language Reference
Abre la Referencia del Lenguaje. Si el comando bajo el cursor
se reconoce como un comando de Xojo, entonces aparecera
“Help for”, permitiéndote saltar directamente a esta entrada en
la Referencia del Lenguaje.

Toolbar

La barra de herramientas del Editor de Cddigo tiene estos
botones:

- Add
Te permite afadir otros elementos de cddigo fuente,
incluyendo: manejadores de evento, manejadores de mend,
métodos, propiedades, notas, propiedades calculadas,
constantes, delegados, enumeraciones, definiciones de
evento, métodos externos, estructuras y métodos
compartidos, propiedades y propiedaes calculadas.

« Comment
Comenta (o descomenta) el cddigo seleccionado.
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« Check for Errors / Analyze Current ltem
Ejecuta el comando Analyze Current ltem para comprobar la
existencia de errores o advertencias para el método en curso.

Atajos de teclado utiles

Cuando estés utilizando el editor de cddigo encontraras varios
atajos de teclado que te permitiran ser mas productivo.

« Ctrl + Return (38-Return en OS X) completa el bloque de
codigo. Por ejemplo, escribiendo “If True” y pulsando Ctrl +
Return rellenara automaticamente el “Then” y el “End If”,
situando el cursor entre ellos. Esto funciona con otros bloques
de cddigo como Select, While, Do y For.

« Ctrl + Enter (Opcién-Enter en OS X) amplia el cdédigo a una

nueva linea anadiendo automaticamente el caracter

« Ctrl +\ (38-\) Conmuta el estado de un punto de parada para la

linea.

- Ctrl + ' (38-') Comenta o descomenta las lineas de codigo
seleccionadas o bien la linea sobre la que se encuentre el
cursor, en el caso de que no esté seleccionado ningun codigo.

- Ctrl (38 on OS X) + doble clic sobre el nombre de un método te
lleva al método en el Navegador.

- Tab se utiliza para invocar el autocompletado. Pulsalo cuando

veas los puntos suspensivos para mostrar los elementos de

autocompletado.

Editor de Notas

El Editor de Notas es un editor de textos sencillo donde puedes
introducir anotaciones relacionadas con el proyecto. Por ejemplo,
es un lugar util para incluir informacion técnica sobre el proyecto.

Figura 2.34. Editor de Notas.

@ Orders.rbp <
CONTENTS
v @ App

>k Events

v Methods

AppendToDBError...

SetupNewDatabase
UpTime

v Notes
B Version Info

>

i

v @ Properties
@ DBErrorLogFile
@ LaunchedOn
@ LogDatabase
@ SystemUsage

v A Session

> Delegates

» ‘k Events

> Methods

> @ Properties

Version Info

1.0 August 16th, 2011
Inital release.

1.1 - August 26th, 2011
Added support for showing the customer's location in a MapViewer

1.2 - August 30th, 2011
Added a toolbar and moved search, show all, revert and update buttons i

1.3 - September 2nd, 2011
Added a mobile user interface for iPhone and iPod Touch.

1.4 - November 18th, 2011
The UI now scales properly when on an iPad in portrait mode. This was d
Added Type and Period popups to the Log page so the scope of the log vi

1.5 - February 23rd, 2012

Added a WebButton subclass to correctly size and style buttons for Andr
Added some more i0S styling
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Seccion 7

Otros Editores

Si bien pasaras la mayor parte del tiempo en los editores de
Disefio y de Cddigo, también hay otros editores para los menus,
barras de herramientas, informes, tipos de archivos y
contenedores.

Editor de Menu

El editor de Menu facilita la creacion de barras de menu, menus
y elementos de menu para tus proyectos de escritorio. La
plantilla de Aplicacion de Escritorio por omision ya incluye una
barra de menus utilizada como barra de menus por defecto para
toda la aplicacion. Puedes utilizar esta barra de menus por

Figura 2.35. Editor de Menu, editando Save.

pplication_File Edit _Help

Behavior

HB

Key

Menumodifier @I )
AlternateMenuModifier (| OFF

Platform Specific Shortcut

MacOptionkey (| OFF |

MacControlkey () OFF )

PCAltkey () OFF )

defecto o bien crear otras barras de menu que se utilicen en
otras ventanas. En ese caso, puedes asignar una barra de menu
a una ventana.

La barra de menu por defecto para una Aplicacidén de Escritorio,
MainMenuBar, incluye los menus File y Edit y los items de menu
File y Edit. El menu File tiene un item de menu, Exit (en Windows)
o Quit (en OS Xy Linux). Se proporcionan las propiedades del
item de menu Quit/Exit, de modo que dicho item de menu
funcione automaticamente. No necesitas modificar o afiadir
propiedades al item de menu para activarlo.

De igual modo, el menu Edit también cuenta con los elementos
de menu Deshacer, Cortar, Copiar, Pegar, Eliminar y Seleccionar
Todo.

Puedes mover los menus para cambiar su orden o bien llevarlos
a nuevos menus. La barra de herramientas tiene funciones para
afadir nuevos menus y elementos de menus.

También puedes usar Cortar/Copiar/Pegar para mover y copiar
items de menu a otras areas del mend.
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La barra de herramientas - Convertir Menu seleccionado a Primer Nivel
La barra de herramientas proporciona estos comandos: @

. Mostrar Plataforma Usa este comando para convertir el item de menu seleccionado

_ a un menu de primer nivel.
iy
Los iconos de plataforma en la barra de herramientas te Inspector
permite ver el aspecto del menu en Windows, OS X y Linux. El Inspector muestra las propiedades para el menu o item de

, . . menu seleccionado.
« Crear Nuevo Menu de Primer Nivel

@ Figura 2.36. Editor de Barra de Herramientas

editando un Boton.

Afade un menu de primer nivel a la barra de menus. "

. Crear nuevo item de Menu e R —

Super | Menultem ‘ v 1
H

Crea un nuevo item de menu bajo el menu de primer nivel

Scope | +

Interfaces | Choose...

Index | Multiple

Appearance

Text  Untitled

Icon [ None + ]

seleccionado.

Behavior

submenu @YW )
Autotnable (@ )

 Crear Separador

E[ Editor de Barra de Herramientas

Crea un item separador bajo el item de menu seleccionado. El Editor de Barra de Herramientas se utiliza también en el caso

. de los proyectos de escritorio para disenar las barras de
- Crea un Submenu

Crea un submenu bajo el item de menu seleccionado.

herramientas usadas en tus apps de escritorio.

Barra de Herramientas

La barra de herramientas tiene estos comandos:
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« Mostrar Plataforma

218

Los iconos de plataforma de la barra de herramientas te

permiten ver el aspecto de la barra de herramientas editada en
Windows, OS Xy Linux.

« Anadir

B

Anade nuevos items a la barra de herramientas.

Inspector

El Inspector muestra las propiedaes para el item seleccionado en
la barra de herramientas.

Editor de Diseno de Informes
El Editor de Diseno de Informes se utiliza para disefar informes

para las apps de escritorio.

Barra de Herramientas

La barra de herramientas tiene estos comandos:

- Anadir Grupo
Afade una nueva seccién de grupo en torno al cuerpo.

- Anadir Cabecera/Pie a la Pagina
Afade una nueva cabecera y pie de pagina al informe.

Figura 2.37. Editor de Informes.

D.@ [Ele]e]e] (B]E) [£]

LICIILIE .

| Il (_All Controls

|
PageHeader |

o
Sales Report
o

ooo

« Ordenadr

| PageFooter Body

Earirar:

Indicar el orden de los controles al informe.

« Rellenar

= 3]

m Note Player

$® RBScript

L8 Serial

Q Server Socket

0 Spotlight Query

Q TCP Socket

a Thread

» Timer

& UDP Socket

Excel Application
E Word Application
E PowerPoint Application
Report Field

E| Report Label

& Report Picture
Report Line

|§| Report Oval

@ Report Rectangle
@ Report Round Rectangle
@ Report Date

Report Page Number

Completa el control de informe al espacio disponible.

« Alinear

Ajusta la alineacion del control de informe.



- Espaciado

<%

Ajusta el espacio del control de informe.

Biblioteca e Inspector

La Biblioteca muestra los controles de informe que se pueden
anadir en el disefio del informe. El Inspector muestra las
propiedades para el control de informe seleccionado.

Editor de Grupos de Tipo de Archivo

El Editor de Grupos de Tipo de Archivo se utiliza para definir los
tipos de archivo soportados por tu aplicacion de escritorio.

Figura 2.38. Editor de Grupos de Tipos de Archivo
FIENIE |

Display Name Object Name MacType MacCreator | Extensions UTl's Icon

image/png Png PNGf ogle .png public.png =

image/jpeg Jpeg JPEG prvw Sfif;.jpe;.jpeg;.ipg public.jpeg Name | FileTypesl

Barra de herramientas

La barra de herramientas tiene estos comandos:

« Anadir Tipo de Archivo Personalizado
Usado para anadir un tipo de archivo personalizado a tu app.

Figura 2.39. Control para seleccionar Tipos de Archivo
adicionales.

Select the file type to add | : Add '\ Close |

Haz doble clic en una fila para utilizar el editor incorporado para
anadir los valores.

- Anadir Tipo de Archivo Estandar
Este botdn muestra un menu desplegable con los tipos de
archivo mas comunes. Haz clic en la opcion “More” del menu
para acceder en la parte inferior a la opcidn que proporciona un
listado completo desde el cual elegir.

« Eliminar Tipo de Archivo
Este botdn se utilizar para eliminar el tipo de archivo
seleccionado en el listado.

Editor ContainerControl
Los ContainerControls son elementos de proyecto especiales

que te permiten combinar multiples controles en un Unico control
que puedes afnadir posteriormente a una ventana o pagina web.

El Editor de ContainerControl funciona de igual modo al Editor de
Ventanas de los proyectos de escritorio o el Disefio de Paginas
Web en los proyectos web.
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Seccion 8

Paneles

Revision

Hay tres botones en la parte inferior del Figura 2.41.
: : Botones de

espacio de trabajo que abren los paneles Panel

para Buscar, Errores y Mensajes.

Buscar
El Panel Buscar se utiliza para buscar (y

opcionalmente sustituir) texto en tu proyecto.

: : : Figura
Busca al instante a medida que escribes en el o 22
campo Find. Puedes utilizar el control de ambito  control
para controlar el alcance de la busqueda, y el Scope.
botdn de “rueda dentada” para cambiar los 00 :)
criterios de correspondencia.
Figura 2.40. Find Panel.
Q Find (Q@ 0) (_/Replace ) (_Replace ) (Al ) =
g' ‘ :::;:metafls\mndowcustomerLisrAOpen. Ilnf 1 ‘ E::c‘:::‘:;:‘:‘ foune: ‘ I
L oo o ot e e
=] CustomerDetailsWindow.WindowToolbar.Action, line 3 LoadCustomers.
=] CustomerDetailsWindow.WindowToolbar.Action, line 9 LoadCustomerFields
Custom il i Action, line 7 /I The user created a new invoice, so reload the
=] CustomerL i Action, line 9 LoadInvoices(iw.InvoiceNumber)
B CustomerL LoadCi ields D

Private Sub LoadCustomerfFields()
found.

21 matches were

Las opciones de ambito son:

+ Global (todo el proyecto)

. ftem de Proyecto actual

- Método o Evento actual (si se aplica)
Los criterios de correspondencia son:

« Whole Word
Busca el texto como palabra completa.

« Match Case
Hace una busqueda sensible a Mayusculas-Minusculas.

« Use RegEx
Usa una Expresion Regular para la busqueda.

Haz clic sobre un resultado de la Busqueda para saltar donde se
encuentre dicho elemento en el proyecto. Find solo busca los
elementos en el Navegador. Si tienes elementos filtrados en el
Navegador, ya sea con el uso del Filtro o con la Barra de Salto,
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entonces la busqueda soélo se aplicara sobre lo que esté visible
en ese momento.

Errores
El Panel Errores muestra los errores y advertencias del

compilador. Este panel aparece automaticamente cuando haces
Run o Build, siempre que haya errores de compilacion. Haz clic
sobre el problema para saltar donde se halle en el proyecto.

Figura 2.43. Errores mostrados por Tipo.

Issue
v Type mismatch error

iCEs.t:;TIzr_DetaiIs\Mndow.CusmmerList.Open, line 4 - Type mismatch error. Expected Int32, but got String

1 errors 0 warnings

QAN

Figura 2.44. Errores mostrados por Ubicacion.

Location Issue
¥ CustomerDetailsWindow.CustomerList... 1 errors 0 warnings

Type mismatch error. Expected Int32, but got String
= i = "Hello"

QAN

Las advertencias soélo se muestran cuando utilizas los comandos
“Analyze Project” o “Analyze Current Item”.

Puedes elegir entre mostrar los errores o advertencias por tipo o
por ubicacion usando el selector disponible en la parte superior
del Panel de Error.

Puedes elegir qué advertencias aparecen utilizando la ventana

Analysis Warnings (Project » Analysis Warnings).

Mensajes
El Panel Mensajes se utiliza principalmente cuando se ejecuta el

proyecto en el depurador.

Cuando ejecutas el proyecto se crean automaticamente los
mensajes Application Launch y Application End. El resto de
mensajes del sistema también se mostraran aqui.

Figura 2.44. Panel Messages.

)\ Messages Q Search Clear =

12:09:16 PM | Process Started. Process ID is 55889.
My Application Launched

12:09:26 PM My Application Ended
Session closed. There are 1 sessions remaining.
Session closed. There are 0 sessions remaining.

App is shutting down: no sessions remaining.

WNEY

Ademas, la salida del método System.DebuglLog aparece en el
Panel Mensajes permitiendo que tus aplicaciones generen sus
propios mensajes de logado.

Puedes buscar en los mensajes usando el campo de busqueda.
EL botdn Clear borra todos los mensajes del listado.
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Seccion 9

Ejecutando tus Aplicaciones

Cuando trabajas en tu proyecto querras probarlo. Puedes Depurador
hacerlo pulsando el boton Run de la barra de herramientas o Se puede utilizar el depurador para ver el funcionamiento de la
bien seleccionando Project » Run. aplicacion. Esté dividida en tres areas principales:
Cuando ejecutas tu proyecto asi lo estas haciendo en modo - Stack
debug. En este modo, Xojo se comunica en segundo plano con Muestra el orden en el que se ha llamado el cddigo de la
tu aplicacién. Aparecera una nueva pestana en el Espacio de aplicacion.
trabajo (que Variabl
contendra el Figura 2.45. La pestafia Depurador | varlabies
q q I mostrando una app en modo de Muestra las variables y sus valores actuales.
epurador) con e Depuracion.
nombre de tu S— - » Source Code
aplicacion. e = Muestra el codigo fuente ejecutado en ese momento.
Cuando se Para ver el Stack (pila), las Variables y el codigo fuente que se

# EddiesElectronics Dim cus

selecciona esta custome esta ejecutando en ese momento, puedes definir un punto de
pestana se parada en tu cddigo fuente o puedes hacer clic en el botdn de
muestra el pausa en la barra de herramientas.

Depurador. En esta el Navegador muestra la seccion Run vy el

nombre de la app que se esta depurando. Barra de Herramientas

La barra de herramientas del depurador tiene estos comandos:
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« Pausa

Pausa la app en la linea

Figura 2.46. Barra de
Herramientas del Depurador.

(> |®|[a]|s|2]|2]

de codigo en curso. El
depurador mostrara la

linea de codigo

resaltada en gris.

- Stop
Detiene la app en ejecucion, cerrando el depurador.

« Paso
En Pausa, avanza por el codigo una linea cada vez.

 Entrar
En Pausa, si la linea de cédigo actual es un método, esta
accion te lleva a la primera linea de cédigo del método.

- Salir
En Pausa, si estas dentro de un método, esta accion ejecuta el
resto del codigo del método y pausa el depurador en la linea de
cbdigo situada a continuacion de la llamada a dicho método.

- Ver Fuente
Te lleva al item de proyecto y muestra el cddigo fuente para que
puedas editarlo. Los cambios realizados en el codigo no
tendran efecto hasta que ejecutes el proyecto de nuevo.

Usar el Depurador
Tienes tres opciones para Pausar el depurador de modo que

puedas revisar el cddigo en funcionamiento:

- Usa el botdon Pausa, y que no te permite controlar donde se
pausara el codigo.

- Define un punto de parada en tu cdodigo.

- Usa el comando Break en tu codigo.

Una vez que estéas en el depurador puedes ver E'g[‘g;a 2.47.
el cddigo fuente, pero no hacer cambios. Para Resume

editar el cddigo, usa el boton View Source y
que te llevara al codigo en el proyecto para que
puedas editarlo. Cualquier cambio que hagas

no tendra efecto hasta que vuelvas a ejecutar el

proyecto de nuevo. Resume

Para continuar con la ejecucion de tu aplicacion
una vez pausada, haz clic en el botén Resume de la barra de
herramientas, y que aparece en vez del boton Run.

También puedes detener por completo la aplicacion haciendo clic
en el boton Stop de la barra de herramientas. Esta accion no te
llevara al depurador dado que se habra terminado con la
ejecucion de la aplicacion, pero puede ser Util si necesitas
detener la app porque esté en un bucle infinito o algun otro error
de programacion.
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Stack ,
El 4rea Stack (esquina II;Ii%ura 2.48. Area de la

inferior izquierda) muestra el —

(_Main Thread $) Il

CustomerDetailsWindow.LoadCustomers
CustomerDetailsWindow.CustomerList.Open
App.Event.Open

nombre de los objetos en el
orden en el que se han ido
llamando, con el objeto en
curso situado en la parte

superior del listado. Puedes
hacer clic en otros
elementos del listado para ver el codigo ejecutado previamente.

El PopupMenu el area de la Pila s6lo muestra por lo general
“Main Thread”. Si estas utilizando especificamente Threading,
entonces puedes utilizar este popup para mirar el cédigo que se
esta ejecutando en otros hilos.

Variables

El area Variables (esquina Figura 2.49. Area de Variables

inferior derecha) muestra para el método

las variables que son LoadCustomers
locales al método que se «’ Variables ( Variables ) =
, . Name Value
este ejecutando. La Globals
. . customerRS RecordSet
columna de la izquierda searchText Q,
self CustomerDetailsWindow

muestra los nombres de
las variables y la derecha
muestra sus valores.

Puedes hacer clic sobre

Figura 2.50. El Depurador.
le]

Private Sub LoadCustomers(searchText As String = "")
- Dim customerRS As RecordSet
-~ customerRS = App.Orders.FindCustomersByName (searchText)

- If customerRS <> Nil Then
// Deleting the rows and then quickly reloading them causes the fields t
// disabled and renabled. This causes a slight flicker on Windows
// when using the Search or Show All features.
// By setting mLockChanges to True, this prevents the fields from being
// (see the CustomerList.Change event handler
mLockChanges = True
CustomerList.DeleteAllRows

For i As Integer = 1 To customerRS.RecordCount
CustomerList.AddRow(customerRS.field("lastname").StringValue + ", " + ¢
CustomerList.RowTag(CustomerList.LastIndex) = customerRS.Field("ID").In
customerRS.MoveNext

Next

CustomerList.ListIndex = 0

customerRS.Close

End If
End Sub
& stack ( Main Thread 1 Varia... ( Variabl =
C LoadC s Nam val
lobal.
C C List.Open Glob
EEEEEEEE RS Records:
App.Event.Open T

los valores en la parte derecha para verlos con mayor detalle. Es
posible editar algunos valores (como numeros o cadenas) de
modo que se afecten los resultados del codigo restante.

A medida que hagas clic para ver los detalles de las variables, el
PopupMenu de la seccion Variables cambia para mostrar lo que
se esté viendo. Puedes utilizar este popup para volver a las
variables previas.

Ademas, el item “Globals” de la seccion Variables te permitira
revisar los valores globales de la app, como los modulos y los
contenidos del objeto App.
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Definir Puntos de parada
En el Editor de Cddigo, el espacio

del margen izquierdo muestra lineas
horizonales para aquellas lineas de
codigo sobre las que se puede
definir un punto de parada. Para
definir el punto de parada sélo has
de hacer clic sobre dicha linea (“-”).
Como resultado aparecera un
pequefio circulo de color rojo para
indicar que se ha definido un punto
de parada. Para desactivar el punto
de parada, haz clic sobre el circulo
rojo. También puedes configurar

puntos de parada usando Project »

Figura 2.51. Punto de
parada definido en el
método
LoadCustomers.

LoadCustomers(searchText As String = ")

Dim customerRS As RecordSet
customerRS = App.Orders.Find

If custpmerRS <> Nil Then

// Deleting the rows and tt
// disabled and renabled. 1
// when using the Search or
// By setting mLockChanges
// (see the CustomerList.Ct
mLockChanges = True

CustomerList.DeleteAllRows

For i As Integer = 1 To cus
CustomerList.AddRow(custol
CustomerList.RowTag(Custor
customerRS.MoveNext

Next

CustomerList.ListIndex = 0

customerRS.Close
End If

Breakpoint » Turn on (3 +\ en OS X, Ctrl-\ en Windows y Linux).

Para desactivar todos los puntos de parada en tu app, usa

Project » Breakpoint » Clear All. Para ver todos los puntos de

parada en tu proyecto, selecciona Project » Breakpoint » Show

All, mostrando como resultado todos los puntos de parada en el

panel Find.

También puedes usar el comando Break para provocar la pausa

de tu aplicacion. Cuando tu cdodigo llegue a un comando Break,

el depurador se pausara en dicha linea. En una aplicacion

independiente (ya compilada como ejecutable autonomo) se
ignorara el comando Break.

Puedes usar el comando Break para pausar de forma condicional
la app y activar el depurador en funcidén de situaciones
especificas.

Por ejemplo, si tu app esta en un bucle, puede que sélo quieras
acceder al depurador cuando se alcance un valor determinado:

For i As Integer = 1 To 100
If i = 50 Then Break
Next
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Seccion 10

Tipos de Proyecto, Formatos y Plantillas

Proyectos
Los proyectos Xojo son un documento que contiene todos los

elementos que conforman tu aplicacién. Puedes tener varios
proyectos abiertos a la vez y puedes tener varias ventanas
abiertas por proyecto.

Cuando eliges crear un nuevo proyecto, dispones de estos tipos
entre los cuales elegir: Desktop, Web, Consola 0 iOS.

Desktop

Los proyectos Desktop te permiten crear aplicaciones con
interfaz grafica de usuario que funcionan sobre los sistemas
operativos de escritorio Windows, OS Xy Linux.

Web

Los proyectos Web te permiten crear aplicaciones que funcionan
en la web. Los usuarios interactuan con estas aplicaciones
usando un navegador Web.

Consola

Los proyectos de Consola se utilizan para crear aplicaciones
basadas en texto que funcionan desde la linea de comandos, el

terminal o como aplicaciones en segundo plano (servicios o
demonios). Estan soportados Windows, OS X y Linux.

i0OS
Los proyectos iOS se utilizan para crear apps que funcionan
sobre dispositivos iOS como iPhones y iPads.

Formatos de Proyecto
Puedes guardar tus proyectos en una variedad de formatos,

incluyendo el formato binario de archivo Unico
(xojo_binary_project), formato XML basado en texto
(xojo_xml_project) y formato basado en texto (xojo_project)
usando diferentes archivos para los items del proyecto.

Note: Xojo puede continuar abriendo y guardando los proyectos con
formatos de archivo Real Studio.

Puedes cambiar el formato utilizado por defecto en las
Preferencias.

Binario (xojo_binary_project)

Este es un formato de archivo binario. Tu proyecto esta
almacenado en un Unico archivo (excepto para items externos
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como imagenes) y que resulta facil de distribuir. Este es el unico
formato de archivo que puede utilizarse sin licencia.

XML (xojo_xml_project)

El formato de archivo XML es simplemente una respresentacion
XML del formato de archivo binario. También es un Unico archivo,
pero es enteramente XML. Siendo XML, este formato de archivo
puede ser de mayor tamafio en comparacion con el guardado
como Binario.

Texto (xojo_project)

El formato de archivo Texto guarda tu proyecto como archivos de
texto separados, uno por cada item de proyecto. Por ello,
asegurate de que guardas cada proyecto como Texto en su
propia carpeta y no intentes guardar multiples proyectos en la
misma carpeta.

El formato de Texto es ideal para su uso en combinacién con
sistemas de control de versiones como Subversion o Git, dado
que puedes ver exactamente qué archivos han cambiado y hacer
un seguimiento del histérico de los cambios en los archivos.

Este formato utiliza las siguientes extensiones para tus items de
proyecto:

« X0jo_code
Contiene cddigo fuente de items como modulos, clases y
paginas web.

+ XOjo_window
Contiene ventanas y container control de proyectos desktop.

« X0Ojo_menu
Contiene menus de proyectos desktop.

+ Xojo_toolbar
Contiene barras de herramientas de proyectos desktop.

+ X0Ojo_report
Contiene informes de proyectos desktop.

+ XOjO_resources
Cintiene informacidn binaria como iconos, items cifrados y otra
informacion binaria.

 XOjo_uistate
Contiene los ajustes de disefo de la Ul como las posiciones y
tamanos de las ventanas.

Cuando se utiliza con un sistema de control de versiones,
deberias afadir todos los archivos al repositorio excepto el
archivo xojo_uistate.

Cuando borras (o renombras) archivos o carpetas en un proyecto
con formato de texto estos quedan en disco para que puedas
hacer los cambios manualmente utilizando el software de control
de versiones.
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items Externos

Determinados items de proyecto estan almacenados siempre
como items externos y no se incluyen junto con el archivo de
proyecto. Estos son: imagenes, peliculas, sonidos, archivos de
texto y otros archivos anadidos al proyecto.

también es posible incluir ventanas, clases o modulos en un
proyecto que estén almacenados en realidad como archivos
externos. Esta caracteristica permite que mas de un proyecto
pueda compartir el item. Cuando se modifica un item de proyecto
externo y se guarda el proyecto, los cambios se escriben al
archivo que reside en el disco. Cuando se abre otro proyecto en
el que también se haga referencia al mismo archivo compartido,
dicho proyecto reflejara los cambios.

Para convertir un item de proyecto a un item externo,
seleccidnalo en el Navegador y haz clic derecho (Control-clic en
OS X) para mostrar el menu contextual para el elemento y elige la
opcidén Make External. Con ello se accede al cuadro de didlogo
Save File. Navega al directorio en el que quieras guardar el item,
dale nombre y haz clic en Save. Cuando hayas guardado el item,
este aparecera en el Navegador con su nombre en cursiva y un
distintivo de atajo en el icono.

Para afadir un item al proyecto como item externo, mantén
pulsada la tecla Alt (Opcién+Comando en OS X). El menu File »

Import cambia a Import as External. Selecciona dicho comando y
selecciona el item a importar. Sabras que lo has hecho

correctamente dado que el icono en el navegador aparecera en
cursiva con el distintivo de atajo en el icono.

Si un item de proyecto externo esta configurado como sélo de
lectura (Windows o Linux) o bloqueado (OS X), no podras
modificarlo en el proyecto, aunque aun podras verlo y usarlo.
Esto proporciona un modo adecuado de proteger los items
externos (que pueden estar compartidos por varios proyectos)
frente a su modificacidn accidental. Ten en cuenta que si un
archivo externo es modificado por cualquier otro componento
distinto de Xojo — como un sistema de versionado — tendras
que cerrar y volver a abrir el proyecto para recarga dicho item.

Cifrando los items de Proyecto

Si quieres distribuir una copia de items de proyecto para que
otras personas puedan
usarlos, pero no quieres que
puedan ver o editar tu item de Proyecto.
cddigo, utiliza el comando

Encrypt para proteger el Encrypt

Warning: This is a lightweight protection
scheme designed to deter casual browsing,
not a secure cryptography system.

objeto antes de exportarlo.
Un item encriptado aparece

Password: [

en el Navegador con un

Confirm: |

icono que contiene una

| Cancel | Encrypt

pequena llave en su esquina
inferior derecha.

Puedes encriptar (proteger)
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o desencriptar (desproteger) un item de proyecto que esta en tu
proyecto utilizando el menu contextual “Encrypt
ProjectlitemName...”. Un item encriptado no puede abrirse y
nadie puede acceder al cédigo (o disefo) asociado con él salvo
que conozcan la contrasefna para descifrarlo.

Cuando cifres un item, puedes indicar una contrasefa y que sera
la utilizada posteriormente para desencriptarlo. No olvides la
contrasefia dado que no tendras otro modo de desencriptarlo.

Importar Items de Proyecto
Para importar un archivo que quieras utilizar en tu proyecto sélo

has de arrastrarlo desde el escritorio y soltarlo en el Navegador.

Si el archivo no esta ubicado en el escritorio, puedes usar File »
Import. Aparecera el cuadro de dialogo Open File, permitiéndote
navegar e importar el archivo.

En el caso del cédigo, abre el método que quieras para importar
el cddigo y arrastra el fragmento de texto en el cuerpo del

método. No puedes usar el comando File » Import para importar

archivos de texto en el cuerpo de un método.

Para borrar un archivo previamente importando al proyecto,
seleccidnalo en el Navegador y pulsa la tecla Borrar del teclado o

bien selecciona Edit » Delete. También puedes borrar un archivo

en el Navegador haciendo Control-clic en el item y eligiendo a
continuacion Delete en el menu contextual.

Exportar Iltems de Proyecto
El codigo para los métodos, eventos, constantes, propiedades,

etc, puede arrastrarse hacia el escritorio como fragmentos de
cddigo o en una aplicacion de tratamiento de textos (sélo OS X).
Por supuesto también puedes copiar el codigo al Portapapeles y
pegarlo en un editor o procesador de textos.

Puedes exportar tu codigo fuente a un archivo XML o a un
archivo con formato binario usando el comando de menu
Export..., y que puede ser util para compartir codigo.

Recoger Iltems de Proyecto
Algunos de tus items de proyecto pueden ser externos con

respecto a los archivos de proyecto. Estos pueden ser cosas
como graficos o incluso items de proyecto compartidos por
multiples proyectos. En el momento de la distribucién puede
resultar Util recoger todos los items de proyecto desde sus
diferentes ubicaciones para guardarlos junto con el proyecto.

Los items externos permanecen como items externos, salvo que
ahora estaran agrupados (imagenes, datos, scripts, etc.).

Este proceso no cambia los nombres de los items en disco, de
modo que los nombres de archivo duplicados pueden ser
reportados como errores.
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Recoger un proyecto no guarda el proyecto. Por lo general
querras guardar el proyecto con “Save As” después de recoger
los elementos del proyecto.

Selecciona File » Collect Project ltems para recoger los items del

proyecto actual.

Plantillas
Si tienes varios items que utilices con frecuencia en cada

proyecto, puedes guardarlos en un archivo de proyecto y hacer
que dicho archivo se utilice como plantilla en cada nuevo
proyecto. La plantilla puede incluir ventanas personalizadas,
clases, modulos y otros items de proyecto.

Cuando creas un nuevo proyecto basado en una plantilla, Xojo
crea un nuevo proyecto sin titulo que es una copia exacta de la
plantilla. La plantilla de proyecto permanece inalterada. Esto te
permite crear un nuevo proyecto utilizando elementos de
proyecto ya existentes sin que debas de preocuparte sobre la
modificacién de los items originales.

El modo mas eficiente de utilizar una plantilla es situandola en un
directorio especial en el mismo directorio de Xojo, denominado
“Project Templates”. Si lo haces, tu lista de plantillas aparecera

en el Selector de Proyecto cada vez que se elija File » New

Project.

Por omision hay descripciones que acompanan a las plantillas
incluidas por defecto. Aunque dichas plantillas se incluyen de
serie, pueden sobreescribirse proporcionando plantillas que
utilicen esos mismos nombres y situandolas en la carpeta Project
Templates.

- CGlApplication: Esta es una version especializada de la plantilla
Console Application destinada a una aplicacion web asociada
con el servidor Apache. Su clase App es derivada de la clase
CGlApplication (en el proyecto) y que de hecho deriva de la
clase ConsoleApplication. CGl (Common Gateway Interface) es
el modo en el que funciona una aplicacién web con Apache.

En la seccion “Notes” de la clase App del proyecto Template se
incluyen detalles adicionales sobre CGlApplication. El mddulo
HTTP contiene una clase personalizada que gestiona las
peticiones HTTP. Contiene propiedades y métodos que querras
utilizar para crear la interface con Apache.

- EmptyService: Esta es una plantilla de aplicacion de servicio.
Su clase App esta basada en la clase ServiceApplication.
También funciona en segundo plano sin presentar interfaz de
usuario. Por favor, consulta la seccion Notes de la clase
ServiceApplication en la Referencia del Lenguaje para obtener
informacion adicional.

- Event Driven Console: Esta también es una plantilla para una
Aplicacion de Consola. Su clase App también esta basada en la
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clase ConsoleApplication e incluye una clase personalizada,
MyApplication, que contiene métodos shell y propiedades para
una Aplicacion de Consola. Consulta la seccidn Notes de la
clase Aplicacién de Consola en la Referencia del Lenguaje para
obtener informacion adicional sobre el funcionamiento de la
aplicacion de consola.

Cambiar proyectos Desktop, Web y Consola

Cuando creas un nuevo proyecto desktop, web o de consola, se
abre un proyecto simple con los componentes basicos como
punto de partida.

Puedes utilizar tus propios archivos de proyecto como sustitutos
de estos proyectos base para desktop, web y consola.

Para ello, crea proyectos (en formato Binario) y afade los items
de proyecto que quieras incuir por defecto. Guardalos con los
siguientes nombres en la carpeta Project Templates:

« Default Desktop Project
« Default Web Project
- Default Console Project

Por ejemplo, si creas un Default Desktop Project que tenga dos
ventanas y algunos moédulos y clases estandar utilizados con
frecuencia en tus proyectos, estos estaran disponibles de
inmediato al elegir Desktop en el Selector de Proyectos.
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Seccion 11

Preferencias / Opciones

Hay varias preferencias que puedes usar para modificar el
comportamiento por omision. Las preferencias estan agrupadas
en estas areas: General, Impresion (Printing), Cédigo (Coding),
Disefio (Layout), Compilaciéon (Building) y Depuracién
(Debugging).

En Windows y Linux, la ventana de Preferencias se denomina
Opciones.

General
El area General contiene las preferencias mas comunes.

Figura 2.53. Preferencias General.
@00 Xojo Preferences

Show Library and Inspector: (*) In the project window
() As floating palettes

Default project format: (®) Binary

(XML
() Text

When seeking help: () Use built-in documentation
(*) Go online for most recent documentation

Show Item Scope: () Behind item text
(¢) Over item icon

Navigator: | | Double click opens item in new tab
Default Values: | | Show default values in navigator
Types: (M Show types in navigator

Show Library and Inspector

Indica como deseas ver la Biblioteca y el Inspector. Por omisién
aparecen en el margen derecho del Espacio de trabajo,
compartiendo la misma area. Puedes optar por mostrarlas como
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paletas flotantes de modo que ambas estén visibles de forma
simultanea y no resten espacio al Area de Trabajo.

Default project format

Cuando guardas tus proyectos Xojo utiliza el formato de archivo
Unico estandar binario por defecto (xojo_binary_project). Este
formato es facil de distribuir pero no funciona bien con los

sistemas de versionado como Git.

Figura 2.54.
Ambito: Sobre el
icono del item.

v |=| Methods

Utiliza este ajuste para cambiar el formato
por defecto de los proyectos.

|5 Editinvoice

|5 EnableFields

|5 LoadCustomerFields
|5 LoadCustomers

|5 Loadinvoices

|5 Save

|5 SearchForCustomer
|5 ShowSalesReport
| UpdateMap

When seeking help

Xojo busca los comandos utilizando la
Referencia del Lenguaje. Por defecto
utiliza la Referencia del Lenguaje en linea
de modo que cuentes con la informacion
mas actualizada, pero esto requiere de

conexion a Internet. _
Figura 2.55.

Ambito: Tras el
texto del item.

v |=| Methods

Si deseas utilizar una copia local de la
Referencia del Lenguaje solo has de
cambiar este ajuste.

=/ |Editinvoice
=/ [EnableFields

=/ |LoadCustomerFields

Show Item Scope

=/ LoadCustomers

Este ajuste determina como se muestra el = :L‘Eﬂgef,
(=) |Savesridis e eiiniiaiy
ambito para las propiedades y métodos (| [SearchForCustomer
o b =/ [showsalesReport
en el Navegador. Al elegir “Behind item
text” se muestra el color de ambito tras el

'=/[updateMap

texto del item en el Navegador. Eligiendo “Over item icon” se
muestra una superposicion sobre el icono del item en el
Navegador.

When closing last window

Este ajuste esta disponible en Windows. Cuando “Keep Xojo
running” esta seleccionado, aparece un nuevo icono en el area de
Notificaciones

de la Barra de ] . o
Figura 2.56. Preferencia de cerrar ultima

Tareas (también ventana.

conocida como

When closing last window: () Keep Xojo running

Bandeja del -
@ Quit

Sistema) y Xojo

permanece en

funcionamiento tras cerrar la Ultima ventana del Espacio de
Trabajo (en vez de salir). Puedes
hacer clic derecho sobre el iconode  Figura 2.57. Xojo en el

area de notificacion de
la Barra de Tareas

c b [P B

Notificacion para acceder al menu
con “New Project”, “About Xojo” y
“Exit”. “New Project” abre el
Selector de Proyecto, “About Xojo”
Muestra la ventana “Acerca de”, y
“Exit” sale de Xojo.

Navigator

El ajuste “Double-click opens item in a new tab” controla el
comportamiento obtenido al hacer doble clic sobre los items del
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proyecto en el Navegador. EI comportamiento por defecto es
“profundizar” en los items de proyecto utilizando la Barra de
Salto.

Activa la casilla de verificacion para abrir el item de proyecto en
su propia pestafia cuando se haga doble clic sobre él.

Activa “Show default values in navigator” para mostrar los valores
por defecto de las propiedades en el Navegador.

Cuando “Show types in navigator” esta activado, los tipos de las
propiedades se muestran en el Navegador.

Printing
Las preferencias Printing (impresidn) controlan elaspecto del
cddigo cuando se imprime.

Figura 2.58. Preferencias de Impresion.

Xojo Preferences

ut Building Debugging

Font: | SmallSystem

Features: [ | Printin color
[ Include images of layouts

Font

Elige la fuente a usar para el texto impreso.

Size

Selecciona el tamano de fuente para el texto impreso.

Print in color

Activa esta casilla si quieres imprimir el codigo fuente utilizando
los colores de sintaxis indicados en las preferencias Coding.

Include images of layouts

Activa esta casilla para que las impresiones incluyan imagenes de
los disefios de interfaz de usuario (ventanas y paginas web).
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Coding
Las preferencias Coding (Cddigo) especifican como mostrar el
cddigo en el Editor de Cddigo.

Font Figura 2.59. Preferencias de

Selecciona la fuente a usar  Codigo.

en el Editor de Codigo de
entre las disponibles en el SEEk ..
instaladas en el Sistema. e S

Size

Default comment style:

Autocomplete: (¥ Applies standard case

Indica el tamano de fuente
a usar en el Editor de "Home" and "End" keys: @Sc:lvlst:::sginningandendofdocument

(_)Move cursor to beginning and end of current line

Cddigo. B

Syntax colors

Puedes personalizar los colores de varias partes del codigo
fuente. Selecciona una sintaxis y haz clic en la casilla de color
para seleccionar el color correspondiente.

Default comment style

Este ajuste determina el estilo de comentario utilizado por el
botdon Comment y funcion del menu contextual.

Autocomplete

Estas dos opciones te permiten controlar el funcionamiento del

Autocompletado. Apply standard case utilizara la caja correcta

durante el autocompletado (por ejemplo MsgBox en vez de
msgbox).

Show icons mostrara iconos junto a los valores en el listado de
autocompletado.

“Home” and “End” keys

Determina como quieres que funcionen las teclas Inicio y Fin.



Layout

Las preferencias Layout ajustan el funcionamiento de los Editores

de Diseno.

Default control font

Por defecto, Xojo usa System como la fuente para todos los
controles. Esto permite que la plataforma la sustituya por su
propia fuente por defecto en tiempo de ejecucion. Si en vez de
ello quieres indicar tu propia fuente, puedes elegirla aqui.

Size
Por defecto Xojo utiliza 0 como tamano de fuente para todos los
controles. Esto permite que la plataforma sustituya dicho valor

Figura 2.60. Preferencias de Layout.

® 00 Xojo Preferences

L_|
f = =
= e
 General Printing Coding fLayout] Building Debugging .=

A

Default control font: | System ‘)

When selecting a control: (#) Highlight the control and its parent
() Highlight the control only

por su propio tamano por defecto en tiempo de ejecucién. Si en
vez de ello quieres utilizar un tamano concreto, has de indicarlo
aqui.

When selecting a control

Cuando tienes controles anidados (uno control sobre otro), el
Editor de Diseno selecciona el control padre con un contorno de
color rojo. Si prefieres no ver eso, puedes seleccionarlo aqui.
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Building Build unsaved apps in

Las preferencias de Building controlan lo que hace Xojo cuando Si intentas compilar un proyecto aun no guardado, se utilizara

compila o ejecuta tus aplicaciones. esta ubicacion para almacenar la aplicacion compilada.

Figura 2.61. Preferencias de Building.

® 00 Xojo Preferences

Reveal apps: [ |Show built apps in Finder when done building

If a compile error occurs: (®) Show all errors in a list
(_)Show only one error at a time

If a file already exists: () Replace the file
(*) Ask me what to do

Build unsaved apps in: [

Reveal apps

Tras Compilar tu aplicacion, Xojo puede mostrar la ubicacion de
la app compilada utilizando el Finder o el Explorador.

If a file already exists

Cuando Compilas tu aplicacion, Xojo normalmente sustituye
automaticamente cualquier aplicacion compilada previamente (y
los archivos relacionados). Si prefieres que se te pregunte qué
hacer antes de sobreescribir un archivo, puedes cambiar dicho
comportamiento aqui.
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Debugging

Las preferencias de depuracion se utilizan para controlar la

depuracién remota.

Figura 2.62. Preferencias de Depuracion.

Xojo Preferences

Network Interface: [ Default

Remote Debug Hosts: | Machine Name
Windows 7 x86

Windows 7 x64
Ubuntu 10.10 x86
Ubuntu 10.10 x64
Vista

Win XP (ABK)
Wbuntn 10,04 ¥ R6

Address
10.0.1.15
10.0.1.38
10.0.1.36
10.0.1.26
10.0.1.33
192.168.151...
10019

Add

Edit Remove

[ ] Show Object IDs in variable lists

Network Interface

Indica la interfaz de red a usar para conectar con el depurador

remoto.

Remote Debug Hosts

Aqui puedes afadir, editar o eliminar las ubicaciones de

depuracion remota.

Show Object IDs in variable lists

Muestra los Object IDs en el area de Variables del depurador.

Proxy

Las preferencias Proxy se usan para indicar informacion de proxy
de modo que Xojo pueda conectar al servidor para validar tus
licencias. Estos ajustes son los usados cuando “accedes” a Xojo.

Figura 2.63. Preferencias Proxy.

® 00 Xojo Preferences

[ ] Connect using a proxy server
Address:
Port:
Server requires authentication
Username:

Password:

[ Test Connection ]

Selecciona la casilla “Connect using a proxy server” para activar
el uso del servidor proxy indicado. Rellena los campos
apropiados para indicar la ubicacion del servidor proxy y
cualquier informacidn necesaria para la autenticacion.
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Updates

Las preferencias de Updates te permiten elegir la frecuencia con
la que Xojo comprobara la disponibilidad de nuevas versiones.
También puedes indicar si quieres transmitir a los servidores de

Figura 2.64. Preferencias de Actualizacion

Xojo Preferences

Check for updates: v] [ Check Now J

@Include system information

If you choose to send us your system information you
encourage better support for systems configured like
yours in the future. This is entirely optional and
anonymous. We promise to never use your information for
nefarious purposes.

Learn More ...

Xojo la informacion del sistema, y que nos permitira conocer
mejor las necesidades de los usuarios del producto en base a la
misma.
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Seccion 12

Atajos del Teclado

General
Mantén pulsado Alt (Windows), Shift (en Linux) u Opcién (en OS

X) para prevenir la carga del estado de la interfaz en el IDE. Esto
evita la carga de las pestafnas y emplea los valores por defecto
de Xojo para el tamano de ventana.

Code Editor

Cuando uses el editor de cddigo, existen varios atajos de
teclado que te permitiran ser mas productivo.

- Ctrl + Return (3 -Return en OS X) completa el bloque de
codigo. Por ejemplo, escribiendo “If True” y pulsando Ctrl +
Return completara automaticamente el “Then” y el “End If”,
situando el cursor entre ellos. Esto funciona también con otros
bloques de cddigo como Select, While, Do y For.

« Ctrl + Enter (Option-Enter en OS X) amplia el cédigo a una

nueva linea anadiendo automaticamente el caracter

« Ctrl +\ (38-\) Conmuta el estado de punto de parada para la
linea.

- Ctrl + * (38-") comenta o descomenta las lineas de codigo
seleccionadas o la linea correspondiente a la ubicacion del
cursor en el caso de que no haya cddigo seleccionado.

- Ctrl (38 en OS X) + doble clic en el nombre de un método te
lleva a dicho método en el Navegador.

- El Tabulador se usa para invocar el autocompletado. Pulsalo
cuando veas texto en gris para autocompletar dicho texto, o
bien cuando veas tres puntos suspensivos de modo que
accedas a las opciones disponibles para el autocompletado.
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Menus

Estos son los atajos de teclado para los menus usados por Xojo.

Menu Edit
U= Tecla
Windows/ Comando
. 0OS X
Linux
Ctrl+Z *-Z Deshacer
Ctrl+Y 1r-38-Z Rehacer
Ctrl+X #B-X Cortar
Ctrl+C #6-C Copiar
Ctrl+V F6-V Pegar
DEL DEL Borrar
Ctrl+D 3-D Duplicar
Ctrl+A 3B-A Seleccionar Todo
Ctrl+Shift+A | {+-38-A Deseleccionar Todo
Ctrl+’ 8-’ Comentar
Pl .
< (return) Definir Valor por Defecto
(return)
Ctrl+F *-F Buscar

Menu File
Tecla
Windows/ | Tecla OS X Comando
Linux
38-, Abre Preferencias/Opciones
#-Q Sale de Xojo
Ctrl+N #6-N Abre el Selector de Proyectos
Ctrl+Shift+N | {>- 8- N Abre un nuevo Espacio de Trabajo
Ctri+T Fo-T Abre una Nueva Pestana
Ctrl+O -0 Abrir Archivo de Proyecto
Ctrl+W $-W Cierra Pestana
Gilt il {-38-W Cierra Ventana
+W
Ctrl+S F6-S Guardar Proyecto
Ctrl+Shift+S |  {+-38-S Guardar Como
Ctrl+P F-P Imprimir
{+-38-P Configuracion de Impresiéon
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Menu Insert

Menu Project

geca Tecla
Windows/ Comando
. 0OS X
Linux
Ctrl+Shift+E | "\ -3#-E Manejador de Evento
Ctrl+Shift+H Manejador de Menu
Ctrl+Shift+M | T -38-M Método
\ -3-N Nota
Ctrl+Shift+P | \_ -38-P Propiedad
Ctrl+Shift+C | " -38-C Constante

R Tecla
Windows/ Comando
Linux RS
Ctrl+R F-R Run
Ctrl+ESC 36-. Detener Depuracion
Ctrl+Alt+R | \.-3-R Ejecucién Remota
Ctrl+Shift+O | +-3-0 Saltar
Ctrl+Shift+l | {+-38-I Entrar
Ctrl+Shift+T | {+-38-T Salir
Ctrl+\ 36-\ Activar/Desactivar
Ctrl+K F8-K Analizar Proyecto
Ctrl+Shift+K | {+-38-K Analizar item
Ctrl+B 1+-36-B Compilar Aplicacién
Og)gti_c::n- Ir a Busqueda
Ctrl+Shift+L | {+-38-L Ir a Ubicacion
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Menu View

eeia Tecla
Windows/ Comando
. 0OS X
Linux
Ctrl+E F6-E Ir a Editor de Disefo/Cddigo
Ctrl+L $#-L Biblioteca
Ctrl+l 36-1 Inspector
Ctrl+Shift+F | {+-38-F Ocultar Buscar
A-38-F Entrar en Pantalla Completa
Menu Window
Tecla
Windows/ Tecla OS X Comando
Linux
#-M Minimizar
Ctrl+Tab 36-} Pestafa Siguiente
Ctrl+Shift+Tab 36-{ Pestafia Anterior
¥#-1.5 Seleccionar Ventana
Menu Ayuda
Tecla
Windows/ Tecla OS X Comando
Linux
F1 Referencia del Lenguaje
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Capitulo 3

El Lenguaje de
Programacion
Xojo

Este capitulo cubre el Lenguaje de Programacion
X0jo, incluyendo conceptos del lenguaje como
tipos de datos, métodos y comandos.

W,
o

3. El Lenguaje de Programacion Xojo

3.1.

3.2.

3.3.

3.4.

3.5.

3.6.

3.7.

3.8.

Reglas de nombres

Variables y Constantes

Tipos de Datos y Almacenamiento
Colecciones de Datos
Comparaciones

Bifurcaciones

Bucles

Métodos



Seccion 1

Reglas de Nombres

En las proximas secciones aprenderas a crear variables,
constantes, métodos, modulos, clases y mas. Todos estos items
siguen las mismas reglas de nombres, y que son las siguientes:

- Los nombres han de comenzar con una letra ASCII (A-Z) o (a-2)

- El resto del nombre puede contener cualquiera de las
siguientes:

- caracteres ASCII alfanuméricos (A-Z, a-z, 0-9)
- guién bajo ()

- cualquier caracter Unicode con un cdédigo de punto superior
al27

- Los nombres pueden tener cualquier longitud

- Los nombres no son sensibles a la caja Mayuscula/mindscula

(age y Age son tratados como el mismo)

Si usas un caracter no valido obtendras un error de compilacién
(generalmente indicado como Error de Sintaxis) cuando intentes
ejecutar el proyecto. En el caso de los nombres indicados a

través del Inspoector, obtendras un prompt indicando que el
nombre no es valido y se cambiara al nombre anterior.
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Seccion 2

Variables y Constantes

Recordar la Informacion
Un ordenador tiene dos tipos de memoria: temporal y

permanente. La memoria temporal se utiliza para recordar algo
siempre que esté encendido el ordenador. Tan pronto como se
apague (o reinicie) el ordenador, se perdera lo almacenado en la
memoria temporal. Esto se denomina RAM (Random Access
Memory; Memoria de Acceso Aleatorio).

El contenido de la memoria permanente se mantiene incluso
después de haber apagado el ordenador. Este tipo de memoria
es generalmente un disco duro, disco de estado sdélido o
memoria flash. Aimacenas las cosas sobre la memoria
permanente utilizando archivos, aspecto tratado en el libro
Framework.

Cuando escribes programas querras recordar una serie de cosas
o valores. Para ello se utiliza el concepto denominado Variables
para almacenar la informacion en la memoria temporal. Las
Variables son geniales para almacenar informacion como los
valores de un contador, los calores de un campo y cualquier
cosa que necesites mientras que tu aplicacion esté funcionando.

Se utiliza el término “variable” porque el valor que contiene
puede ser cambiado por tu programa, de modo que su valor
puede variar.

Variables
Una variable es la forma mas simple de almacenar valores. Todas

las variables se declaran en el cédigo utilizando la palabra clave
Dim, y cada variable debe de ser declarada antes de usarla.
Cuando declaras una variable indicas el tipo de dato que puede
contener.

La declaracién de una variable se compone de tres partes: la
palabra clave Dim, el nombre de la variable, y el tipo de dato.
Este es el ejemplo de una declaracién de variable:

Dim age As Integer

Estan disponibles estos tipos de datos simples: String, Integer,
Double, Currency, Boolean, y Color. Los Tipos se cubren en la
siguiente seccion: Tipos de Datos y Almacenamiento.

79



Una vez has declarado una variable, puedes asignarle valores asi:

Dim age As Integer
age = 42

Las variables pueden declararse en cualquier parte dentro de un
método, siempre que su declaracion preceda a su uso.

Si tienes varias variables del mismo tipo, puedes declararlas con
una Unica sentencia Dim:

Dim i, j, k As Integer

Si quieres declarar variables de diferentes tipos, también puedes
declararlas en una unica sentencia Dim. Por ejemplo, lo siguiente
es valido:

Dim Name, Address as String, ShoeSize As
Integer

Cuando creas una variable con la instruccion Dim, también
puedes asignar un valor. Para ello se anade el signo igual tras el
tipo de dato y, a continuacion, el valor. Por ejemplo:

Dim i As Integer =1
Dim Name As String = "Igor'", Address As
String = "15 Rue de Vallee"

También puedes mezclar variables con valores iniciales y sin
ellos:

Dim a As Integer, b As Integer = 15

En este caso, la variable A se declara como Integer pero sin valor
asignado. Si examinas el valor de A, sera cero. La variable B, por
otra parte, tiene el valor 15 por defecto.

Observa que lo siguiente también es valido:

Dim a, b, ¢ As Integer = 15

Esta instruccion declara tres variables de enteros y asigna a
todas ellas el valor 15. Aunque es valido, has de tener cuidado a
la hora de asignar valores a mas de una variable utilizando una
Unica instruccion Dim, dado que puedes perder con facilidad el
seguimiento de las asignaciones.
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Acceder a una Variable
Se puede acceder a una variable sélo desde el método en el que

se haya declarado. Cuando el método finaliza, la memoria
utilizada para almacenar la variable pasa a estar disponible para
otros usos. Esto significa que otro método de la aplicacion no
puede acceder al valor de la variable.

El término ambito se utiliza para describir cuando algo, como una
variable, se encuentra accesible. Las variables y las constantes
declaradas en los métodos tienen lo que se denomina un ambito
local, dado que sdlo estan disponibles de forma local para el
método.

Si declaras una variable o constante dentro de un bloque de

cddigo (como pueda ser una instruccioén If, Select o cualquier otra

instruccion de bucle), entonces su ambito sera local para dicho
blogue de codigo y no sera visible en el resto del método.

Por ejemplo puedes escribir:

If x > 5 Then
Dim y As Integer
y = 10

End If

// y sale del ambito en este punto;
ahora se puede reutilizar el nombre
de la variable.
// Se redeclara como cadena en la si-
guiente instruccidn
If x < 5 Then

Dim y As String

y = "hello"

También puedes asignar un valor a una variable utilizando otra
variable. Hacer esto no afecta a la variable original.

Cuando se utilizan los tipos de datos simples, la nueva variable
obtiene una copia del dato encontrado en la variable original. Al
cambiar la nueva variable no se modifica el valor de la variable
original.
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Para obtener informacion adicional sobre como funcionan las Estos son algunos ejemplos de declaracion de constantes:
variables de objeto con referencias de clase, consulta el capitulo

Clases. .
Const p1 = 3.14159

Este ejemplo crea una variable de cadena, le asigna un valor y Const value = 256*10

asigna a continuacion su valor a otra variable:
Const kDefault = "DefaultName"

Dim s As String = "hello"
Solo se puede asignar a las Constantes un valor constante o el
Dim s2 As String resultado de una expresion constante.
s2 = s // s2 contiene ahora "hello"
MsgBox (s2)

// El cambio de s2 no afecta a s
s2 = "world"
MsgBox (s2)

// s aun contiene "hello"
MsgBox (s)

Constantes
Una constante se comporta de forma similar a una variable con

dos diferencias significativas: no indicas el tipo cuando la
declaras y su valor no se puede modificar una vez se ha definido.



Seccion 3

Tipos de Datos y Almacenamiento

Para lograr que el cédigo se ejecute mas rapido y para
proporcionar comandos potentes que te ahorren tiempo al
programar, los ordenadores han de poder realizar ciertas
presunciones sobre la informacidn proporcionada. Por ejemplo,
cuando proporcionas un fragmento de informacion al ordenador,
este necesita saber si es un nimero, una cadena de caracteres,
una fecha, etc. Si proporcionas al ordenador la instruccion “1 +
1”, este necesita saber qué tipo de dato es cada “1”. De otro
modo, no sabra si esperas que 1 mas 1 sea 2 o bien la cadena
“11”. En este ejemplo, si indicas que son numeros entonces los
sumara y devolvera el resultado de “2”. Si le indicas que son
caracteres, entonces los concatenara y devolvera el resultado de
“11”. Hay varios tipos de datos disponibles, pero estos son los
tipos de datos mas comunes de todos. Estos son: Text, String,

Integer, Double, Currency, Boolean, y Color.

Text

Un Text es una serie de caracteres. Algunas veces se denomina
String (consulta la siguiente seccion), Text es el tipo de dato
preferido para tratar con Texto dado que puede gestionar con
mas inteligencia todo tipo de lenguajes.

La longitud maxima de Text esta limitada unicamente por la
cantidad de memoria disponible.

Puedes declarar un Text asi:

Dim t As Text

También puedes asignar directamente un valor como parte de la
declaracion:

Dim t As Text = "Hello, World!"

Basicamente se puede almacenar cualquier tipo de informacion
como Text, simplemente entrecomillandolo.

String
Una String es el antiguo modo de tratar con texto. En esencia,
una String es simplemente una serie de (0 cadenas de)

caracteres (o bytes).
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Dado que las Strings tratan de forma primaria con bytes, pueden
resultar mas dificiles de utilizar con algunos lenguajes, de mdoo
que deberias de utilizar el tipo de dato Text en la mayoria de los
casos. Puedes convertir un valor String a Text llamando
String.ToText

Dim s As String = "Hello, World!"
Dim t As Text s.ToText

Asi se declara una cadena:

Dim s As String

También puedes asignar directamente un valor como parte de la
declaracion:

Dim s As String = "Hello, World!"

Por defecto, las cadenas que no tienen una asignacion directa
tienen el valor de una cadena vacia.

Basicamente, se puede almacenar cualquier tipo de informacion
en una cadena. “Jenni”, “3/17/98”, “45.90”, son todos ellos
ejemplos de cadenas.

Puede que pienses “Hey, las dos Ultimas no parecen cadenas”,
pero lo son. Cuando entrecomillas la informacién en tu cédigo,
estas indicando que dichos datos son simplemente una cadena
de caracteres, y nada mas. La longitud maxima de una cadena
depende Unicamente de la memoria disponible.

Puedes combinar dos cadenas con el simbolo de suma (+). Por
ejemplo, la instruccion “Big” + “Dog” resulta en la cadena
“BigDog”. Esta es realmente toda la “matematica” que puedes
aplicara a las cadenas. Sin embargo, dispones de varias
funciones incorporadas que facilitan el trabajo con cadenas. Por
ejemplo, la funcién Lowercase toma una cadena y convierte
todos sus caracteres a minusculas. La funcion Trim elimina
cualquier espacio encontrado al inicio o final de la cadena.

Integer
Un entero es un numero sin parte decimal. No puede aceptar un

valor decimal o fraccion.

Nota: El tipo de dato Integer es un entero con signo que utiliza el tamario de
palabra de la plataforma de destino. Actualmente estos son cuatro bytes
(32-bits) en todas las plataformas soportadas, proporcionando un rango de
entero de -2,147,483,648 a 2,147,483,647.

Dado que los enteros son numeros, puedes realizar calculos
matematicos con ellos. A diferencia de las cadenas, en el cddigo
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no se entrecomillan los valores enteros. Asi es como se declara
un Integer:

Dim i1 As Integer

Un Integer declarado asi obtiene un valor por defecto de 0.

También puedes declarar un entero e indicar un valor por defecto:

Dim i1 As Integer = 100

Aunqgue por lo general solo deberias usar el tipo Integer, también
hay una variedad de tipos de entero mas especificos (tanto con
signo como sin él) y que se pueden utilizar en situaciones
concretas (generalmente sélo al comunicar con la API del
Sistema Operativo). Estos son: Int8, Int16, Int32, Int64, UInt8
(Byte), UInt16, UInt32 and UInt64.

Nota: La diferencia entre enteros con signo y sin signo es que los enteros
sin signo solo pueden contener numeros positivos (y 0).

Double

Un Double es un nimero que puede contener un valor decimal.
En otros lenguajes el Double puede indicarse como numero real
de precision doble. Dado que los Doubles son nimeros puedes
realizar calculos matematicos con ellos. Los Doubles utilizan 8

bytes de memoria. El rango de los doubles comprende
+1.79769313486231570814527423731704357e+308.

Dim value As Double

Un Double declarado asi tiene un valor por defecto de 0.0.
También puedes declarar un Double e indicar el valor por defecto:

Dim pi As Double = 3.1415926

Currency
Una Currency es un valor numérico de valor decimal fijo (64-bit,

8-bytes) que maneja 15 digitos a la izquierda de la coma decimal,
y 4 digitos como parte decimal. Se escala por 10,000 para
proporcionar 4 digitos a la derecha de la parte decimal. Siempre
es preciso para las cuatro posiciones decimales. Es Util para los
calculos relacionados con dinero, donde la precision es muy
importante. Es compatible con el tipo de dato Currency utilizado
en algunas versiones de Visual Basic.

Dim value As Currency
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Un Currency declarado asi tiene un valor de 0.0. También puedes
declarar un Currency e indicar el valor por defecto:

Dim value As Currency = 1.23

Boolean
Un Booleano puede tomar los valores True (cierto) o False (falso).

Los valores booleanos son False por defecto:

Dim b As Boolean = True

Puedes definir un Booleano a Cierto utilizando el valor True y de
nuevo como Falso usando el valor False, o bien mediante
cualquier expresion que devuelva un valor booleano.

Dim b As Boolean = True

Este ejemplo configura b a True o False en funcion de que el valor
entero sea mayor de 5:

Dim i As Integer = 10
Dim b As Boolean
b= (i >5) // b se define a True

Color
Un Color es un tipo de dato que almacena el valor de un color.

Un “valor” de Color consiste en realidad de tres valores
numéricos que se pueden definir utilizando cualquiera de los tres
modos de color populares: Rojo-Verde-Azul, Color-Saturacion-
Valor (HSV) o Cian-Magenta-Amarillo (CMY). Cada valor RGB se
almacena como un byte. Esto significa que cada numero puede
tener 256 posibles valores.

Cada funcién de color también incluye un parametro entero
opcional que se puede usar para indicar el nivel de transparencia.
La transparencia se suele denominar como canal alfa. También es
un entero que varia de 0 a 255. Cero significa la opacidad total,
mientras que 255 es totalmente transparente. Si omites el
parametro de transparencia, entonces se usa por defecto como
totalmente opaco.

Un color también puede configurarse a un valor usando el prefijo
&c o mediante las tres funciones de color (RGB, HSV, CMY) y que
se corresponden con los tres modelos de color.

Algunos ejemplos de declaracion de color:
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// Varios modos de asignar Rojo

Dim red As Color

red = &cffOO0O0O

red = RGB(255, 0, 0)

red = Color.Red

red = &cffOOOO88 // semitransparente

Cambiar un Valor de un Tipo de Dato a Otro
Encontraras ocasiones en las que necesites cambiar un valor de

un tipo de dato a otro. Esto ocurrira generalmente porque
necesites utilizar un valor con algo que esta disehado para
trabajar con un tipo de dato diferente. Por ejemplo, puede que
quieras incluir un nimero en el titulo de una ventana, pero el titulo
de la ventana es una cadena y no un numero. Por tanto, si
intentas asignar un numero al titulo de una ventana obtendras un
mensaje de error cuando ejecutes la aplicacion. El error te
indicara que los dos tipos de datos no son compatibles (son
distintos). Dado que el titulo de la ventana es una cadena,
tendras que cambiar el nUmero a una cadena antes de que
puedas usarla en el titulo de la ventana.

Afortunadamente existe una funcion incorporada denominada Str
(abreviatura de String) y que puede cambiar un nimero a una
cadena. Consulta la funcion Stre en la Referencia del Lenguaje
para obtener informacion adicional. También existe una funcion

denominada Val (abreviatura de Value) y que cambia las cadenas
a numeros. Consulta la funcion Val en la Referencia del Lenguaje
para obtener informacién adicional.

Cuando trabajas con Texto utilizas por lo general el método
ToText sobre un tipo de tipo distinto a texto para convertirlo a un
valor de Texto. Por ejemplo, se puede convertir un Integer a valor
Text asi:

Dim i As Integer = 42
Dim t As Text = i.ToText

Para crear un valor Integer a partir de un valor Text, se utiliza el
método FromText:

Dim i As Integer = 42
i = Integer.FromText("42")
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Operadores Matematicos tratan en primer lugar. La expresion se evalua empezando con el

La realizacién de calculos matematicos es una tarea muy comun conjunto de paréntesis incluido dentro del grupo de paréntesis
en programacién, y se soportan todas las operaciones mas externo. A continuacion se realiza el calculo de potencia,
matematicas comunes. seguido por la multiplicacion o divisién de izquierda a derecha.
Por Ultimo se realiza la suma o la resta. En la tabla de
Figura 3.1. Operadores matematicos. “Expresiones de ejemplo”, las tres expresiones devuelven
Operacion resultados diferentes debido al uso y lugar de los paréntesis.
. Operador Ejemplo
realizada
Precedencia de Parentesis
Suma + 2+3=5 La Precedencia de los Paréntesis determina el orden en el que se
Resta ; 3-0-1 ejecutan los operadores cuando hay mas de un operador en la
expresion. Por ejemplo, la expresion:
Multiplicacion * 3"2=6
o 5+2/3
Division en coma / 6/4=15
flotante
Division de \ 6\d=1
enteros - Figura 3.2. Expresiones Matematicas de
A S ejemplo.
Modulo Mod 6 Mod 4 = 2 :
Expresion Resultado
Potencia A 2"3=8
2+3*(5+3) 26
Ademas también se encuentran otras funciones matematicas de (2+3)*(5+3) 40
serie y que estan cubiertas en detalle en la Referencia del 2.4(3*5)+3 20
Lenguaje.
Las expresiones soportan la precedencia matematica estandar. contiene tanto operadores de division como de suma. Importa si
Esto significa que las ecuaciones contenidas en paréntesis se la division o la suma se realizan en primer lugar. Puedes forza una
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precedencia en concreto mediante el uso de paréntesis. Por suma en primer lugar usando paréntesis para sobreescribir la

defecto, la divisidon precede a la suma, de modo que esta precedencia por defecto de los operadores:

expresion se evalua como 5 mas 2/3. Puedes forzar que haga la

Figura 3.3. Precedencia de Operadores

(5+2)/3

Si hay mas de un operador en una expresion, entonces la
precedencia va de izquierda a derecha. Por ejemplo, la

Operador Descripcion multiplicacidon es mas elevada que la division en coma flotante,
Operador Punto que es m,as elevada que la division entera, que es mas elevada
que el modulo.
AddressOf Creacion de Delegado
Todos los operadores son asociativos a la izquierda excepto en el
IsA Comprobacion de Tipo caso de los pares (;) y la potencia (A). Asociacion a la izquierda
A Potencia significa que (foo or bar or baz) se evaluara como ((foo or bar) or
baz) en vez de (foo or (bar or baz)). De igual modo, la asociacién a
- Negacion o menos unitario la derecha significa que (foo:bar:baz) se evaluara como (foo: (bar:
Not Negacion Logica baz)) en vez de ((foo:bar):baz).
Multiolicacié ., ]
“ 1.\, Mod Hltiplioacion y division Expresiones Booleanas
Las expresiones Booleanas tratan sélo con los valores True y
K Restay suma False. True y False son valores que puede manipular Xojo, tal y
A I Comparaciones como hace con numeros y cadenas.
And Bitwise y And l6gico Hay dos tipos de expresiones Booleanas:
Or, Xor Bitwise y Or légico - Simple: Las expresiones Booleanas confirman algo sobre un
valor en el programa, generalmente usando operadores como
Creacion de Pair _ prog _ J _ P
= (igual), <> (no igual), <= (menos que o igual), o >= (mayor

que o igual). Algunas veces una propiedad o cualquier otra
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cosa del programa sera simplemente un valor Booleano. Un
buen ejemplo son los conmutadores que ves en el Inspector.

Source1.Bold es una expresion Booleana valida, dado que hay

un conmutador Bold en el Inspector cuando haces clic sobre
uno de los TextFields — de modo que la expresion
Source1.Bold se evaluara a True cuando el conmutador Bold
de Source1 esté definido como ON.

- Compuesta: Expresiones Booleanas que esta formadas por
otras expresiones booleanas (y que también pueden ser en si
mismas simples o Booleanas), usando para ello los
operadores Booleanos Not, Or o And.

Como ocurre con otros tipos de expresiones, tendras que utilizar
con frecuencia los paréntesis en las expresiones Booleanas para
dejar claro en qué orden deben de evaluarse las operaciones. De
igual modo, tal y como ocurre con otros tipos de expresiones,
Xojo proporciona el valor final evaluando desde dentro hacia
afuera.

Image 3.1 Arbol de Sintaxis Booleana.

or

/\

and and

A A
(val(Sourcel .text)=0 Sourcel.text<>"0" (val(Source2.text)=0 Source2.text<>"

Ejemplo de Expresion Compuesta

Considera esta expresion:

(Val(Sourcel.Text) O And
Sourcel.Text <> "O@") Or
(Val(Source2.Text) = 0 And
Source2.Text <> "O")

Una expresion compuesta como esta se evalua atendiendo a la
regla “de izquierda a derecha”. Las dos ramas de la expresiéon OR
se evallan de forma separada antes de aplicarles el OR.

Si una expresidn compuesta se une mediante AND, entonces
cualquier subexpresion que se evallie como False finaliza el
proceso de evaluar cualquier subexpresion siguiente dentro de la
expresion compuesta. Esto se debe a que una subexpresion
evaluada a False implica que toda la expresién compuesta de
AND sera también falsa.

Una expresion como esta puede representarse en un arbol de
sintaxis. El arbol de sintaxis se muestra en la Imagen 3.1.

La expresion se evalla desde la parte inferior hacia arriba. Cada
nivel del arbol se evalla de izquierda a derecha.
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En este ejemplo, el primer paso consiste en evaluar la rama
izquierda de la expresion OR. Esta es una expresion compuesta
en si misma, y sus ramas utilizan AND.

Esta comienza con

Val(Sourcel.Text) = 0

Si esta expresion devuelve True, entonces se evalla:

Sourcel.Text <> "O"

Y por ultimo, si

Val(Sourcel.Text) = 0

es False, entonces hay suficiente informacion para evaluar el
“AND” de modo que se devuelve False al siguiente nivel sin
evaluar la segunda expresion.

Dado que las dos expresiones compuestas estan unidas por OR,
necesita evaluar la expresion compuesta de la derecha en la base
del arbol incluso si la expresion compuesta de la izquierda se

evalla a False. Si la rama izquierda es False pero la rama derecha
es True, entonces la expresion compuesta completa es True.

Se sigue el mismo procedimiento al evaluar la rama derecha de la
sentencia OR compuesta.

Variant
Una Variant es un tipo de dato especial que contiene culaquier

tipo de dato. Las Variant son caracteristicas avanzadas que
deberian utilizarse con precaucion dado que los valores se
convertiran automaticamente a otros tipos segun sea necesario,
lo que puede producir comportamientos no deseados.

Consulta la Referencia del Lenguaje para obtener informacion
adicional sobre el tipo de dato Variant.

Auto

El tipo Auto es un sustituto de Variant. También puede contener
cualquier tipo de dato, pero no se convierte automaticamente a
otros tipos de datos. En vez de ello has de asignar el valor de
forma explicita a una variable del tipo correcto para usarlo.

Por ello, el tipo Auto es mas seguro al no incurrir en los
comportamientos no deseados que pueden derivarse de la
conversion automatica de tipos.

Consulta la Referencia del Lenguaje para obtener informacion
adicional sobre Auto.
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Seccion 4

Colecciones de Datos

Los programas cuentan con frecuencia con una gran cantidad de
datos que han de gestionar. Dos técnicas para manejar los datos
incluyen los arrays y los diccionarios. Si bien ambos son
capaces de manejar grandes colecciones de informacion,
difieren de varias formas.

Arrays
Un array es un tipo de variable especial que contiene varios

valores del mismo tipo de dato. Cada variable de un array se
denomina elemento del array. Para referirse a un elemento
concreto, se utiliza un indice numérico.

La instrucciéon Dim también te permite crear y escribir arrays.
Cuando declaras un array indicas el nimero de elementos que
tiene. Posteriormente puedes cambiar el nUmero de elementos.

Crear Arrays

Declaras un array indicando el indice del Ultimo elemento del
array. El indice indicado en la instruccion Dim es en realidad uno
menos de la cantidad total de elementos en el array, dado que
los arrays de Xojo siempre tienen un elemento cero. Por ello los
arrays se indican a veces como array basado en cero. Si el

primer elemento del array es el elemento 1, entonces se
denominaria array basado en uno. Dado que los arrays de Xojo
son basados en cero, la sentencia:

Dim names(10) As String

crea un array de cadenas con once elementos.

La sentencia:

Dim names(0) As String

crea un array de cadenas con un elemento, el elemento cero.
Puedes leer y escribir a este elemento tal y como harias con
cualquier elemento con un indice positivo.

En otras palabras, declaras una variable como array
simplemente afadiendo el indice del ultimo elemento a la
sentencia Dim. El indice del ultimo elemento debe ser un nimero
o una constante. No puedes utilizar variables con esta sintaxis.
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Si no conoces el tamano del array que necesitas en el momento

de declararlo, puedes declarar un array nulo (es decir, un array sin

elementos). Para ello utilizas el indice -1 en la instruccion Dim o
dejas el paréntesis vacio. Esto significa “un array sin elementos”.
Por ejemplo, las sentencias:

Dim firstNames(-1) As String
Dim lastNames() As String

crean el array sin elementos. Posteriormente puedes cambiar el
tamafo del array usando la instruccion Redim o “aumentarlo”

elemento a elemento usando los métodos Append o Array.

Arrays Multidimensionales

Puedes crear arrays multidimensionales. Por ejemplo, el disefio
de una hoja de calculo puede ser visto como un array de dos
dimensiones: filas y columnas.

Cada dimensioén se indica por su propio indice. Por ejemplo, los
elementos de un array con dos dimensiones se indican por un
indice para las filas y otro para las columnas. El primer elemento
en la esquina superior izquierda es el elemento 0,0.

Creas un array multidimensional indicando un indice para cada
dimensidén. Por ejemplo, la sentencia:

Dim names(2, 10) As String

crea un array bidimensional con 3 filas y 11 columnas.

Puedes usar constantes en las sentencias Dim para definir el
tamafo de un array. Por ejemplo, la siguiente declaracion se
refiere a una constante global, kLanguages, definida en un
modulo:

Dim names (10, klLanguages) As String

En este ejemplo, kLanguages es la cantidad de lenguajes
soportada por la aplicacion y se utiliza en numerosos lugares de
la aplicacion. Cuando cambia solo has de cambiar su definicion
en el modulo.

Referencia de Elementos del Array

Te refieres a un elemento del array situando el elemento deseado
entre paréntesis. Por ejemplo, la instruccioén:

names(1l, 1) = "Frank"
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sitla la cadena “Frank” en el elemento de array (1,1).

Obtener el Indice del Ultimo Elemento

La funcion Ubound devuelve el indice del ultimo elemento en un
array con una dimension. Por ejemplo, la expresion:

Ubound (names)

devuelve este valor. La cantidad de elementos es uno mas que
este numero, dado que el array es basado en cero.

Por ejemplo, el siguiente ejemplo devuelve 5 en la variable i.

Dim i As Integer
Dim names(5) As String
i = Ubound(names)

También puedes obtener el ultimo elemento de un arary utilizando
la sintaxis de notacién de punto. El siguiente codigo es
equivalente:

Dim i As Integer
Dim names(5) As String
i = names.Ubound

Inicializando Arrays

Después de que hayas declarado un array, puedes asignar los
valores iniciales a los elementos con la funcidon Array, asi como
utilizando instrucciones individuales de asignacion, tal y como se
muestra a continuacion. La funcion Array toma una lista de
valores y asigna los valores a los elementos del array,
comenzando con el elemento cero. En otras palabras,
proporciona la misma funcionalidad que el uso de instrucciones
separadas para cada elemento del array.

Por ejemplo, las siguientes instrucciones inicializan el array
usando instrucciones de asignaciéon independientes para cada
elemento:

Dim names(2) As String
// Separate assignment statements

names(®) = "Fred"
names (1) = "Ginger"
names(2) = "Stanley"

Las siguientes instrucciones utilizan la funcion Array para lograr el
mismo objetivo. Advierte que no has de declarar el tamano

exacto del array mediante la instruccion Dim.
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Dim names() As String
names = Array("Fred", "Ginger",
"Stanley")

La funcion Array anadira elementos al array a medida que sea
necesario.

Si declaras el array de tamano fijo pero no indicas el valor para
todos los elementos, la funcidn Array comenzara con el elemento
cero y utilizara tantos como se hayan indicado.

Asignacion de Array

Si tienes dos arrays de tipos de datos compatibles, entonces
puedes asignar un array a otro array. Simplemente has de utilizar
la instruccion de asignacién sin paréntesis. Este seria un ejemplo
simple:

Dim names(2), copyNames(2) As String
names = Array("Fred", "Ginger",
"Stanley")

copyNames = names

La ultima instruccion asigna los valores de todos los elementos
en names a los primeros tres elementos de copyNames. Si

copyNames tuviese menos elementos que names, entonces los
elementos adicionales se afiadirian en primer lugar a copyNames
y se completaria a continuacion la asignacion de todos los
elementos de names a copyNames. Por ejemplo, lo siguiente es
valido:

Dim names(3), copyNames(2) As String

names(®) = "Fred"
names (1) = "Ginger"
names(2) = "Tommy"

names(3) = "Woody"
copyNames = names

Después de que se ejecute el cddigo, el array copyNames tiene
un cuarto elemento para almacenar el valor de “Woody”.

Cambiar el tamano de Arrays

Varios métodos del lenguaje permiten modificar el tamafo de los
arrays.

- Append: El método Append afiade un elemento al array,
aumentando su tamano en uno. Cuando se llama a Append se
pasa el valor a anadir al array. Por ejemplo, la siguiente
sentencia:
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names.Append("Dave")

anade un elemento al array names y define el valor para dicho
elemento con la cadena “Dave”. Append funciona sélo sobre
arrays de una dimension.

- Insert: El método Insert crea un elemento adicional y lo inserta
en la posicion indicada. Requiere de dos parametros, el indice
el elemento a insertar y el valor del nuevo valor. Por ejemplo:

names.Insert(9, "Hal")

Una vez que se ejecute esta instruccién, el valor de names(9)
seria “Hal”. El antiguo elemento de element(9) se desplazara a
element(10) y asi con el resto. El tamafo del array aumentara en
uno, tal y como ocurre con Append.

Insert también funciona soélo con los arrays unidimensionales.

- Remove: El método Remove borra el elemento indicado por el
indice. Por ejemplo:

names.Remove(9)

elimina el elemento con el indice 9, reduciendo el tamano del
array en uno y desplazando los elementos del array en uno una
vez que se ha borrado dicho elemento. También funciona sdlo
sobre arrays unidimensionales.

- Redim: La instruccion Redim modifica el tamafio de un array ya
existente. Pasas los nuevos valores de los indices del array
salvo que no especificas el tipo de dato, y que queda definido
por la instruccion Dim inicial. Por ejemplo, la instruccion:

ReDim names(100)

cambia el tamano del array names a 101 elementos.

Redim funciona tanto en los arrays unidimensionales como
multidimensionales. En el caso de los arrays multidimensionales,
puedes cambiar el tamafo sdlo las dimensiones existentes, no
puedes anadir o reducir la cantidad de dimensiones disponibles.

Una diferencia entre Dim y Redim es que Dim acepta solo enteros
o constantes, mientras que Redim acepta cualquier expresion
que devuelva un entero. Esto incluye, por ejemplo, una funcién
escrita por el usuario que devuelva un valor entero o una simple
variable. Con esta caracteristica puedes cambiar las dimensiones
de los arrays sobre la marcha.
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Si no sabes el tamafo del array en el momento de su
declaracion, puedes declarar un array nulo (es decir, sin
elementos) y utilizar el comando Redim posteriormente para
cambiar su tamano. Si tu programa necesita cargar una lista de
nombres introducida por el usuario, puedes esperar a definir el
tamano del array hasta que sepas cuantos nombres se han

introducido. Puedes escribir una funcién para hallar dicho niumero

y usarlo con Redim o bien el método Append para afadir los
elementos requeridos al array uno a uno.

Convertir desde y hacia un Array a Variables

Son dos las funciones que permiten tomar un array y
descomponerlo en diferentes variables, asi como tomar una
variable de cadena para convertirla en un array.

- Split: La funcion Split usa una variable String y crea un array
unidimensional dividiéndola en elementos. Usa un delimitador,
un caracter o caracteres, para indicar el final de un elemento y
el inicio del siguiente para llevar a cabo la tarea. Por defecto el
delimitador es un espacio, pero puedes indicar cualquier otro.

Dim names() As String

// resize using the Split method
Dim s As String

s = "Juliet,Taylor,Casting"
names = Split(s, ",")

La funcion Split toma la cadena como su primer parametro y el
delimitador como el segundo. Este es un ejemplo que divide los
contenidos de una cadena en elementos de un array. Indica la
coma como delimitador. Después de la llamada, el array
resultante, names, tiene tres elementos:

names(0) = "Juliet"
names(1) = "Taylor"
names(2) = "Casting"

- Join: La funcién Join toma un array unidireccional y crea una
variable de tipo String que contiene todos los elementos del
array, separados por el caracter o caracteres indicados. Por
defecto, el caracter delimitador es un espacio, pero puedes
indicar tu propio delimitador pasandolo como segundo
parametro.

Por ejemplo, si tienes un array que contiene elementos que
almacenan el nombre y apellido de una persona, asi como el
numero de teléfono, la funcion Join creara una variable de String
que contiene toda la informacion. He aqui un ejemplo:
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Dim names(2) As String
Dim s As String

names(0) = "Anthony"
names (1) = "Aardvark"
names(2) = "(406) 737-8946"

// "Anthony,Aardvark, (406) 737-8946"
S = Jo-in(names, ll,ll)

En este ejemplo, la llamada a la funcién Join indica el nombre del
array y la coma como delimitador. Si la llamada fuese:

s = Join(names)

El resultado habria tenido un espacio entre cada valor: “Anthony
Aardvark (406) 737-8946".

Diccionarios
Un diccionario es un objeto compuesto por una lista de pares

clave-valor. Esto esto, cada valor esta emparejado con una clave
de identificacion. La caracteristica interesante de los Diccionarios
es que tanto la clave como el valor son variantes. Esto significa
que un diccionario puede almacenar una mezcla de tipos de
datos — y que la clave no tiene por qué ser simplemente un
entero. Puedes buscar un valor en un diccionario indicando tanto
su clave o su posicidén secuencial en el diccionario.

Un diccionario es un gran modo de realizar accesos aleatorios
rapidos a la informacion.

Un diccionario es una clase (descrito en el Capitulo 5) de modo
que puedes crear uno usando el comando New:

Dim d As New Dictionary

Anades valores al diccionario usando el método Value. Advierte
que el indice puede ser cualquier cosa, como una cadena:

d.Value("FirstName") = "Bob"

Puedes buscar un valor usando el indice, de igual modo:

MsgBox (d.Value("FirstName")) // Muestra
Bob

Pairs

La clase Pair es similar al Diccionario. Tiene dos propiedades:
Left y Right. Por tanto, cada instancia de Pair consiste de un par
clave-valor. Tal y como ocurre con el Diccionario, los valores en el
par son variantes. Se usa el operador “:” para asignar los valores
Left y Right al declarar el Pair. Por ejemplo:
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Dim p As Pair = "Telephone Number"
"(406) 737-8946"

Esto asigna “Telephone Number” a la propiedad Left del pary el
valor del nimero a la propiedad Right.

También puede almacenar un listado enlazado de pares cuando

se pasa una lista de elementos, como por ejemplo:

Dim p as Pair =1 : 2 : 3 : 4 : 5

El pimer par consta del par “1” (propiedad Left) y el segundo
objeto del par (propiedad Right); el siguiente par esta formado

por “2” y el tercer par, etc.
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Seccion 5

Comparaciones

Hay veces en las que precisas comparar dos valores para
determinar si se cumple una condicion. Cuando se realiza una
comparacion lo que se hace en realidad es generar una
expresion que proporciona un resultado de cierto (True) o falso
(False). Por ejemplo, la instruccion “Mi perro es un gato” evalla
como False. Sin embargo, la expresion “Mi perro pesa mas que
mi gato” puede resultar en True. La siguiente tabla muestra
ejemplos con los operadores de comparacion disponibles:

Figura 3.4. Operadores de Comparacion.

Descripcién Simbolo Ejemplo Resultado
lgualdad = 5=5 True
Diferencia < 5<5 False
Mayor que > 6>5 True
Menor que < 6<5 False

Mayor o igual - 6>=5 True

que
Menc:uc;igual <= 6<=5 False

También se pueden utilizar los valores booleanos y las cadenas
en las comparaciones. Las comparaciones de cadenas respetan
el orden alfabético y no tienen en cuenta las mayusculas/
minusculas. Esto significa que “Jeannie” y “jeannie” son iguales.
Pero “Jason” es menos que “Jeannie” dado que “Jason”
aparece antes alfabéticamente en comparacién con “Jeannie”. Si
necesitas realizar distinciones entre mayusculas/minusculas o

lexicograficas, entonces deberas de usar la funcion StrComp:

If StrComp("Jeannie", "jeannie", 0) <> 0 Then
MsgBox ("Las cadenas no son tiguales.")
End If

Para obtener informacién adicional, consulta la funcién StrComp
en la Referencia del Lenguaje.

Ademas, también esta el operador de igualdad de coma flotante.
Te permite determinar si dos nimeros de coma flotante son lo
suficientemente préximos como para ser considerados iguales.
Utilizalo para tener en cuenta las imprecisiones de operaciones
como la divisidn en coma flotante. El operador de igualdad de
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coma flotante es la palabra clave Equals. No hay un simbolo para

ello. Su sintaxis es:

result = expression.Equals(NumValue, x)

Expression es el valor en coma flotante a comparar, NumValue es
el valor con el que se compara, y x es la cantidad de unidades en

la Ultima posicion y que indica un rango aceptable. El resultado
puede ser True o False en funcién del resultado obtenido como
fruto de la comparacion.

Por ejemplo, si estas comparando 10000 a un valor e indicas
x=1, entonces los valores aceptables son 10000.000000000002,
10000.0 and 9999.999999999998.

Dim d As Double = 10000
If d.Equals(compareValue, 1) Then

// aqui se realizan otras acciones
End If

Comparaciones Logicas
Puedes probar mas de una comparacion a la vez utilizando los

operadores And, Or, y Not. Cuando se pasan valores booleanos,
estos operadores determinan si la expresién es cierta o falsa.

Operador And

Usa este operador cuando necesites saber si todas las
comparaciones se evaluan a True. En el siguiente ejemplo, si la
variable x contiene 10 entonces la expresion se evalla a False:

x > 1 And x < 5

Esto es asi porque 10 no es mayor que 1y menor que 5.

Operador Or

Usa este operador cuando necesites saber si cualquiera de las
comparaciones se evallan a True. En el siguiente ejemplo, si la
variable x contiene 10 entonces la expresiéon se evalla a True:

x > 1 0r x <5

Esto es asi porque 10 es mayor 1ue 1. El hecho de que no sea
menor de 5 no tiene importancia dado que solo te importa si una
de las dos comparaciones es cierta (True).

Operador Xor

Usa este operador cuando necesites saber si cualquiera de las
comparaciones se evallan a True, pero no todas ellas. En el
siguiente ejemplo, si la variable x contiene 10 entonces la
expresion es cierta y se evalua como True.

101



X > 1 Xor x < 5

Esto es asi porque sélo una de las comparaciones es cierta. Sin
embargo, si x contiene 3 entonces la anterior expresion
devolveria False, dado que ambas expresiones serian ciertas.

Operador Not

Usa el operador Not par ainvertir el valor de una variable
booleana. Por ejemplo:

Not x < 0

comprueba si x es igual o superior a 0.

Figura 3.5. Tabla de Evaluacion Booleana (Tabla de la

verdad).

Expri Expr2 Xor Or And
True True False True True
True False True True False
False True True True False
False False False False False

Figura 3.6. Tabla de Comparacion Bitwise.

Bit 1 Bit 2 Xor Or And
1 1 0 1 1
1 0 1 1 0
0 1 1 1 0
0 0 0 0 0

Comparaciones Bitwise
También puedes comparar cada uno de los bits de dos enternos

para determinar si son o no iguales. Esto se lleva a cabo
expresando cada entero como numero binario. Entonces se
comparan los bits en el par de enteros uno a uno. Se obtiene un
nuevo entero que es el resultado de la comparacion.

Puedes hacer esto con los operadores And, Or, y Xor. Estos se
consideran sobrecargados. Esto significa que pueden aceptar
tanto booleanos (tal y como se muestra arriba) o enteros. Si se
les pasa expresiones booleanas, “saben” que quieres las
comparaciones légicas descritas en la anterior seccion. Si se les
pasa enteros, “saben” que quieres comparar los bits que
conforman los dos valores enteros. En este caso cada uno
devuelve un entero compuesto por los resultados de todas las
comparaciones de bits. La siguiente tabla resume los resultados
de la comparacion de cada bit en los enteros pasados.
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Por ejemplo, pongamos como caso los numeros 5 y 3. Escritos
en binario serian:

101 (5)

011 (3)

Para evaluar 5 Xor 3, haces la comparacion en cada bit. Asi que,
para este ejemplo (de izquierda a derecha):

1Xor0=1 Figura 3.7. Cambios de
0 Xor1=1 Valor Bitwise Not.
1Xor1=0 Bit 1 Not Bit 1
El nuevo valor binario es 110,
que se corresponde con 6. 0 1

1 0
De modo que 5 Xor 3 = 6.

El operador Not también esta
sobrecargado. Si pasas un entero a Not, simplemente invierte el
valor de cada bit.

También puedes hacer estas comparaciones de bit utilizando

métodos de la clase Bitwise (consulta la Referencia del Lenguaje

para obtener informacion adicional).
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Seccion 6

Bifurcaciones

Tomar decisiones con Bifurcaciones
Los métodos que escribes se ejecutan linea a linea desde la

parte superior a la inferior, y de izquierda a derecha. Habra
ocasiones en las que quieras que tu aplicacion ejecute parte de
su codigo basado en ciertas condiciones (usando
comparaciones). Cuando la logica de tu aplicacion necesita
tomar decisiones se denomina “bifurcacion” o “derivaciones”.
Esto te permite controlar qué cddigo se ejecuta y cuando. Hay
dos instrucciones de bifurcacion: If...Then...End If y Select...
Case.

If...Then...End If

La instruccion If...Then...End If se utiliza cuando el codigo
necesita testar una condicion booleana (True o False) y ejecutar a
continuacion el cédigo en funcién de dicha condicion. Sl la
condicion evaluada es True, entonces se ejecutan las lineas del
codigo encontradas entre la linea If...Then y la linea End If.

If condition Then
// [Tu codigo va aqui here]
End If

Digamos que quieres probar la variable entera month y que si su
valor es 1, ejecuta algun cddigo:

If month = 1 Then
// [Tu codigo va aqui]
End If

La parte “month = 1” es una expresion booleana; puede ser True
o False. La variable mes puede ser o bien 1 ono es 1.

Supongamos que tienes un Button (botdn) que realiza una tarea
adicional si esta activado un CheckBox en particular. La
propiedad Value de un CheckBox es un booleano, de modo que
puedes evaluarlo facilmente con una instruccion If:
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If CheckBox1l.Value Then
// [Tu coédigo va aqui]
End If

Puedes declarar variables locales dentro de una instruccion If
utilizando la instruccién Dim. Sin embargo, dichas variables
saldrian de ambito tras la instruccién End If. Por ejempilo:

If error = -123 Then

Dim a As String

a = ";0ops! Ha ocurrido un error."
End If
MsgBox(a) // fuera de ambito

Si necesitas la variable después de la instruccion End If, deberias
declararla como local para todo el método y no solo dentro de la
instruccion If...End If.

If...Then...Else...End If

En algunos casos, necesitas realizar una accion si la condicion
booleana es True y otra accion si es False. En estos casos
puedes usar la cladsula opcional Else de la instruccion If. La
clausula Else te permite dividir el cddigo a ejecutar en dos
secciones: el codigo que se ejecuta cuando la condicién es True

y el cddigo que se ejecuta cuando es False. En este ejemplo, se
muestra un mensaje si la condicion es True, y otros distinto en el
caso de que sea False:

If month = 1 Then
MsgBox ("Es enero.")
Else
MsgBox ("No es enero.")
End If

If...Then...Elself...End If

En algunos casos necesitas realizar pruebas adicional cuando la
condicion inicial es False. Utiliza la instruccion opcional Elseif. En
el siguiente ejemplo, si la variable month no es 1, entonces la
instruccién Elseif realiza pruebas adicionales:

If month = 1 Then
MsgBox("Es Enero.")
ElseIf month < 4 Then
MsgBox ("Aun Invierno.")
Else
MsgBox ('""No es Invierno.'")
End If
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Por supuesto puedes usar una instruccion If...Then...End If
adicional dentro de la porcion Else de la primera instruccion If
para realizar otra comprobacion. Sin embargo, esto aflade otro
End If y crea un codigo mas complejo. En vez de ello, puedes
usar tantas instrucciones Elseif como necesites.

En este ejemplo se ha anadido otro Elself para realizar una
comprobacion adicional:

If month = 1 Then

MsgBox ("Es Enero.")
ElseIf month < 4 Then

MsgBox ("Aun Invierno.")
ElseIf month < 6 Then

MsgBox ("Debe ser Primavera.")
End If

Si la condicion inicial es False, tu cddigo seguira evaluando las
condiciones Elself hasta que encuentre una que sea True.
Entonces ejecutara el cddigo asociado con dicha instruccién
Elself y continuara ejecutando las lineas de cddigo tras la
instrucciéon End If.

If...Then...Else

Una instruccidn If puede escribirse en una linea, siempre que el
codigo que siga al Then y (opcionalmente) la instruccion Else

pueda escribirse en una linea de cédigo. Cuando se utiliza esta
sintaxis se omite la instrucciéon End If. Por ejemplo, las siguientes
instrucciones son validas:

If error = 123 Then MsgBox("Ha ocur-
rido un error.")

If error = 123 Then MsgBox("Ha ocur-
rido un error.") Else MsgBox("éx-
ito")

If error = 103 Then Break

Operador If

Para las situaciones en las que simplemente has de devolver un
resultado basado en una comparacion, puedes utilizar el
operador If.

If(condition, resultIfTrue, resultIfFalse)

Se evalla la condicion y si es True se devuelve resultlfTrue, de
otro modo se devuelve resultlfFalse.

Por ejemplo, este codigo muestra “Big”:
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Dim myInteger As Integer = 41
MsgBox (If(myInteger > 40, "Big", "Small"))

Select...Case
Utiliza la instruccion Select...Case cuando necesitas comprobar

una propiedad o variable contra varios posibles valores, y realizar
una accion en base a dicho valor.

Pongamos por caso el siguiente ejemplo que utiliza If...Elself..End
If para comprobar una variable (dayNumber) y mostrar el dia de la
semana:

Dim dayName As String
If dayNumber = 2 Then

dayName = "Lunes"
ElseIf dayNumber = 3 Then

dayName = "Martes"
ElseIf dayNumber = 4 Then

dayName = "Miércoles"
ElseIf dayNumber = 5 Then

dayName = "Jueves"
ElseIf dayNumber = 6 Then

dayName = "Viernes"
Else

dayName = "Fin de semana."
End If

MsgBox ("Es " + dayName)

No es posible que dos de estas condiciones sean ciertas (True) al
mismo tiempo. Si bien este cddigo funciona, no es facil de leer.

El siguiente ejemplo utiliza una instruccién Select...Case para
lograr el mismo resultado. Es mucho mas facil de leer:

107



Dim dayName As String
Select Case dayNumber

Case 2

dayName = "Lunes"
Case 3

dayName = "Martes"
Case 4

dayName = "Miércoles"
Case 5

dayName = "Jueves"
Case 6

dayName = "Viernes"
Else

MsgBox "Fin de semana."
End Select

MsgBox ("It’s " + dayName)

La instruccion Select...Case compara la variable o propiedad
pasada en la primera linea con cada valor de las instrucciones
Case. Una vez que se halla una correspondencia, se ejecuta el
cddigo entre dicho case y el siguiente.

Las instrucciones Select...Case pueden contener una instruccion
Else para gestionar otros valores no gestionados de forma
concreta por un case.

Puedes crear variables locales utilizando la instruccion Dim
dentro de una instruccion Case. Sin embargo, dichas variables
abandonan el ambito al finalizar la instruccion. Por ejemplo:

Select Case dayNumber
Case 2

Dim day As String

day = "Martes"
Else

MsgBox (" ;NO es martes!")
End Select

MsgBox (day) // Error: dia fuera de am-
bito

La variable “day” deberia de haberse declarado antes de la
instruccion Select...Case para que también esté disponible
después de que se ejecute la instruccion End Select.

La instruccidn Select...Case funciona con variables de cualquier
tipo de dato, incluyendo cadenas, enteros, singles, dobles,
booleanos y colores. Por ejemplo, puedes comparar colores
como en el siguiente ejemplo:
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Dim ¢ As Color Dim ¢ As Color

c = &CcFFOOOO // rojo puro c = &CcFFOOO00 // rojo
Select Case c Select Case c
Case &CcOOFFO0O // verde Case &COOFF00O, &cFF0000 // verde, rojo
MsgBox ("Verde") MsgBox ("Verde o Rojo")
Case &cFFOO00 // rojo Case &cFFOO00 // rojo
MsgBox ("Rojo") MsgBox (“Rojo”)
Case &CcOOOOFF // azul Case &cOOOOFF // azul
MsgBox ("Azul") MsgBox ("Azul")
End Select End Select
Una instruccion Case puede aceptar mas de un valor, con En el anterior ejemplo, el primer Case es cierto, de modo que se
diferentes valores separados por comas. Por ejemplo, lo ejecuta el cddigo. Aunque el color pasado a Select...Case es
siguiente es valido: Rojo, el codigo para el segundo case no se ejecuta porgue no se

trata de la primera correspondencia.

La instruccion Select Case acepta una clausula Else. El cédigo en
la clausula Else se ejecuta solo si no se halla una
correspondencia con ninguno de los anteriores case. Se puede
escribir la clausula Else como “Else” o “Case Else”. En el
siguiente ejemplo, la clausula Case Else se ejecuta porque el
color FFFFOO no se corresponde con ninguna de las
instrucciones Case:
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Dim ¢ As Color
c = &CcFFOOOO // rojo puro

Select Case c

Case &CcOOFFO0O // verde
MsgBox ("Verde")

Case &cFFOO00 // rojo
MsgBox ("Rojo")

Case &CcOOOOFF // azul
MsgBox ("Azul")

Case Else

MsgBox ("Ninguno de los anteriores")

End Select

La instruccion Case también puede aceptar un rango de valores
consecutivos utilizando la palabra clave “To”. Por ejemplo:

Dim i As Integer = 53
Select Case 1
Case 1 To 25

MsgBox ("25 o menos")
Case 26 To 50

MsgBox ("26 a 50")
Case 51 To 100

MsgBox ("51 a 100")
End Select

En este ejemplo es cierto el tercer caso, “51 a 100”.

Puedes combinar rangos con valores consecutivos separandolos
con comas, como por ejemplo:

Case 0, 26 to 50, 75, 100 to 200

Puedes escribir desigualdades con la palabra clave “Is” y un
operador de desigualdad. La sintaxis es:

Is ineqgalityOperator <value>

Por ejemplo:
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Dim i As Integer = 10 Dim i As Integer = 4
Select Case i Dim a As Integer = 2
Case Is <= 10

// se selecciona este caso Select Case 1
Case Is > 10 Case CalcSquare(a)

// no se selecciona este caso // case 1
End Select Case a

// case 2
Else
También puedes combinar desigualdades con valores, como en: // no hay correspondencia

End Select

Dim i As Integer = 75
Select Case i
Case 0, Is <= 10, 100

// caso no seleccionado
Case Is > 10, Is < 99 Function CalcSquare(a As Integer) As Integer

La funcion de la primera instruccion Case es:

// case seleccionado Return a * a
End Select End Function

_ N o _ En este ejemplo, la funcidn duplica el valor pasado, de modo que
En una instruccion Case puedes utilizar incluso funciones que

_ o ) _ la primera instruccion Case obtendria una correspondencia.
devuelvan un valor del tipo de dato indicado. He aqui un ejemplo

sencillo: En el caso de una funcién simple, como esta, puedes escribir la
expresion en la instruccion Case propiamente dicha. Es decir, lo
siguiente también seria una correspondencia valida para la
instruccion Case:
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Case a*a

La instruccidn Select Case también puede comparar variables
que sean objetos. El siguiente ejemplo usa una instruccion
Select...Case para determinar qué botdn ha pulsado el usuario
en un MessageDialog. La instruccion Select Case compara los
objetos de tipo MessageDialogButton para determinar que boton
se ha pulsado en el dialogo de los tres posibles.

Dim d As New MessageDialog
Dim b As MessageDialogButton

d.Icon = MessageDialog.GraphicCaution
d.ActionButton.Caption = "Save"
d.CancelButton.Visible = True
d.AlternateActionButton.Visible = True
d.AlternateActionCaption = "Don’t Save"
d.Message = "Save changes before closing?"
d.Explanation = "If you don't save your

changes, you will lose your work."

b = d.ShowModal
Select Case b
Case d.ActionButton
// user pressed Save
Case d.AlternateActionButton
// user pressed Don’t Save
Case d.CancelButton
// user pressed Cancel
End Select

También puedes utilizar el operador ISA para determinar si un
objeto es de una clase concreta. La sintaxis es:

Case IsA ClassName
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Este es un ejemplo simple. El cddigo en el manejador de evento
Action de un PushButton en una ventana es:

Select Case Me
Case IsA PushButton
MsgBox ("I’m a PushButton.")
Case IsA TextField
MsgBox ("Nope!")
End Select

El término “Me” se refiere al PushButton, de modo que la primera
instruccion Case devuelve True.
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Seccion 7

Bucles

Ejecutar Instrucciones Repetidamente con

los Bucles
Hay ocasiones en las que se precisa ejecutar una o mas lineas

de cddigo de forma repetida. Si sabes cuantas veces han de
ejecutarse las mismas lineas de cddigo podrias repetir
simplemente ese mismo codigo dicha cantidad de veces. Por
ejemplo, si quisieras que un PushButton mostrase un mensaje
tres veces al hacer clic sobre él, simplemente podrias incluir un
método MsgBox en tu codigo tres veces:

MsgBox ("Uno")
MsgBox ("Dos")
MsgBox ("Tres")

¢Imaginas que hubiese de repetirse cincuenta veces o quiza
hasta que se cumpla una condicidon determinada? En estos
casos la simple repeticién del cédigo seria tedioso o
sencillamente imposible. ; Cémo resolver el problema? La
respuesta son los bucles.

Los bucles ejecutan una o mas lineas de cédigo una y otra vez.
Estan disponibles las siguientes estructuras de tipos de bucles:

« While...Wend: El bucle se ejecuta hasta que se satisfaga la
condicion indicada en la instruccidon While.

- Do...Loop: El bucle se ejecuta hasta que se satisfagan las
condiciones especificadas en las instrucciones Do or Loop.

 For...Next: El bucle se ejecuta una cantidad determinada de
veces indicada mediante la instruccion For. Una variable local
controla la ejecucion del bucle.

« For...Each: El bucle se ejecuta repetidamente para cada
elemento de un array.

Puedes declarar variables locales dentro de una estructura de
bucle. Cuando defines una variable local dentro de una
estructura de bucle, su ambito es local a la estructura
propiamente dicha, y no a todo el método. Sale del ambito una
vez que se satisfaga la condicién del bucle. Si necesitas utilizar
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la variable una vez que se salga del bucle, definela fuera del
bucle, de forma que sea local para el método.

While...Wend

Un bucle While ejecuta una o mas lineas de codigo entre las
instrucciones While y Wend. El codigo entre las instrucciones se
ejecuta de forma repetida, siempre y cuando continle siendo
cierta (True) la condicién pasada a la instruccion While.

Veamos el siguiente ejemplo:

Dim i1 As Integer
While 1 < 10

i=1+ 1
Wend
La variable “i” sera cero por defecto cuando se crea con la

instruccion Dim. Dado que cero es inferior a diez, la ejecucion

pasara dentro del bucle While...Wend. La variable se incrementa
en uno Yy el bucle vuelve a la parte superior donde la instruccion
While comprueba si la condicion aun es cierta, en cuyo caso se

vuelve a ejecutar nuevamente el cddigo situado dentro del bucle.

Este proceso continda hasta que la condicion ya no devuelva
True. Si la variable i no fuese inferior a diez en primer lugar, la
ejecucion habria continuado en la linea de codigo que sigue a la
instruccion Wend.

Do...Loop

Los bucles Do son similares a los bucles While aunque algo mas
flexibles. Los bucles Do contindian ejecutando todas las lineas de
cddigo entre las instrucciones Do y Loop hasta que una
condicion particular sea True. Los bucles While, por su parte, se
ejecutan siempre que la condicion continue siendo True. Los
bucles Do proporcionan mas flexibilidad en comparacion con los
bucles While dado que te permiten comprobar la condicion al
inicio o al final del bucle. El siguiente ejemplo muestra dos
bucles, uno de ellos evalla la condicién al inicio y el otro al final:

Do Until i = 10

i=1+1
Loop
Do
i=1+1

Loop Until 1 = 10

La diferencia entre estos dos bucles es esta. En el primer caso, el
bucle no se ejecutara si la variable i ya es igual a diez. El segundo
bucle se ejecuta como minimo una vez, independientemente de
cual sea el valor de i, dado que la condicidn no se evalua hasta el
final del bucle.
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También es posible crear un bucle Do que no evalle ninguna
condicion. Observa este bucle:

Loop

Dado que no se realiza ninguna evaluacion, este bucle se
ejecutara sin fin. Puedes utilizar el método Exit para forzar la
salida de un bucle sin evaluar ninguna condicidn. Sin embargo,
esto se suele considerar por lo general un diseno pobre dado que
has de leer todo el cédigo para averiguar qué causara la salida y
finalizacion del bucle.

Bucles infinitos
Asegurate de que el cédigo dentro de los bucles While y Do sean

capaces de no satisfacer la condicion en un momento dado; de
no ser asi terminarias con un bucle infinito que se ejecutaria
siempre. En el caso de que ocurra esto, puedes hacer clic en el
boton Stop del Depurador. Si no funcionase, puedes “forzar la
salida” de tu app con el administrador de tareas en Windows o
Forzando la Salida en OS X, o bien en la ventana Tareas de Linux.

Bucles largos
Cuando un bucle comienza a funcionar, su proceso “entra en

accion” y no permite que el usuario pueda interactuar con

elementos de la interfaz de usuario como menus, botones y
barras de desplazamiento. En los ordenadores actuales y con
bucles razonablemente cortos, esto no es un problema dado que
el bucle se ejecuta lo suficientemente rapido como para que el
usuario pueda pulsar otro boton o seleccionar un item de mend.
Si no es asi, hay dos cosas que puedes hacer:

« Si el usuario ha de esperar a que finalice el bucle antes de
hacer alguna otra cosa (por ejemplo, si la accion del usuario
invalidase los resultados del bucle), puedes indicar que se esta
llevando a cabo una operacién larga cambiando el cursor del
ratdn al de “espera” hasta que finalice el bucle. Consulta la
seccion sobre la clase MouseCursor para obtener informacion
adicional:

Self.MouseCursor = System.Cursors.Wait

- Si se permite que el usuario pueda realizar otras tareas mientras
que se esté ejecutando el bucle, entonces deberias de
considerar el uso de un hilo de ejecucion propio. Los hilos
(threads) permiten ejecutar el cddigo de forma concurrente con
el de la aplicacion principal (el que gestiona la entrada del
usuario y mantiene la interfaz del usuario), si bien se hace en
segundo plano, permitiendo que ocurran tareas en primer
plano. La Guia del Framework tiene mas informacion sobre los
Threads.
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For...Next
Los bucles While y Do son perfectos cuando no se puede

determinar la cantidad de veces que han de ejecutarse porque
esta basado en una condicion. Un bucle For es para los casos en
los que puedes determinar la cantidad de veces que ha de
ejecutarse el bucle. Por ejemplo, pongamos por caso que quieres
afadir los numeros del uno hasta el diez a una lista de un
ListBox. Dado que sabes exactamente cuantas veces ha de
ejecutarse el codigo, la mejor opcidn es utilizar un bucle For. Los
bucles For también se diferencian de los bucles While y Do
porque los bucles For tienen una variable de contador, un valor
de partida para dicha variable y un valor de finalizacién. La
construcciodn basica para un bucle For es:

Dim Counter As Integer
For Counter = 0 To 100

// [tu cdédigo va aqui]
Next

Advierte que la instruccion Dim declara el contador como entero
(Integer). Si bien un entero es el modo mas frecuente de definir
una variable de contador, también puedes declararla como Single
o Double.

En este ejemplo, la variable contador se ha declarado de forma
habitual con la instruccidon Dim. Dado que las variables de

contador no suelen utilizarse fuera del bucle For, también puedes
declarar la variable de contador justo dentro de la instruccion For.
En otras palabras, puedes rehacer el ejemplo como sigue:

For Counter As Integer = 0 To 100
// [tu cdédigo va aqui]
Next

Advierte que en este caso se ha eliminado la instruccion Dim del
ejemplo. Si declaras la variable de contador de esta forma,
puedes usarla solo dentro del bucle For. Sale del ambito una vez
que finaliza el bucle For. Este es el modo recomendado de
declarar una variable de contador. Por supuesto, si necesitas leer
o cambiar el valor del contador fuera del bucle For, lo que no
suele ser frecuente, deberias de utilizar la instruccion Dim en vez
de este formato.

En los anteriores ejemplos, el valor incial y final se indican como
numeros. También puedes utilizar variables, tal y como se
muestra en este ejemplo:
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Dim startingValue, endingValue As Integer
startingValue = 0
endingValue = 100

For counter As Integer = startingValue To
endingValue

// [tu codigo va aqui]
Next

La primera vez que se pasa por el bucle, se define la variable
counter a StartingValue. Cuando el bucle llega a la instrucocin
Next, la variable contador se incrementara en uno. Cuando se
llegue a la instruccidon Next y la variable counter sea igual a
EndingValue, se incrementara el contador y se finalizara el bucle.

Observa de nuevo el ejemplo mencionado anteriormente. Quieres
afadir los nUmeros hasta el diez a un ListBox. El siguiente cédigo
se encarga de realizar esto:

For i As Integer = 1 To 10
ListBox1l.AddRow (Str(i))
Next

La variable contador (i en este caso) se pasa a la funcion Str para
convertirlo a una cadena, de modo que se pueda pasar al
método AddRow de ListBox1.

Nota: La letra “i” se suele utilizar generalmente como contador de
bucle por motivos historicos. En FORTRAN, las letras | hasta la N
eran enteros por defecto. Por tanto, los programadores
FORTRAN comenzaron con la practica de utilizar dichas letras
como contadores, y en el orden en el que aparecian en el
alfabeto. De modo que si un programador FORTRAN necesitaba
anidar un bucle en otro, utilizaba la j como contador del bucle
interior. Esta convencion simplificaba a los programadores en
FORTRAN seguir la Iogica del cddigo que procesaba arrays
multidimensionales.

Por defecto, los bucles For incrementan el contador en uno.
Puedes indicar otro valor de incremento utilizando la instruccién
Step. En este ejemplo, se afiade la instruccion Step para
aumentar la variable contador en 5 en vez de en 1.:

For i As Integer = 5 To 100 Step 5
ListBox1l.AddRow(Str(i))
Next

En este ejemplo, el bucle For empieza con el contadora 100 y lo
va decrementando de 5 en 5:
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For i As Integer = 100 DownTo 1 Step 5
ListBox1l.AddRow(Str(i))
Next

Consideraciones de Rendimientoe

Hasta ahora has visto ejemplos en los que StartingValue y
EndingValue eran nimeros enteros. Si StartingValue o
EndingValue son expresiones que han de evaluarse a enteros,
entonces el bucle For realizara la evaluacion cada vez que
incremente el contador, incluso en el caso de que la expresion
siempre se evalue al mismo entero.

Por tanto, por motivos de rendimiento, es recomendable realizar
cualquier evaluacion antes de entrar en el bucle. Por ejemplo,
tomemos un bucle que necesita procesar todas las fuentes
instaladas en el ordenador del usuario. Dicho valor no puede
conocerse por adelantado, pero hay disponible una funcion,
FontCount, que puedes utilizar para obtener la cantidad total de
fuentes. Si la utilizas en una instruccién For para calcular
EndingValue (asi):

For i As Integer = 0 To FontCount-1

Next

El bucle se ejecutara mas lento que si solo calculas el valor una
vez:

Dim numFonts As Integer = FontCount-1
For i As Integer = 0 To numFonts

Next

Sin embargo la diferencia en velocidad puede que no sea
practica salvo que se trate de un bucle realmente largo. En un
ordenador tipico la diferencia entre estos dos bucles sera de una
minima fraccién de segundo, no lo suficiente como para perder el
suefo.

Bucles Anidados

Un bucle For (asi como cualquier otro tipo de bucle) puede tener
otro bucle en su interior. En el caso de un bucle For, lo Unico que
deberas de vigilar es que las variables utilizadas como
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contadores sean diferentes, de modo que un bucle no confunda grupo de instrucciones para cada valor del contador, la

al otro. El siguiente ejemplo utiliza un bucle For embebido en otro instruccion For...Each procesa cada uno de los elementos del
bucle For para recorrer todas las celdas de un ListBox array que le pasemos.

multicolumna, contando las celdas en las que aparece la palabra

Echa un vistazo a un ejemplo que suma los valores de un array
“Hello”:

utilizando una variable contador:

Dim count As Integer

For row As Integer = 0 To ListBoxl.ListCount-1 Dim values() As Double
For column As Integer = 0 To values = Array(2.2, 1.1, 3.3, 4.4)
ListBox1l.ColumnCount-1
If ListBoxl.Cell(row, column) = "hello" Then Dim sum As Double
count = count + 1 Dim element As Double
End If
Next
Next For i As Integer = 0 To values.Ubound
MsgBox (Str (count)) sum = sum + values(i)

Next

Otra forma de lograr este propdsito es seguir la misma regla
iniciada por los programadores en FORTRAN, y utilizar como
contador las letras por orden alfabético, comenzando con la “i”.
De este modo siempre sabras qué bucle esta dentro del otro sin
tener que imaginar a cual de los bucles correspondera cada

Caso.

La instruccion For...Each
Otra situacion en la que querras utilizar un bucle es para iterar un

grupo de valores al procesar un array. En vez de recorrer un

120



Este es el mismo ejemplo utilizando For...Each:

Dim values() As Double
values = Array(2.2,1.1,3.3,4.4)

Dim sum As Double
Dim element As Double

For Each element In values
sum = sum + element
Next

En la instruccién For...Each hay una variable que
automaticamente obtiene el valor de cada uno de los elementos
del array, en vez de usar una variable de contador. En el anterior
ejemplo, la variable element obtiene el siguiente valor del array
values cada vez que se itera el bucle.

Cuando estés trabajando con arrays, For...Each te permite
escribir cddigo mas simple.

Dado que los array no tienen por qué ser necesariamente
numeéricos, esta instruccion te permite procesar un grupo de
objetos de cualquier tipo. Pueden ser imagenes, colores,
documentos, conjuntos de registros de una base de datos, etc.

Como en el caso del bucle For...Next, puedes declarar el tipo de
dato de la variable element dentro de la instruccién For...Each en
vez de utilizar una instruccién Dim adicional. Por ejemplo, el
anterior ejemplo podria escribirse también asi:

Dim values() As Double
values = Array(2.2, 1.1, 3.3, 4.4)

Dim sum As Double

For Each element As Double In values
sum = sum + element
Next

Anadir bucles con el Editor de Coddigo
El menu contextual del Editor de Cddigo ofrece un modo

conveniente de anadir bucles a tu cddigo. Los tres Ultimos
elementos del menu contextual se encarga de “envolver” las
lineas de codigo seleccionadas dentro de un tipo de bucle. Para
usar estos items de menu, simplemente has de escribir el cddigo
que va dentro del bucle, seleccionar las lineas, y elegir el tipo de
bucle en el menu contextual. Tus opciones son: If...End If,
Do...Loop, and While...Wend.
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El Editor de Cddig puede “envolver” las lineas de codigo
seleccionadas en un bucle pero no sabe qué condicidén ha de
finalizar el bucle, Por tanto, inserta un marcador de posicidon
_condition_ en la instruccion de bucle. Esta condicion estara
seleccionada de modo que sdélo debas de comenzar a escribir
para sustituirlo por la condicion deseada.
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Seccion 8

Métodos

Los métodos son los bloques de construccion de tu aplicacion. « Method Name
El cddigo que escribes suele residir por lo general en un método. El nombre del método. Tal y como ocurre con las variables, los

meétodos tienen un nombre que los describe y en los que se

Un método es una o mas instrucciones que se ejecutan para _ _ ,
aplica las mismas reglas: el nombre puede ser de cualquier

realizar una tarea concreta; una accién de algun tipo. Hay una _ ,
_ ) _ _ ) _ longitud, pero debe comenzar con una letra y contener solo
gran cantidad de métodos de serie. Por ejemplo, el método Quit . » _

_ o ) caracteres alfanuméricos (a-z, A-Z, 0-9) o un guion bajo ().
provoca la salida de la aplicacion. La mayoria de las clases

incorporan sus propios métodos. Por ejemplo la clase ListBox - Parameters

tiene un método llamado AddRow para afiadir filas (tal y como se Los parametros son los valores pasados al método para que
deduce de su nombre). los pueda utilizar.

También puedes crear tus propios métodos. - Return Type

Los métodos que no precisan

Imagen 3.2. Editar un Método en el Editor de Cddigo. devolver un tipo de dato Imagen 3.3. El
Saykello(name As String) Method Name [Sayhello B concreto se denominan Navegador Mostrando
S k("H 11 ! * ) As String - 7 z H
peak("Hello " + name Parameters | name Subrutinas. Los métodos que metodos Protegido,
_— ndi la devolucién d . Privado y Publico de
u Sw |[pub.i< :]I indican la devolucion de un tipo una Clase.
| ce dato se denominan
Un método tiene cuatro valores que debes definir utilizando el Funciones. v [=| Methods
i DeleteDat
Inspector: El Tipo de dato Devuelvo puede E a: eData
ser cualquier tipo de dato valido, ’® LoadData
'=| SaveData

incluyendo las clases.
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- Scope
El Scope o ambito indica quién puede llamar al método. Los
valores son Public (Publico), Protected (Protegido) y Private
(Privado).

- Los métodos Publicos pueden ser llamados por cualquiera
sin restricciones.

- Los métodos Protegidos tienen algunas restricciones, y que
varian en funcion de donde esté ubicado el método (Clase o
Modulo).

- Los métodos Privados sdlo pueden ser llamados por el
modulo o la clase que contiene el método.

Pasar Valores a los Métodos

Algunos métodos precisan uno o mas datos para realizar su
funcion. Estas piezas de informacidon se denominan parametros.
Se pasan los parametros a los métodos situandolos a la derecha
del nombre del método. En el siguiente ejemplo, se llama al
método AddRow del ListBox llamado ListBox1. AddRow afiade
una fila al final del ListBox y escribe texto en la nueva fila. Para
ello, has de pasar el texto a AddRow como parametro. He aqui
un ejemplo:

ListBox1l.AddRow("January")

Cuando pasas parametros has de hacerlo del tipo de dato
correcto. Por ejemplo, AddRow requiere un String. Si necesitas
afadir un numero al ListBox habras de convertirlo primero a
String. Por ejemplo, si necesitas afadir el nUmero 12,7 al ListBox,
puedes escribir:

ListBoxl.AddRow("12.7")

O puedes utilizar la funcion Str incluida de serie y que se encarga
de convertir a cadena el niUmero pasado. Lo siguiente también
funciona:

ListBoxl.AddRow (Str(12.7))

La funcidn Str es en si misma un método que requiere de un
parametro, un nimero, y devuelve una String. De modo que esta
expresion toma el nimero que quieres mostrar, lo convierte en
una cadena y pasa la cadena al método AddRow.

Si un método requiere mas de un parametro se utiliza la coma
para separar cada uno de ellos. La clase ListBox tiene un método
llamado InsertRow que se utiliza para insertar nuevas filas en
cualquier posicion en un ListBox. El método InsertRow requiere
de dos valores: el numero de fila y donde deberia aparecer la
nueva fila y el valor de cadena que ha de mostrarse en la nueva
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fila. Dado que se usa mas de un parametro, estos se separan
mediante el uso de la coma:

ListBox1l.InsertRow(3, "January")

Los parametros también pueden ser variables o constantes. Si se
pasa una variable como parametro, entonces se estara pasando
el valor actual de dicha variable. En el siguiente ejemplo se
asigna un valor a una variable y se pasa como parametro:

Dim month As String
month = "January"
ListBoxl.InsertRow(3, month)

Paso de Arrays como Parametros

Se puede pasar un array como parametro en la llamada a un
método o funcion. Se pueden pasar tanto los array
unidimensionales como los multidimensionales. Para especificar
que un parametro es un array unidimensional has de poner
paréntesis tras su nombre en la declaracion. Por ejemplo:

names() As String

puede utilizarse en la declaracion cuando quieres pasar un array
de cadenas a la subrutina. Dado que no necesitas indicar la
cantidad de elementos del array, puedes pasar una cantidad
diferente de elementos en diferentes partes de tu cédigo. Cuando
pasas un array a un método o funcién, omite los paréntesis del
array. Por ejemplo:

PrintLabels(allNames)

PrintLabels es el nombre del método que acepta el array de
cadenas como su parametro.

Puedes pasar arrays multidimensionales sin indicar la cantidad
de elementos en cada dimensidn, si bien has de indicar la
cantidad de dimensiones. Para ello, has de incluir una coma de
menos entre los paréntesis que dimensiones disponibles. Por
ejemplo, si names fuese un array multidimensional de cadenas
(String), deberias declarar el array de la siguiente forma:

names(,) As String
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Cuando pasas un array multidimensional a un método o funcion
has de incluir los paréntesis, pero no las comas:

PrintLabels(allNames())

Devolver Valores desde los Métodos

Algunos métodos devuelve valores. Estos métodos se denominan
Funciones. Cuando un método devuelve un valor, el valor se
devuelve desde el método a la linea de cddigo que ha llamado el
método. Por ejemplo, el método global Ticks devuelve la
cantidad de ticks (un tick es 1/60 de segundo) transcurridos
desde que has encendido el ordenador. Puedes asignar el valor
devuelto por un método del mismo modo que asignas un valor.
En el siguiente ejemplo, el valor devuleto por Ticks se asigna a la
variable elapsed:

elapsed = Ticks

Algunos métodos requieren parametros y devuelve un valor. Por
ejemplo, la funcion Chr devuelve el caracter correspondiente al
cddigo ASCII pasado. Cuando pasas parametros a los métodos
que devuelven valores, los parametros deben estar contenidos
entre paréntesis. En el siguiente ejemplo, se pasa a la funcién Chr

el codigo 13 (codigo ASCII para Return) y devuelve el codigo
ASCII a la variable carriageReturn:

carriageReturn = Chr(13)

En el siguiente ejemplo, el valor numérico devuelto por la funcion
Len (que devuelve la cantidad de caracteres en la cadena de
texto recibida) se pasa a la funcion Str (que convierte un valor
numérico a cadena). La cadena devuelta por la funcidn Str se
pasa como parametro al método InsertRow de un ListBox:

ListBoxl.InsertRow(3, Str(Len("Hello")))

Paso de Parametros por Valor y Referencia

Por defecto se pasan los valores a un método por valor. Cuando
se hace esto, el método recibe una copia de la informacién
pasada, permitiendo al método modificarla sin afectar el valor
original.

Los parametros pasados por valor son tratados como variables
locales dentro del método — justo como variables creadas con la
instruccion Dim. Esto significa que puedes modificar los valores
de los parametros propiamente dichos en vez de tener que
asignar previamente el parametro a una variable local. Por
ejemplo, si pasas un valor en el parametro “x”, puedes
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incrementar o decrementar el valor de x en vez de asignar el valor
de x a una variable local que se hubiese creado con Dim.

Este ejemplo modifica el parametro y muestra el resultado:

Sub SquareIt(d As Integer)
d=d*d
MsgBox (Str(d))

End Sub

Cuando escribes tus propios métodos tienes la opcion de pasar
la informacioén por referencia. Cuando pasas la informaciéon por
referencia estaras pasando en realidad un puntero al objeto que
contiene dicha informacion. La ventaja practica de esta técnica
es que el método puede cambiar los valores de cada parametro y
sustituir los valores de los parametros por los valores cambiados.
Cuando pasas parametros por valor, no puedes hacerlo dado que
el parametro sélo representa una copia de la informacién
propiamente dicha.

Nota: Todos los arrays y cualquier tipo de objeto se pasan
siempre por referencia independientemente de lo que se haya
indicado en la declaracion del método.

Muy pocos de los métodos incluidos de serie funcionan de este
modo. Uno de ellos es la funcion ParseDate. ParseDate toma una
fecha escrita como texto y devuelve un objeto Date. Lo que es
poco usuarl en el caso de ParseDate es que el objeto Date

devuelto lo hace en un parametro pasado al método. La funcion
ParseDate propiamente dicha devuelve un valor Booleano que
indica si la funcidn ha tenido éxito o no.

Un método o funcidn que pasa un parametro por referencia utiliza
la palabra clave ByRef en su sintaxis. En este caso, la sintaxis
para ParseDate es:

result = ParseDate(Text, ByRef Parsedate)

« Text contiene la cadena que ha de parsearse a Date

« ParsedDate contiene el objeto Date, permitiendo que funcione
la llamada a la funcion

« Result es un valor Booleano que indicara si la funcién ha tenido
éxito o no.

Para usar ParseDate, declara la variable Date y una variable
Boolean con instrucciones Dim. A continuacion pasa la nueva
variable Date junto con la cadena a parsear. Después de la
llamada, comprueba el resultado para determinar si la funcién ha
tenido éxito. Por ejemplo:
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Dim theDate As New Date
Dim success As Boolean
success = ParseDate("12/14/1991", theDate)
If success Then
MsgBox (thedate.AbbreviatedDate)
Else
MsgBox ("Invalid Date format!")
End If

Parametros Opcionales y Parametros por defecto

Hay dos modos de hacer que un parametro sea opcional, y
ambos se aplican en el momento de escribir la declaracion:
puedes asignar un valor al parametro durante la declaracién o
puedes usar la palabra clave Optional en la declaracion.

El modo de lograr que sea claro y de forma explicita el estado de
un parametro es usando la palabra clave Optional. Este
modificador precede al nombre del parametro y puede utilizarse
con o sin un valor por defecto. Si quien llama al método omite
este parametro, recibira el valor por defecto para este tipo de
dato en el caso de que no se haya indicado un valor por defecto
en la declaracion. Por ejemplo:

MyMethod(a As Integer, b As Integer,
Optional ¢ As Integer)

El parametro ¢ es opcional y si se omite en la lamada al método,
el método obtendra el valor por defecto de un entero, y que es 0.

Si quieres indicar un valor diferente, puedes asignarlo:

MyMethod(a As Integer, b As Integer,
Optional ¢ As Integer = 5)

En este ejemplo, el parametro aun es opcional, pero si se omite
en la llamada al método, este obtiene el valor de 5.

Por Ultimo puedes omitir la palabra clave Optional cuando se
proporciona un valor por defecto:

MyMethod(a As Integer, b As Integer, c As
Integer = 5)

Indentificar el nombre del Método desde Caodigo

Con el propdsito de logado puede resultar con frecuencia Util
saber cual es el nombre del método en curso. Utiliza la Constante
CurrentMenthodName para obtener el nombre del método que se
esté ejecutando en ese momento:

MsgBox (CurrentMethodName)
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Setters

Un valor pasado a un método se proporciona por lo general entre
paréntesis a continuacion del nombre del método, como en:

MyMethod (10)

Algunas veces es preferible que la llamada al método muestre un
comportamiento distinto, de modo que puedas asignar un
parametro como en:

MyMethod = 10

Esto se denomina un Setter dado que estas asignando el valor 10
a MyMethod en vez de pasando el valor 10 como parametro a
MyMethod. Puedes conseguir esta sintaxis alternativa utilizando
la palabra clave Assigns en la declaracion del parametro:

Sub MyMethod (Assigns value As Integer)

Eventos
Los Eventos son un tipo de método especial utilizado por lo

general en las clases de los controles; pero también pueden
implementarse en tus propias clases no relacionadas con
controles. Los eventos solo pueden ser llamados por las clases

que declaran el evento. Por lo general, los eventos se utilizan
para que las subclases puedan proporcionar funcionalidad
adicional.

No has de preocuparte de los Eventos justo ahora. Tanto las
subclases como los eventos se describen en mas detalle en el
capitulo Clases.
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Capitulo 4

Modulos

4.1. Acerca de los Modulos

4.2. Agrupar items de Proyecto (Espacio de nombres)

4.3. Métodos de Extension

Aprende como se pueden utilizar los modulos para
organizar tu codigo.
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Seccion 1

Acerca de los Modulos

Entender los Modulos
Un mddulo es una coleccion de items de proyecto, generalmente

métodos, propiedades y constantes. Pero un médulo también
puede contener otros elementos de proyecto como clases o
incluso otros moddulos. De hecho, los mdé’dulos pueden contener
practicamente cualquier cosa excepto ventanas y controles
Container.

Se considera que los mddulos son globales y son accesibles
desde cualquier parte del proyecto.

Sin embargo puedes controlar el ambito de los items afadidos a
los médulos.

Cuando utilizar un Modulo
Por lo general los mddulos deberian de utilizarse de forma

esporadica en un lenguaje orientado a objetos como Xojo. En la
mayoria de los casos, probablemente estés mejor cubierto con
una clase.

Dicho esto, existen varios usos habituales (y validos) para los
mddulos:

- Constantes globales, particularmente en el caso de la
localizacion

- Agrupar elementos de proyecto en un espacios de nombre
« Extensiones de Clase

- Propiedades y métodos globales, si bien deberian de ser
minimos

Tratamos los mddulos primero aqui dado que son mas faciles de
usar y aprender y sirven de transicion a las clases (tratadas en el
préximo capitulo).

Anadir un Modulo
Puedes afiadir un nuevo médulo a tu proyecto haciendo clic en

el boton Insert en la barra de herramientas y seleccionando
Module Module (o usando el menu Insert » Module o el menu
contextual). El nuevo mddulo aparece en el Navegador con un
nombre por omision (el primer mddulo que afiadas se nombrara
Module1, por ejemplo). También puedes usar el Inspector para
cambiar el nombre del mddulo a algun otro mas apropiado. Por
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ejemplo, si el modulo contiene funciones financieras

probablemente quieres llamarlo Finanzas.

Editas los modulos con el Editor de Cddigo: sdlo has de hacer
clic en el nombre del médulo en el Navegador. Los mddulos se
identifican en el Navegador por su

icono especial (&8).

Figura 4.1. El
Navegador,
mostrando métodos
Protegido, Privado y
Global en un
Modulo,

Los modulos contienen
principalmente propiedades,
constantes y métodos.

Anadir Propiedades a los

v |= Methods
Modulos ‘5| DeleteData
Las Propiedades son variables que g LoadData
= SaveData

pertenecen a todo el médulo en vez
de a un unico método.

Para afadir una propiedad a un mdodulo, usa el boton Add en la
barra de herramientas del Editor de Cédigo, el menu Insert »

Property, el menu contextual o el atajo de teclado (Opcion-
Comando-P en OS X o Ctrl+Shift+P en Windows y Linux).

Puedes definir el nombre de la propiedad, tipo, valor por defecto
y visibilidad (@mbito) usando los correspondientes campos del
Inspector.

Nota: Para crear una propiedad rapido, puedes introducir tanto el nombre y
tipo en una linea en el campo Name: PropertyName As DataType. al dejar el
campo, el tipo pasara al campo Type.

Anadir Métodos a los Modulos
Para anadir un método a un moédulo, utiliza el botén add en la

barra de herramientas del Editor de Cédigo, el menu Insert »

Method, el menu contextual o el atajo de teclado (Opcién-
Comando-M en OS X o Ctrl+Shift+M en Windows y Linux).

Puedes definir el nombre del método, parametros, tipo devuelto y
visibilidad (ambito) utilizando el Inspector.

Anadir Constantes a los Moddulos
Tal y como se ha tratado anteriormente en Capitulo 3: El Lenguaje

de Programacion Xojo, las constantes son similares a las
variables cuyos valores no pueden modificarse durante la
ejecucion del programa.

Cuando afiades una constante a un modulo, esta pertenece al
modulo y no a un método en concreto.

Para afadir una constante a un modulo, utiliza el botén Add de la
barra de herramientas del Editor de Cédigo, el menu Insert »
Constant, el menu contextual o el atajo de teclado (Opcion-
Comando-C en OS X o Ctrl+Shift+C en Windows y Linux).

Desafortunadamente, las constantes creadas de este modo no
puedes ser valores asignados a funciones, tal y como si ocurre
cuando se crean con la palabra reservada Const en un método.
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Una forma de simular este comportamiento es afadiendo un
método al mddulo y devolviendo el valor deseado.

Por ejemplo, para crear un método que devuelva el caracter de
retorno (ASCII 13), puedes anadir el siguiente método a un
modulo:

Function CR as String
Return Chr(13)
End Function

Ambito de los items de Modulo
Cuando afades un item a un médulo has de definir su ambito

usando la propiedad Scope del Inspector. El ambito también se
indica en el Navegador. EI ambito de un item determina su
accesibilidad por parte de otros items del proyecto. Hay tres
opciones:

- Global: Un item Global esta disponible para el cédigo de toda
la aplicacion. El ambito Global esta disponible sdélo para los
items en los mddulos. Por ejemplo, puedes usar una propiedad
global para almacenar un dato que deba estar disponible para
varias ventanas o para la aplicacion como un todo incluso
aunque no esté abierta ninguna ventana (s6lo OS X). Cuando tu
cddigo necesite acceder a un item global sélo has de indicar su

nombre desde cualquier parte de la aplicacion. El ambito Global
no esta disponible para los items en los modulos anidados.

Public: Un item Public (publico) también esta disponible para
todo el codigo de la aplicacion. Cuando necesites acceder a un
item publico desde fuera del mddulo, utiliza la notacién por
punto y precede su nombre con el nombre del médulo. Por
ejemplo, si declaras una propiedad Public MyPublicProperty en
Modulel, puedes llamarla con la sintaxis
Modulel.MyPub'licProperty desde fuera de Modulel. Si
creas una propiedad Public en un mdédulo anidado, necesitaras
usar toda la ruta a la propiedad cuando la referencies desde
fuera del moédulo. Por ejemplo, si declaras una propiedad
Public, myPublicProperty, en Module2 que esté anidada en
Module1, deberas de referirte a ella fuera desde fuera del

mddulo como Modulel.Module2.MyPublicProperty.

Private: Un item Private (privado) esta disponible sélo desde
dentro del mddulo. Es “invisible” al resto de la aplicacion.
Cuando necesites acceder a un item Privado desde el mddulo
en el que se ha creado, solo tendras que utilizar su nombre. Si
has creado un item Privado en un modulo anidado, no podra
ser accedido desde modulos de un nivel superior. Sin embargo,
los items Privados en mddulos de nivel superior pueden ser
accedidos desde los mddulos anidados.
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Seccion 2

Agrupar [tems de Proyecto (Espacios de nombre)

Anadir items de Proyecto a Modulos
Los mddulos también pueden contener otros elementos de

proyecto, como clases, interfaces de clase e incluso a otros
moddulos. Los mddulos no pueden contener ventanas (Window),
Paginas Web, iOSViews o Containers.

La capacidad de los modulos de contener clases, interfaces de
clase y otros modulos representa el espacio de nombre del
modulo para el sistema. Las clases,
interfaces y modulos “viven” dentro del

Figura 4.2. El
espacio de nombre del médulo. Un Navegador
espacio de nombre de médulo contrasta ~ Mostrando un
con el espacio de nombre raiz y que modulo que

P ya contiene Clases.
queda representado por el proyecto v (@ Modulel
propiamente dicho. Las clases, v @ Classes
interfaces de clase y médulos que estan @ Class1

listados en el Navegaodr estan
técnicamente en el espacio de nombre
raiz del proyecto.

Una clase en un modulo “vive” dento del modulo. Fuera del
modulo, una clase de mddulo se referencia mediante la notacion
por punto. Algunos ejemplos:

Dim ¢ As New Modulel.Classl
c.MethodCall

En el anterior ejemplo, Class1 esta contenida en Module1.

En el Navegador, un mddulo presenta un elemento de despliegue
(un pequefio triangulo) en el caso de que contenga a otros
elementos de proyecto.

La instruccion Using

Puedes emplear la instruccion Using para evitar el tener que
escribir el espacio de nombre completo cada vez que quieras
acceder a un item de su interior. Por ejemplo, puedes escribir
codigo como este y evitar el tener que usar la notacion por punto
para acceder a las clases dentro de Module1:
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Using Modulel
Dim ¢ As New Classl // en Modulel
c.MethodCall

Convertir una Clase de Proyecto en Clase de
Modulo

Puedes cambiar una clase de proyecto a clase de médulo. Las
clases de proyecto aparecen en el Navegador y estan disponibles
de forma global para el proyecto.

Para convertir una clase de proyecto a una clase de mdédulo en el
Navegador, arrastra la clase sobre el nombre de mddulo.

Advierte el pequefio contorno de color azul bordeando el nombre
del mdédulo. Esto indica que la clase se anadira al médulo.

Cuando se complete el arrastre, la clase aparecera indentada en
el mdédulo.

Anidar un Médulo en un Moédulo
Un mddulo puede contener a otros mdédulos. Un mddulo anidado

en otro mddulo puede tener clases, interfaces, métodos,
propiedades, constantes, estructuras y enumearciones, tal y
como un modulo de primer nivel. El ambito del item determina el
modo en el que lo referenciaras desde fuera de su mddulo. Sin

embargo, los mddulos de nivel superior no pueden “ver” los items
de los modulos anidados.

Puedes indicar los items de un médulo utilizando el nombre del
modulo como prefijo.

El nuevo mddulo puede contener otros mddulos. El anidado de
modulos puede continuar de forma

indefinida.
Figura 4.3. Un
modulo que contiene

Un método dentro de una clase, _
una clase Privada.

dentro de un moédulo ve los

v @ Modulel
v @ Classes

miembros del mdédulo del mismo
modo que lo haria un método

directamente dentro del modulo. La

clase contenida tiene acceso a

todos los miembros privados del médulo, y puede referenciar
todos los miembros publicos del mdédulo sin tener que indicar el
nombre del mdédulo.

Ambito de los Items de un Médulo Anidado
Cuando afades un item a un moédulo anidado has de definir su

atributo Scope. El Scope de un item determina qué otros
elementos del proyecto pueden acceder al mismo. Hay dos
posibles valores:

- Public: Un item Public (publico) esta disponible para el cédigo
de toda la aplicacién. Si creas un item Public en un médulo

anidado, has de incluir toda la ruta al item cuando lo
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referencies. Por ejemplo, si declaras una propiedad Public,
MyPublicProperty, en Module2 que esta anidado en Module1,
podras hacer referencia a este desde fuera de su propio
modulo como Modulel.Module2.MyPublicProperty. Si
declaras una propiedad Public en Module1, puedes acceder a
ella desde el Module2 como Modulel.MyPublicProperty.

Private: Un item Private (privado) esta disponible solo desde el
moddulo. Es “invisible” para el resto de la aplicacion. Cuando el
cddigo desde dentro del mddulo necesita acceder a un

método, propiedad o constante privados, simplemente puedes
indicar su nombre. Si creas un item privado en un médulo
anidado, este no puede ser accedido por modulos de nivel
superior. Sin embargo, los items Privados de un nivel superior si
pueden ser accedidos desde los modulos anidados.
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Seccion 3

Meétodos de extension

Un método de extensidon de clase es un método que puede
invocarse utilizando sintaxis que indica que pertenece a otro
objeto. Por ejemplo, puedes anadir un método invocado desde
cualquier objeto Folderltem para guardar algo en un formato
concreto. Una vez que afiadas un método de extension de clase
a un mddulo, puedes invocarlo como si hubiese sido creado
como parte de la propia clase Folderltem.

Esta caracteristica es Util cuando necesitas ampliar una clase
para la que no tienes acceso al cédigo fuente. En particular
permite ampliar la funcionalidad de las clases incluidas en el
Framework incorporado.

Utiliza la palabra clave Extends para definir un método como
extension de clase antes del primer parametro. El tipo de dato
del primer parametro es el tipo de objeto desde el que debe
invocarse el método. En otras palabras, el uso de la palabra
clave Extends indica que el parametro se utiliza a la izquierda del
operador punto “.” en la instruccion de llamada. Cuando utilizas
la palabra clave Extends, no has de pasar un objeto de dicho

tipo al método. Puedes anadir parametros “normales” en la

declaracion de parametros a la declaracion de parametros que
prosigue al parametro Extends.

La palabra clave Extends se puede utilizar sélo con los métodos
globales que residen en los mddulos. Siempre que el modulo
esté en el proyecto, el método de extension de clase puede
invocarse desde cualquier parte del proyecto.

Para utilizar el método de extensiéon de clase en otro proyecto,
sOlo has de importar el modulo en dicho proyecto.

Escribir un Método de Extension de Clase
Por ejemplo, puedes afiadir un método que pueda invocarse

desde un objeto Text Area. Supongamos que quieres un método
Clear que borre el texto de un Text Area. Crea un modulo en el
proyecto en el caso de que no haya alguno ya creado y anade un
método Clear al mddulo.

Asi es como se indica el Parametro:

Extends ta As TextArea
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El cddigo para esta extension es simple:

ta.Text = ""

La palabra clave Extends indica que el método puede invocarse
desde cualquier objeto Text Area que esté en el proyecto.
Advierte también que el Ambito para el método de extensién de
clase ha de ser Global.

Llamar a un Método de Extension de Clase

Puedes invocar este método desde cualquier parte del proyecto.

Solo has de incluir la linea en cualquier parte de una Window:

Figura 4.4. Método de Extension Clear.

untitled

% b @ (= 0

Insert Run  Build Help Feedback Library Inspector

Q Filter RN EREIREE] L &

[@) untitled < > | Clear(Extends tf As TextField) Method Name | Clear

CONTENTS L tf.Text = "

T

v |

App Parameters  Extends tf As TextField

] window1

MainMenuBar

Return Type
e Modulel

@ Constants Scope | Public

Methods
B Clea

TextAreal.Clear

Esto asume que en este caso se encuentra un Text Area con el
nombre TextAreal.

Para usar el método de extension de clase en otro proyecto, todo

lo que necesitas hacer es copiar el médulo que contiene la
definicién del método de extension de clase al otro proyecto.
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Capitulo 5

Clases

Las clases son los bloques fundamentales de todas
las aplicaciones Xojo. Este capitulo cubre disefo
orientado a objetos y como utilizar eficazmente las
clases en tus proyectos.

W,
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5. Clases
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5.3.

5.4.
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5.6.
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Sobre las Clases

Conceptos de Disefio Orientado a Objetos
Propiedades, Métodos y Eventos
Constructores y Destructores

Interfaces

Ejemplos de Subclases

Caracteristicas Avanzadas de Clases



Seccion 1

Sobre las Clases

¢Qué es una Clase?
En su forma mas simple, una clase es un contenedor de cddigo

tal y como ocurre en el caso de un mddulo. Pero a diferencia del
modulo, una clase proporciona una mejor reutilizacion del
caodigo.

Las clases son los blogues de construccidon fundamentales de la
programacion orientada a objetos.

Las Ventajas de las Clases

Las clases ofrecen una gran cantidad de ventajas, incluyendo:

- Cdédigo Reutilizable
Cuando afiades codigo a un control PushButton para
personalizar su comportamiento, sélo puedes utilizar ese
cdodigo con ese PushButton. Si quieres usar el mismo cdodigo
con otro PushButton, tienes que copiar el cddigo y hacer los
cambios necesarios en el caso de que se refiera al PushButton
original (dado que el nuevo PushButton tendra un nombre
distinto).

Las clases almacenan el codigo una vez y se refieren al objeto

(como el PushButton) de forma genérica de modo que se
pueda reutilizar el mismo cdédigo siempre sin modificacion. Si
creas una clase basada en el control PushButton y anades tu
cddigo a la clase, cualquier instancia de dicha clase
personalizada tendra dicho cdédigo.

Proyectos y aplicaciones mas pequeno

Dado que las clases te permiten almacenar el cddigo sélo una
vez y utilizarlo tantas como necesites en el proyecto, tu
proyecto y la aplicacion resultante tendran un tamano mas
pequeno y requerirdn menos memoria.

Mantenimiento del Cédigo mas sencillo

Menos cddigo significa menos mantenimiento. Si tienes
basicamente el mismo cddigo en varias ubicaciones de tu
aplicacion, tendras que recordarlo cada vez que debas de
hacer un cambio o corregir bugs. Al almacenar una copia del
cddigo, pasaras menos tiempo haciendo seguimiento de todas
esas partes del proyecto en las que estés utilizando el mismo
codigo. Al hacer un cambio en el cédigo de una clase, se
actualizara automaticamente alla donde se utilice la clase.
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- Depuracion mas sencilla
Cuanto menos codigo tengas, menos codigo tendras que
depurar.

- Mayor Control
Las clases te proporcionan mayor control del que puedes
obtener afiadiendo cddigo en los manejadores de evento de un
control en una ventana. De hecho, algunas clases pueden
incluso gestionar menus. También puedes usar clases para
crear controles personalizados. Y con las clases tienes la
opcion de crear versiones que no permitan el acceso a su
cddigo fuente, permitiéndote crear clases para compartir o
vender a otros.

Usar las Clases en tus Proyectos
Antes de usar una clase en tu proyecto es importante entender la

diferencia entre estos conceptos: la clase propiamente dicha, la
instancia de la clase y la referencia a la clase.

La Clase

Piensa en la clase como en una plantilla para contener
informacién, como un mddulo. Y como ocurre con los médulos,
cada clase existe en tu proyecto sélo una vez. Pero a diferencia
de los mddulos, una clase puede tener multiples instancias.

La Instancia

Las clases proporcionan una mejor reutilizacion del cédigo
debido a un concepto denominado instancias. A diferencia de un

modulo, que existe solo una vez en tu aplicacion, una clase
puede tener multiples instancias. Cada instancia (también
llamada objeto) es una copia separada de la clase y todos sus
métodos y propiedades.

Por ejemplo, hay multiples clases disponibles de serie para los
controles de interfaz de usuario como el PushButton, WebButton,
Label, WeblLabel, TextField, WebTextField, ListBox y WebListBox.

Por si mismas las clases de controles no son tan utiles; solo son
plantillas abstractas. Pero cada vez que anades un control a una
ventana obtienes una instancia de la clase. Dado que cada botén
es una instancia independiente, esto es lo que te permite tener
multiples botones en una ventana y que cada uno de ellos sea
completamente independiente del otro.

Estas instancias son con las que interactlas cuando escribes
codigo en la ventana, y es con lo que interactua el usuario
cuando se encuentra utilizando tu aplicacion.

Por ejemplo, cuando arrastras un TextArea desde la Biblioteca
hasta una ventana estas creando una instancia del TextArea en la
ventana. La nueva instancia tiene todas las propiedades y
método que se hayan creado en la clase TextArea. Obtendras
todas ellas sin que debas de hacer nada concreto: texto con
estilo, multiples lineas, barras de desplazamiento, y el resto de
capacidades. Personalizas dicha instancia en concreto de
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TextArea modificando los valores de las propiedades de la
instancia.

Cuando afiades un control a una ventana (o pagina web), el
Editor de Disefo crea automaticamente la referencia para ti (esta
es el nombre del control).

Cuando escribes codigo puedes crear instancias de las clases
mediante el uso de la palabra clave New:

Dim car As New Vehicle

La Referencia

Una referencia es una variable o propiedad que referencia una
instancia de clase.

En el anterior cddigo de ejemplo, la variabla car es una referencia
a una instancia de la variable Vehicle.

Interactlas con las propiedades y métodos de la clase utilizando
la notacién por punto:

Dim car As New Vehicle
car.Brand = "Ford"
"Focus"

car .Model

Aqui Brand (Marca) y Model (Modelo) han sido definidas como
propiedades de la clase Vehicle, a las que se les asigna valores
para dicha instancia en concreto.

Recuerda que esta variable o propiedad esta apuntando a una
referencia de la instancia. Esto tiene consideraciones importantes
cuando se asigna la referencia a otra variable.

Cuando realizas una asignacion de una variable de referencia a
otra, la segunda variable apunta a la misma referencia que la
primera variable. Esto significa que esta apuntando a la misma
instancia de la clase, y no a una copia de la misma. Si cambias
una propiedad de la clase con cualquiera de las variables,
entonces se habra cambiado para ambas variables. Este ejemplo
puede ayudar:
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Figura 5.1. Dos variables

Dim car As New Vehicle que apuntan a la misma
car.Brand = "Ford" instancia.
car.Model = "Focus"

Vehicle Instance

Dim truck As Vehicle Brand = Tonf’
Model = "Focus

truck = car
// truck.Model = "Focus"

car.Model = "Mustang"

// truck.Model es ahora también "Mus-

tang"

truck.Model = "F-150" Dim car As New Vehicle

// car.Model es ahora también "F- car.Brand = "Ford"

150" car.Model = "Focus"

Dim truck As New Vehicle

Si observas la Figura 5.1, puedes ver que tanto las variables car truck.Brand = car.Brand
como truck apuntan a la misma instancia de Vehicle. De modo trunk.Model = car.Model

que al cambiar una también se cambia en la otra.

// truck.Model Ahora también "Focus"
truck.Model = "F-150"

Si quieres crear una copia de una clase, necesitas crear una
nueva instancia (usando la palabra clave New) y copiar entonces
cada una de sus propiedades tal y como se muestra a

continuacion: // car.Model Sigue siendo "Focus"
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Cuando lo haces de esta forma obtienes dos instancias
independientes. Los cambios en una no afectan a la otra.

Vehicle Instance
Brand = "Ford"
Model = "F-150"

Vehicle Instance
Brand = "Ford"
Model = "Focus"

Crear Clases
Anadir una clase al proyecto es sencillo. Para anadir una nueva

clase, haz clic en el botdn Insert de la barra de herramientas y
elige Class o selecciona Class en el menu Insert. Esta accion
afnade una nueva clase al Navegador con un nombre por defecto
(Class1 para la primera clase).

Usa el Inspector para cambiar el nombre de la clase.

Al igual que en los mddulos, las clases contiene principalmente
propiedades y métodos.

Anadir Propiedades a las Clases
Las propiedades son variables que pertenecen a toda la instancia

de clase en vez de a un método en concreto.

Para anadir una propiedad a una clase, usa el boton Add en la
barra de herramientas del Editor de Codigo, el menu Insert »

Property, el menu contextual o el atajo de teclado (Opcion-
Command-P en OS X o Ctrl+Shift+P en Windows and Linux).

Puedes definir el nombre de la propiedad, el tipo, valor por
defecto y ambito utilizando el Inspector.

Nota: Para crear una propiedad con mayor rapidez, puedes escribir su
nombre y tipo en una linea en el campo Name: PropertyName As DataType.
Cuando abandones el campo, el tipo pasara automaticamente al campo

Type.

Las propiedades afadidas asi se denomina por lo general
Propiedades de Instancia dado que sélo se pueden utilizar en
las instancias de la clase.

También puedes anadir propiedades a las que se acceda
mediante la clase propiamente dicha, sin necesidad de crear
previamente una instancia. Estas se denominan Propiedades
Compartidas (Shared Properties).

Propiedades Compartidas

Una propiedad compartida (también conocida como Propiedad
de Clase) es como una propiedad “normal” salvo que pertenece
a la clase, no a una instancia de la clase. Una propiedad
compartida es global y puede accederse desde cualquier parte
que permita su ambito. En muchos aspectos funciona al igual
que hacen las propiedades de modulo.
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Es importante comprender que las propiedades compartidas son
literalmente compartidas. Si cambias el valor de una propiedad
compartida, esta varia en todas partes.

Hablando de forma general, las propiedades compartidas son
una caracteristica avanzada que solo necesitas en casos
especiales.

Anadir Métodos a las Clases
Para anadir un método a una clase, utiliza el botén Add de la

barra de herramientas del Editor de Cddigo, el menu Insert »

Method, el menu contextual o el atajo de teclado (Opcidn-
Comando-M en OS X o Ctrl+Shift+M en Windows y Linux).

Puedes definir el nombre del método, los parametros, tipo
devuelto y ambito usando el Inspector.

Nota: Cuando escribas el nombre del método, el campo te permitira
autocompletar con los nombres de cualquier método de su superclase.

Los métodos anadidos de esta manera se denominan Métodos
de Instancia dado que solo se pueden utilizar desde una

instancia de la clase.

También puedes afiadir métodos que se invoquen desde la clase
propiamente dicha. Estos se denominan Métodos Compartidos.

Métodos Compartidos

Un método compartido (a veces denominado Método de Clase)

es como un método normal, excepto que pertenece a la clase, no

a la instancia de la clase. Un método compartido es global y
puede invocarse desde cualquier parte que permita su ambito. En
muchos aspectos es como un método de modulo.

Es importante entender que los métodos compartidos son
realmente compartidos. No conocen ninguna instancia, de modo
que sélo pueden acceder a otros métodos o propiedades
compartidas de la clase.

Hablando de forma general, los métodos compartidos son una
caracteristica avanzada que sélo necesitaras utilizar en casos
especiales. Por ejemplo, si estas usando una instancia de clase
para llevar el seguimiento de items (por ejemplo personas,
mercancias, transacciones de ventas, etc.) puedes usar una
propiedad compartida como contador. Cada vez que crees o
destruyas una instancia de la clase, puedes aumentar el valor de
la propiedad compartida, o bien reducirlo en su destructor. (Para
obtener informacion sobre los constructores y destructores,
consulta la seccion Constructores y Destructores). Cuando
accedas a dicha propiedad obtendras la cantidad de instancias
de la clase.
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Seccion 2

Conceptos de Diseno Orientado a Objetos

Esta seccion cubre algunos conceptos importantes de disefio
orientado a objetos que se aplican a las clases: Encapsulacion,
Sobrecarga, Herencia y Polimorfismo.

Encapsulacion
La encapsulacién es el proceso de ocultar la informacion que no

precisa estar expuesta. Con las clases puedes controlarlo
usando el ambito de tus propiedades y métodos. En orden de
menor visibilidad a mayor visibilidad son: Privado (Private),
Protegido (Protected) y Publico (Public).

Privado

Definir el ambito como privado significa que el item sélo es
accesible desde la actual instancia de clase (o clase en el caso
de los items compartidos). Esto hace que sea invisible para el
resto de tu codigo.

Este es el ajuste mas restrictivo. Es una buena practica de
programacion tener el habito de definir los items como Privados
si no son necesarios fuera de la instancia de clase.

Es una practica comun utiliza “m” como prefijo de las
propiedades privadas, como:

Figura 5.2 El
Navegador mostrando

métodos Protegido,
Protegido Privado y Publico en

Un &mbito protegido significa una Clase.

, . ¥ | TestClass
que el item es accesible desde la _

v |=| Methods

mUserName As String

actual instancia de clase (o casle

5| DeleteData
para los items compartidos), asi '3 LoadData
como para sus subclases. |=| SaveData

Un método, propiedad o

constante protegidos sélo esta disponible para el codigo de la
clase y las subclases basadas en dicha clase. Es “invisible” para
el resto de la aplicacion. Cuando otro cédigo de la clase necesita
acceder al método, propiedad o constante protegida, solo
precisa hacerlo usando su nombre. Si intentas acceder a un
método, propiedad o constante protegida desde fuera de la
clase, obtendras un error informativo cuando intentes ejecutar la
aplicacion, indicando que el item esta fuera de ambito.
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Publico

Un método, propiedad o constante publica esta disponible para
todo el codigo de la aplicacion. Puedes referenciarlo utilizando la
notacion de punto, usando la referencia de clase y el nombre

como en el caso de car.Modell.

Sobrecarga  Figura 5.3 Método Calculate
La sobrecargaes ~ Sobrecargado.
el término para v @ Classl
los métodos que v et
v |= Calculate

tienen el mismo (] (value As Integen)

nombre, pero que

-= value’

tienen signaturas

de método diferentes (como pueda ser diferente cantidad de
parametros, diferentes tipos de datos para los parametros o bien
pertenecer a una subclase).

Nota: No puedes sobrecargar métodos basandote solo en el tipo del valor
devuelto.

Para sobrecargar un método en tus propias clases, afiade
simplemente el método a la clase y utiliza parametros diferentes.
El método aparece en el Navegador con los parametros
sobrecargados mostrados bajo el método de modo que puedas
diferenciarlos.

Para sobrecargar métodos en las clases incluidas con el
framework, necesitaras crear primero una subclase usando
herencia.

También puedes sobrecargar los operadores usando una
variedad de funciones especialmente implementadas. Un buen
ejemplo de un operador sobrecargado incluido de serie es el
operador “+”. Si sus argumentos son numeros, se calcula la
suma; si los argumentos son cadenas, entonces las concatena.
La seccion Caracteristicas Avanzadas de Clase en este capitulo
tiene un ejemplo de ello.

Herencia (Subclases)
La herencia es una caracteristica de la programacion orientada a

objetos mediante la que creas una nueva clase que esta basada
en una clase existente. La nueva clase se denomina subclase y la
clase existente se denomina super clase.

¢, Por qué es Util? Puedes encontrar situaciones en las que
quisieras tener un objeto que fuese simplemente una version
modificada de una clase incluida de serie. Por ejemplo, podrias
querer una version del control TextArea que desactivase los items
Cortar y Copiar del menu Edicion, evitando asi que el usuario
pueda llevar al Portapapeles datos de caracter sensible. Podrias
querer crear un ListBox que, por defecto, incluya los meses del
afno en él. Puedes crear tus propias versiones de estas clases
incluidas de serie simplemente anadiendo subclases a tu
proyecto.

Existe una diferencia importante entre anadir una instancia de
TextField a una ventana frente anadir una subclase basada en
TextField al proyecto. En el segundo caso, puedes personalizar la
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clase basada en el TextField y usar instancias de la subclase

personalizada en varios lugares de la aplicacion. También puedes

guardar la subclase personalizada de modo que puedas
reutilizarla en otros proyectos.

. Qué es una Subclase?

Una subclase es simplemente una clase que tiene una clase
super. Una clase “super” es una clase en la que se basa una
subclase, denominada también en ocasiones como clase padre.
Las subclases heredan todas las propiedades, métodos,
constantes y eventos de la superclase. Entonces la subclase
puede modificarlas. De hecho, una subclase es idéntica a su
superclase hasta que empiezas a modificarla. Después es
diferente de su sUperclase solo en aquellas caracteristicas que
hayas diferenciado, ya sea afnadiendo propiedades, modificando
eventos y anadiendo o

modificando métodos. Figura 5.4. Dialogo para elegir

superclase.
Crear una SUbCIase Select Super Q Search Classes
deSde una Clase GamelnputManager
existente Gaoties
InternetHeaders >
. Introspection.Attributelnfo
Hay VaFIOS mOdOS de Introszection.Memberlnfo
Introspection.Parameterinfo
crear una subclase o
KeyChain
desde una clase ey

existente en el proyecto

|  Cancel | Select

0 existente en el

1.

3.

Si quieres crear una subclase a partir de una clase de control
incluida de serie, solo has de arrastrar el control desde la
Biblioteca hasta el Navegador.

Puedes ) .,
Figura 5.5 Dialogo de Extraer

seleccionar una Superclase

C|aSG en el Extract Superclass

This refactoring makes a new superclass for this class, and
optionally allows you to move some or all of the methods and
properties of this class into that superclass.

Navegador y usar
la opcidn “New

Superclass Name: | GeneralAnimal J

Subclass” del

Move the checked items into the superclass:

menu contextual

Methods Properties
para crear una © Speak
nueva subclase
basada en la clase
seleccionada. | Cancel | [ Ok |

You can add a

class to your project (using the Insert button on the toolbar or
the Insert menu) and then manually change its Super property
to the name of the class that it is based on using the Select
Super Class Dialog.

Crear una Superclase desde una Clase existente

Si tienes una clase existente para la que has llegado a la

conclusion que deberia de ser en realidad una subclase, entonce

puedes crear una superclase a partir de ella. Utiliza el menu

framework.

contextual sobre la clase y selecciona “Extract Superclass”. Esta
accion abre un didlogo (Figura 5.5) que te permite especificar el
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nombre de la superclase y elegir el método y propiedades que
quieras mover de la clase a la sUperclase.

Meétodos Virtuales (Sobreescritura)

Los métodos virtuales proporcionan una via para que una
subclase pueda sobreescribir su propia version de un método
que esta presente en la superclase. Las subclases heredan los
métodos que pertenecen a la clase padre.

Cuando una subclase tiene un método que tiene el mismo
nombre (y parametros) como el método de su superclase, se
invoca el método de la subclase en vez de el método de la
superclase. Esto se denomina como “sobreerscritura”. Aun
puedes llamar al método de la superclase indicandolo
especificamente, utilizando para ello el prefijo Super en la
invocaciéon del método:

Super.MethodName

Polimorfismo
Polimorfismo es la capacidad de que tipos de datos

completamente diferentes (por lo general clases) se comporten
de una forma uniforme. Puedes hacerlo usando la herencia y la
sobreescritura, herencia y eventos o interfaces de clase (descritas
posteriormente en este capitulo).

Un ejemplo comun de esto es la relacion Animal entre Gato y
Perro. Si quieres tener un objeto genérico animal que sepa como
ladrar o maullar en funcién de que contenga un Gato o un Perro,
podrias implementarlo utilizando la herencia y la sobrecarga.

En primer lugar, crea una nueva clase llamada Animal. Ahade un
método que se llame Speak y que devuelva un String.

Ahora crea una subclase de Animal, denominada Gato. Aiadele
el método Speak que devuelva una String. Esto significa que
puedes sobreescribir el método Speak no implementado en
Animal. El cddigo para este método es:

Return "Meow!"

A continuacidn, crea una subclase de Animal, llamada Perro.
Anadele un método Speak que devuelva una String y cuyo
cddigo sea este:

Return "Woof!"

Para probarlo, crea un botdn en una ventana. En el evento Action
del boton afade cddigo para crear un array de Animales:
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Dim animals() As Animal
animals.Append(New Gato)
animals.Append(New Perro)

For Each a As Animal In animals
MsgBox (a.Speak)
Next

Cuando ejecutes este cddigo veras “Meow!” y luego “Woof!”.

Dado que tanto Gato como Perro son ambos subclases de
Animal, pueden ser asignados a la variable (el array Animals) de
tipo Animal.

Y cuando llamas al método Speak de Animal (en el bucle),
gracias al polimorfismo tu codigo llama al método Speak del tipo
de subclase adecuado de los anadidos al array.

En posteriores secciones veremos como puedes realizar esto
mismo usando herencia con eventos y con interfaces de clase.
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Seccion 3

Propiedades, Métodos y Eventos

Propiedades
Las propiedades son rasgos que te indican algo acerca de un

objeto.

Los utilizas como una via para que las instancias de clase
almacenen valores. Puedes anadir cuatro tipos de propiedades a
tus clases: propiedades, propiedades calculadas (Computed
Properties), propiedades compartidas (Shared Properties) y
propiedades calculadas compartidas (Shared Computed
Properties).

Puedes anadir propiedades a una clase para almacenar valores

que no almacene la sUperclase. Por ejemplo, puede que quieras
crear una subclase del control TextField que almacene el ultimo

valor introducido. Esto te permitiria descartar de forma selectiva
la entrada actual y reponer la inmediatamente anterior.

Propiedades

Las propiedades (Propiedades de Instancia) se han descrito en la
Seccién 1. Estas son las propiedades que pertenecen a una
instancia de clase.

Propiedades Calculadas
Figura 5.6
Propiedad calculada.

¥ + Product

v @ Properties
v @ TotalPrice
(=) Get
(=) Set

Una propiedad calculada es una
propiedad que no almacena su
valor sino que se calcula cada vez
que se accede a ella.

Una propiedad calculada tiene dos
partes: un getter y un setter. Esto
muestra en el Navegador el node
Get y Set bajo el nombre de la propiedad. Ahades cddigo al
nodo Get para obtener el valor de la propiedad. Ahades codigo
al nodo Set para definir el valor que ha de tener la propiedad. Si
no incluyes codigo en el nodo Set, entonces la propiedad pasa a
ser una propiedad de solo lectura.

También puedes dejar sin cédigo el nodo Get, haciendo asi que
la propiedad sea de sélo escritura, aunque muy raramente es de
utilidad algo asi.

Un ejemplo de una propiedad calculada podria ser una
propiedad TotalPrice en una clase Product. Puedes implementar
TotalPrice con este cédigo en su Get:
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Return Price * Quantity

Si tu propiedad calculada necesita retener un valor, generalmente

deberas crear una propiedad privada para ello (con el prefijo “m”):

Get:
Return mName

Set:
mName = Value

Propiedades Compartidas

Como se ha indicado en la Seccién 1, las Propiedades
Compartidas (también denominadas propiedades de clase), son
propiedades que pertenecen a la clase en vez de a la instancia.

Propiedades Calculadas Compartidas

Las Propiedades Calculadas Compartidas funcionan
exactamente como esperas. Son versiones compartidas de
propiedades calculadas.

Métodos

Los métodos proporcionan funcionalidad a las clases.
Generalmente realizan alguna accion, como cargar datos o
calcular valores.

El Capitulo 3, Seccion 8 trata los métodos en mayor detalle.

Meétodos

Los métodos (Métodos de Instancia) se describieron en la
Seccidn 1. Son los correspondientes a una instancia de la clase.

Meétodos compartidos

Como se tratd en la Seccién 1, Los Métodos Compartidos
(también denominados métodos de clase) son los métodos que
pertenecen a la clase en vez de a la instancia.

Eventos
Los eventos son un tipo de método llamado por alguna accién (o

evento) que ha tenido lugar. Dichos eventos no tienen nada que
ver con los “eventos” en “programacion orientada a eventos”.

Son varias las clases y controles que presentan sus propios
eventos de serie (tratados en los libros Interfaz del Usuario y
Frameworks), pero también puedes crear tus propios eventos
utilizando Definiciones de Eventos.

Las Definiciones de Eventos te proporcionan una via para afadir
tus propios Manejadores de Eventos a tus clases. Las
Definiciones de Eventos pueden llamarse solo desde la clase
propiamente dicha, pero pueden ser implementados sélo por sus
subclases.

Para anadir una definicion a una clase, usa el botén Add en la

barra de herramientas del Editor de Codigo, o Insert » Event
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Figura 5.7. Definiciones  pgfinition desde el ment o el mend

de Eventos.
contextual.
v ° Product
¥ K Event Definitions Por ejemplo, si tienes un método
“hs PostSave
5 4 Save en una clase, probablemente
ks PreSave . ] i
v ol b quieras proporcionar una via a las
= = [ESae subclases para que realicen algun

proceso antes y después de realizar
el guardado. Una forma en la que puedes hacerlo es

sobreescribiendo el método Save en la subclase, por ejemplo asi:

Sub Save
PreSave
Super.Save

PostSave
End Sub

Esto funciona aunque se basa en que definas e implementes
todo correctamente. Si haces esto

Figura 5.8. Subclase, con eventos, no hay lugar a errores.

mostr_ando Podrias crear dos definiciones de
Manejadores de , _

evento en la superclase: PreSave y
Eventos.

" PostSave. En el método Save de la
° AutoProduct

v “h Event Handlers superclase llamas entonces a

PreSave en el inicio y a PostSave al
‘h PreSave final.

‘h PostSave

Cuando crees una subclase veras que tiene dos Manejadores de
Evento que puedes afadir: PreSave y PostSave. Simplemente
has de afnadir dichos manejadores de evento e implementarlos
CcOomo necesites.

Todas las clases de controles incluidas de serie incluyen una
amplia variedad de manejadores de eventos (como por ejemplo
Open), todos los cuales funcionan de esta forma.

Observa que cuando implementas un manejador de evento este
ya no aparece en sus subclases. Si quieres que el manejador de
evento siga estando disponible para las subclases, necesitas
crear una nueva definicion de evento en la clase replicando el
nombre y parametros y llamarlo desde la definicidon de evento
que hayas implementado.

Ejemplo Animal

Volvamos al ejemplo Animal, asi es como lo harias usando
eventos.

Crea una nueva clase llamada Animal. Aiadele un método Speak
que devuelva un String con este cddigo:

Return SpeakSound

Ahora anade a la clase Animal una Definicidon de Evento llamada
SpeakSound y define su valor devuelto como String.
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A continuacidn, crea una subclase de Animal, llamada Gato. Haz
clic en el botdn “+” de la barra de herramientas y selecciona “Add
Event Handler”. En el dialogo veras el manejador de evento
SpeakSound. Seleccidnalo y pulsa OK.

El cddigo para dicho evento es:

Return "Meow!"

Ahora crea una subclase de Animal, llamada Perro y afiade
también el manejador de evento SpeakSound con este cédigo:

Return "Woof!"

Para probarlo, crea un botdn en una ventana. En el evento Action
del botén anade cdédigo para crear un array de Animales:

Dim animales() As Animal
animales.Append(New Gato)
animales.Append(New Perro)

For Each a As Animal In animales
MsgBox (a.Speak)
Next

Cuando ejecutes este codigo veras un “Meow!” seguido por un
“Woof!”.

Dado que Gato y Perro son subclases de Animal, pueden ser
asignados a una variable (el array animales) de tipo Animal.

Cuando invocas el método Speak de Animal (en el bucle), se
llama al manejador de evento SpeakSound de cada una de las
subclases en el orden en el que se hayan afnadido al array.
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Seccion 4

Constructores y Destructores

Cuando creas un nuevo objeto es probable que quieras hacer
algun tipo de inicializacion sobre el objeto. El constructor es un
mecanismo que permite realizar justo esto. El constructor de un
objeto es el método que se ejecuta automaticamente cuando se
crea una instancia de una clase.

De igual modo, cuando un objeto se elimina de la memoria se
llama a su método destructor.

Constructores
Afnades un constructor a una clase afnadiendo un método a la

clase y que se llama “Constructor”. Para facilitarlo, el
“Constructor” es una de las opciones que encontraras en el
menu de métodos del Editor de Cddigo.

El constructor se llamara automaticamente cuando se crea una
instancia mediante el operador New. Si el constructor acepta
parametros, has de pasar la cantidad de parametros requerida y
han de ser del tipo de dato correcto.

Cuando creas un constructor para una subclase, el Editor de
Cddigo anade automaticamente una llamada al constructor de la

superclase en el Editor de Codigo y ahade comentarios que
explican la funcion.

// Calling the overridden superclass constructor.
Super.Constructor

Esto se aflade porque el constructor que estas afiadiendo
sobreescribe el constructor de la superclase, pero el nuevo
objeto puede que no se inicialice correctamente excepto que se
ejecute el constructor de la sUperclase. El método Super es
como se invoca a un método de la clase superior o padre y que
ha sido sobreescrito por la subclase.

Veamos un ejemplo sencillo de un constructor. Supongamos que
estas gestionando un servicio que vende suscripciones
mensuales. Quieres una version personalizada de la clase Date
que obtenga automaticamente el valor de la fecha de renovacion
cada vez que se cree una instancia. En primer lugar, anade una
nueva clase al proyecto y define su clase Super a Date y cambia
su nombre a “ExpirationDate”. Ahora puedes anadir un método
llamado “Constructor”. El constructor deberia recibir un
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parametro entero, numMonths, con la cantidad de meses por las
que se ha suscrito el cliente. De modo que el constructor tiene
soOlo una linea de cddigo:

Self.Month = Self.Month + numMonths

Cuando se crea una instancia de un objeto Date “normal”, se
inicializa con la fecha actual, de modo que esta linea incrementa
el nUmero del mes en curso con la cantidad de meses que se ha
pasado en el parametro.

Cuando necesitas obtener la fecha de caducidad para un cliente
que se ha suscrito por 6 meses, puedes obtenerla de este modo:

Dim expDate As New ExpirationDate(6)
MsgBox (expDate.ShortDate)

Se pasa la cantidad de meses como parametro y la nueva
instancia contiene la fecha de expiracion en vez de la fecha en
Curso.

Inicializando Subclases de Controles

Si necesitas inicializar la instancia de una subclase de un control,
no utilices el constructor. En vez de ello, incluye el cédigo en el
manejador de evento Open correspondiente al control.

Cuando accedes a las propiedades del Inspector en el
Constructor éstas aun no tienen el valor por defecto especificado
en el Inspector, y de hecho contendran el valor por defecto del
tipo de dato. Si asignas valores a dichas propiedades publicas
estas quedaran sobreescritas con lo que se haya indicado en el
Inspector.

Destructores
También puedes crear un destructor, aunque por lo general no

suele ser necesario. El destructor es llamado cuando una
instancia de la clase padre se borra o queda fuera de ambito; por
ejemplo cuando el usuario cierra la ventana. Utiliza “Destructor”
como nombre del nuevo método. Los destructores no admiten
parametros y no devuelven ningun valor.

Se invoca a los destructores cuando se elimina la ultima
referencia a un objeto, incluso si la ejecucion esta en el destructor
de otro objeto. Esto significa que puedes causar un
desbordamiento de la pila si tu destructor desencadena la
llamada de otros destructores en una recursividad profunda. Pero
no ocurrira esto si las propiedades de los objetos se limpian
automaticamente. Por tanto, por lo general es preferible no definir
las propiedades a Nil en el destructor, y dejar que estas se
limpien automaticamente sin tu intervencion.

Gestion de Memoria
La memoria se gestiona automaticamente utilizando un

mecanismo denominado contador de referencias. Se utiliza un
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contador para cada instancia (objeto) creado, y este se encarga
de registrar las referencias al objeto. Cada referencia incrementa
el contador, y al eliminar una referencia se decrementa el
contador en consecuencia. Por ejemplo, eliminas una referencia
definiéndola a Nil o dejando que salga de ambito, como al cerrar
una ventana en la que esté ubicada la instancia. Cuando el
contador de referencias llega a cero, el objeto se elimina de
inmediato de la memoria.

Esto significa que las instancias de las clases se eliminan de
memoria automaticamente cuando ya no se utilizan mas.
Supongamos que creas una clase basada en un ListBox. A
continuacion creas una instancia de esa clase en una ventana.
Cuando se abre la ventana se crea la instancia de la clase
automaticamente en memoria. Cuando se cierra la ventana, se
elimina automaticamente de memoria la instancia de la clase. Si
almacenas la referencia a la clase en una variable, cuando el
método o manejador de evento finalice su ejecucion, se eliminara
la instancia de clase de la memoria. Si guardas la referencia de
una instancia de clase en una propiedad, la instancia se eliminara
de memoria cuando el objeto propietario de la propiedad se
elimine de memoria.
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Seccion 5

Interfaces

Una interfaz de clase es la construccion que usas para unir
aquellas clases que no compartan una superclase pero que si
tengan algo en comun en tu aplicacion. Las interfaces de clase
se utilizan para especificar qué hace un objeto sin especificar
cdémo lo hace.

Para comprender mejor las interfaces de clase resulta de ayuda
pensar en una clase como si estuviese formada por dos
componentes, la interfaz (publica) de la clase y la
implementacion. La interfaz consiste en las llamadas Publicas a
los métodos, mientras que la implementacion es el cédigo que
implementa dichos métodos. La interfaz indica lo que hace la
clase, y la implementacién dice como lo hace.

En la jerarquia de objetos, una subclase hereda tanto la interfaz
como la implementacion de su sUperclase. Es decir, recibe tanto
las llamadas de los métodos como la implementacion concreta
de dichos métodos.

Las interfaces de clase te permiten separar las dos
construcciones. Si dos o mas clases necesitan hacer lo mismo

pero de maneras distintas, entonces utilizas una interfaz en vez
de una superclase.

Una interfaz de clase funciona como una “especificacion” que
contiene una lista de métodos utilizadas por tus clases
personalizadas en el proyecto. No contiene de hecho ningun tipo
de codigo para los métodos en si mismas.

En las interfaces de clase los métodos son meros marcadores
para los métodos que se incluyen en realidad en cada una de las
clases personalizadas que “implementan” la interface de clase.
De igual modo, una clase personalizada puede implementar mas
de una interface de clase.

El término “Implementa” simplemente significa que la clase tiene
métodos con los mismos nombres y declaraciones encontrados
en la interfaz de clase. La interfaz de clase especifica los
métodos y sus declaraciones pero no el cédigo.

El framework incluye por defecto varias interfaces de clase.
Puedes implementar cualquiera de ellas en tus propias clases.
Por ejemplo, las interfaces Readable y Writeable especifican
meétodos para leer y escribir datos. Cada clase que utilice las
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interfaces Readable o Writeable proporciona las
implementaciones. Por ejemplo, una clase que lea datos del
puerto Serie podria utilizar una implementacion diferente que una
clase que lee desde un archivo binario.

Cuando indicas que una clase implementa una interfaz de clase,
la clase debe de implementar todos los métodos en la interfaz de
clase, y las declaraciones de dichos métodos han de coincidir
con los indicados por la interface de clase. Sin embargo, las
clases son libres de implementar los métodos de diferentes
formas. Por ejemplo, un método que cambia la fuente en una
Label podria implementarlo de forma distinta al método que
cambia la fuente en un control Canvas, y que muestra el texto
mediante llamadas a la clase Graphics.

El proceso comprende tres fases basicas:
- Crear la interface de clase,
- Crear las clases que implementan la interfaz de clase,

- Anadir las clases a tu proyecto y llamar a los métodos de la
interface de clase en tu programa. Por lo general, eso significa
escribir cddigo genérico que compruebe si una clase
implementa una interface y ejecutar los métodos de la interface
de clase en caso adecuado.

Para afadir una nueva interface de clase, haz clic en el boton
Insert de la barra de herramientas y selecciona Class Interface, o

bien puedes seleccionar Class Interface en el menu Insert. Esto
anade una nueva interface de clase al Navegador con el nombre
por defecto (Interface1 para la primera interface de clase).

Usa el Inspector para cambiar el nombre de la interface de clase.

Solo puedes anadir métodos a la interface de clase. Para afadir
un método a una interface de clase, usa el botdn Add en la barra
de herramientas del
Editor de Cddigo, la

opcion Insert »

Figura 5.9. Boton para elegir una
iinterface en el Inspector.

ID
Method del menu, el
menu contextual o Name  Test
bien el atajo de Super | [«
teclado (Opcion-

Scope -

Comando-M en OS

Interfaces | Choose...

X o Ctrl+Shift+M en
Windows y Linux).

No puedes especificar cddigo alguno en una interface de clase,
de modo que el Editor de Codigo estara desactivado. Utiliza el
Inspector para indicar los nombres de los métodos y sus
parametros.

Implementar los Métodos de Interface en

una Clase
Para implementar los métodos de las interfaces de clase has de

asignar la interface de clase a una clase. Para ello, selecciona la
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clase en el Navegadory, en el Figura 5.10. Didlogo para

Inspector, pulsa sobre el elegir Interfaces.

This refactoring adds an interface to the set of interfaces Dog represents,
then adds the methods declared by that interface to the class.

botdén Choose asociado a la

etiqueta Interfaces. También

actionNotificationReceiver
actionSource

DataCell
dataNotificationReceiver
dataNotifier

DataSource

puedes usar la opcidn

listSelectionNotificationReceiver
listSelectionNotifier
Petinterface

“Implement Interface” en el

!

menu contextual del método

_|Include "#pragma error" in the source of each method

en el Navegador.

[ cancel | [ OK ]

Cuando haces clic sobre

Choose, accedes al didlogo Choose Interfaces en el que se
muestran los nombres de todas las interfaces de clase
disponibles. Algunas de las interfaces se corresponden con las
incluidas de serie, y otras seran las creadas por ti. Selecciona una
o mas interfaces para asignarlas a la clase.

También puedes seleccionar la opcidn ‘Include “#pragma error” in
the source of each method’ para forzar la generacion de un error
del compilador con el mensaje “Don't forget to implement this
method!". Elimina el pragma una vez hayas afadido el cddigo
para implementar el método de la interface.

Figura 5.11. Error de Compilacion debido a la ausencia de un
método de Interface.

A Errors Type

Location J

Issue

> @ This class is missing one or more methods of an interface it implements

Pulsa OK para que el Editor de Codigo afiada automaticamente
los métodos de la interface a tu clase con un comentario que te
indique la interface con la que se corresponden (junto con el
pragma opcional).

Si modificas o cambias la interface de clase una vez que ya la
hayas aplicado a la clase, tendras que actualizar manualmente la
clase.

Si intentas compilar un proyecto que contiene una clase con una
interface, pero la clase no implementa todos los métodos de la

interface, obtienes el error de compilacion: “This class is missing
one or more methods of an interface it implements.” (“Esta clase
no incluye uno o mas métodos de la interface que implementa.”)

Modificar y Borrar Interfaces

Si cambias de opinion y quieres borrar o sustituir una interface,
puedes hacerlo del mismo modo en el que has anadido la
interface. Cuando aparezca el dialogo de Interface, desactiva la
casilla de verificacion correspondiente a la interface que ya no
quieras.

Nota: Cuando eliminas una interfaz no se modificaran o eliminaran
cualquiera de los métodos arfiadidos a la clase y que se correspondian a
dicha interface. Es decir, si afiades una interface mediante el dialogo
Implement Interfaces, los métodos especificados por dicha interface se
mantienen como parte de la clase incluso si borras la interface en cuestion.
Debes encargarte de todas las actividades de “limpieza”.
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Indicar Ila Interface a Implementar

En algunos casos raros puedes encontrar que una clase
implementa mas de un método con el mismo nombre pero
pertenecientes a diferentes interfaces de clase. Puede que hayas
decidido que una clase implementa dos interfaces que tengan un
método que comparte el mismo nombre y declaracion. Por lo
general no hay forma de diferenciarlos. Sin embargo existe un
modo de indicar la interface de clase a la que corresponde cada
uno. Puedes hacerlo utilizando el campo opcional Interfaces en el
cuadro de dialogo de la declaraciéon de método, disponible
usando el menu contextual “Show Implements” del método.

Para usarlo, supongamos que tienes dos interfaces de clase, Foo
y Bar, y que ambas contienen un método llamado “wahoo” que
no tiene parametros. Puedes tener una clase llamada (Baz) que
implemente ambos métodos de forma independiente.

Anade el método wahoo a Baz. A continuacién haz clic derecho
(control+clic en OS X) sobre el nombre del método y selecciona
“Show Implements”. Esto muestra un campo adicional en el
Inspector, denominado “Implements”. Aqui puedes indicar el
nombre de la interface y método que implementa en realidad
dicho método: Foo.wahoo.

Ahora afnade otro método llamado wahoo y selecciona “Show
Implements” para él. Especifica “Bar.wahoo”. Ahora habras
indicado a la clase exactamente qué métodos de interface
implementa.

Crear una nueva Interface de Clase a partir

de una Clase ya existente
Si una clase ya existente de tu proyecto contiene métodos que

quieras extraer como interface de clase, puedes generar la
interface de clase en el Navegador. Para ello, selecciona “Extract
Interface” en el menu contextual del método en el Navegador.

La nueva interface de clase se anade al proyecto y la clase actual
pasa a ser un implementador de la nueva interface.

Polimorfismo
El polimorfismo es la capacidad de tener tipos de datos

completamente distintos (por lo general, clases) que se
comportan de una forma uniforme. Esto puede realizarse
mediante interfaces de clase.

He aqui como implementar el ejemplo Animal, Perro y Gato
utilizando interfaces de clase.

En primer lugar, crea una nueva interface de clase (llamada
Animal). Ahadele un método Speak que devuelva una String.

Ahora crea una nueva clase (Gato) y selecciona Animal como su
interface. El Editor de Cdodigo afiadira automaticamente el
método Speak por ti. Ahade este cddigo en el método:

Return "Meow!"
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A continuacién, ahade una nueva clase (Perro) y selecciona
Animal como su interface. El Editor de Codigo afade el método
Speak en el que puedes incluir este cddigo:

Return "Woof!"

Para probarlo, crea un boton en una ventana. Afhade el siguiente
cddigo en el evento Action del boton para crear un array de
Animales:

Dim animales() As Animal
animales.Append(New Gato)
animales.Append(New Perro)

For Each a As Animal In animales
MsgBox (a.Speak)
Next

Cuando ejecutes este codigo veras un “Meow!” seguido por un
“Woof!”.

Dado que tanto Gato como Perro implementan Animal, estos
pueden ser asignados a una variable (el array animales) de tipo
Animal.

Y cuando invocas el método Speak de Animal (en el bucle), tu
codigo llamara el método Speak del tipo real afadido al array
gracias al polimorfismo.
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Seccion 6

Subclases de Ejemplo

Ejemplo: SelectablePopupMenu

Como ejemplo, puedes crear una subclase PopupMenu en la
que se afiade un método que puede utilizarse para seleccionar
cualquier elemento del PopupMenu.

Crea una nueva clase, llamada SelectablePopupMenu, y define
su Super a PopupMenu. En esta clase, afiade un nuevo método
publico con el nombre “SelectRow” y con el parametro “value As
String”.

Este método iterara por las filas del PopupMenu y vera si el texto
de la fila coincide con el valor proporcionado. Si se corresponde,
seleccionara la fila y retornara. Si no se produce una
coincidencia, entonces no se seleccionara nada.

Figura 5.12. Método SelectRow en la clase

SelectablePopupMenu.

untitled < > | SelectRow(value As String) DT

CONTENTS; " For i As Integer = © To Self.ListCount-1 :

> @ Aop = If Self.List(i) = value Then | /e As String
[ windowl // Found a row with matching text, so select it

> B MainMenuBar — Self.ListIndex = i...

v LB SelectablePopupMenu L Return
¥ = Methods End If

-

BUILD SETTINGS RewnType |
(o Shared = Self.ListIndex = -1 // Select nothing Scope
0O osx

Este es el cddigo para el método SelectRow:

For i As Integer = 0 To Self.ListCount-1
If Self.List(i) = value Then
// Encontrada una fila con correspon-
dencia
//de modo que la seleccionamos
Self.ListIndex = 1
Return
End If
Next

// No se selecciona nada

Ejemplo: MonthPopup

Veamos otro ejemplo. Supongamos que quieres crear un
PopupMenu que, por defecto, muestra los nombres de los
meses del afio con el mes actual seleccionado. Crea una nueva
clase, y ndbmbrala MonthPopup, seleccionando PopupMenu
como su superclase.
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Ahora puedes afadir un manejador de evento Open a
MonthPopup y afadir los nombres de los meses, la cabeceray el
codigo que selecciona el mes apropiado del listado. En este
caso, el manejador de evento Open es:

Self.HasHeading = True
Self.InitialValue = "Meses"
Self.AddRow("Enero")
Self.AddRow("Febrero")
Self.AddRow("Marzo")
Self.AddRow("Abril")
Self.AddRow("Mayo")
Self.AddRow("Junio")
Self.AddRow("Julio")
Self.AddRow("Agosto")
Self.AddRow("Septiembre")
Self.AddRow("Octubre")
Self.AddRow("Noviembre")
Self.AddRow("Diciembre")

// Selecciona el mes actual
Dim d As New Date
Self.ListIndex = d.Month-1)

Para anadir una instancia de la clase MonthPopup a una ventana,
cambia el Editor de Plantilla de la ventana y arrastra el
MonthPopup desde el Navigator hasta el Editor de Plantilla.
Cuando ejecutes la aplicacidn, se ejecutara el manejador de
evento Open y se poblara el PopupMenu con los meses del afo,

teniendo el mes en curso seleccionado.

Nota: Una vez creada, las clases de controles personalizados pueden
exportarse como objetos autocontenidos que pueden utilizarse en otros
proyectos. Sdlo has de hacer clic derecho (Control-clic en OS X) sobre la
clase de control personalizada en el Navegador y elegir Export... en el menu
contextual.

Las Subclases son Clases
Recuerda, las subclases son clases. Estas se llaman subclases

para diferenciarse de la clase original y enfatizar el punto de que
heredan las propiedades, eventos y métodos de su clase padre.
Dado que las subclases son clases, pueden ser a su vez la clase
padre de otras subclases. Por ejemplo, supongamos que tienes
una subclase NumbersOnlyTextField, y ahora necesitas un
TextField que permita Unicamente los nUmeros comprendidos en
un rango determinado. Podrias duplicar la subclase
NumbersOnlyTextField y modificar su codigo. Sin embargo esto
haria que el proyecto fuese mas grande y dificil de mantener. Si
encontrases un bug en el cdédigo de NumbersOnlyTextField,
tendrias que recordar si habias utilizado dicho cddigo también en
otros lugares, comprobarlo y corregirlo. Un modo mas eficiente
consiste en crear una nueva subclase y seleccionar
NumbersOnlyTextField como su superclase. La nueva subclase
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(Ilamémosla “NumberRangeTextField”) utilizaria todas las
propiedades, eventos y métodos de su clase padre. Sin embargo,
podrias anadir codigo en el manejador de evento TextChange que
permitiese solo los numeros dentro del rango deseado.
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Seccion 7

Caracteristicas Avanzadas de Clase

Esta seccion cubre las caracteristicas mas avanzadas de las La declaracioén se veria asi:
clases. No necesitaras estas caracteristicas muy a menudo, pero

son decididamente utiles. ) )
Sub Quantity(Assigns amount As

Asignar un valor a un Método Integer)

A veces es Util, desde el punto de vista de la sintaxis, tener un

método que obtenga un valor mediante el operador de B ) )

asignacién También puedes tener mas de un parametro, algo que no puedes
hacer con una simple propiedad:

En vez de hacer esto:

Sub Quantity(productName As String,
order.Quantity(2) Assigns amount As Integer)

Podrias escribir: Este comando se utilizaria asi:

order.Quantity = 2 order.Quantity("Book") = 2
y que parece mas como una propiedad. Puedes obtener el Cuando utilizas esta técnica, parecera que estuvieses definiendo
comportamiento de sintaxis de una propiedad en un metodo una propiedad, incluso aungue estés tratando con un método.

usando la palabra clave Assigns en la lista de parametros.
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Esto puede ser practico cuando se disefian clases y puede
facilitar la lectura del codigo.

Sobrecarga de Operadores

Puedes sobrecargar los métodos de una clase, pero como
sobrecargas un operador en una clase? Por ejemplo, ;qué pasa
si tienes dos instancias de la clase SalesOrder y quieres saber si
una es mayor que otra? Puedes hacerlo implementando uno de
los métodos Operadores sobrecargados (Figura 5.13) en la clase
SalesOrder, en este caso Operator_Compare.

Sub Operator_Compare(rightOrder As SalesOrder)
If Self.TotalAmount > rightOrder.TotalAmount Then
Return 1
Elself Self.TotalAmount < rightOrder.TotalAmount Then
Return -1
Else
Return 0
End If
End Sub

Para obtener mas informacion sobre la sobrecarga de operadores

en las clases personalizadas, consulta la seccion de cada palabra

clave Operator_ en la Referencia del Lenguaje.

Operador de Busqueda

Se utiliza la notacién por punto para acceder a los métodos y
propiedades de una instancia de clase. Si intentas acceder a un

Figura 5.13. Métodos de Operadores

Sobrecargados.
Operador Funciones
N Operator_Add
Operator_AddRight
i Operator_Subtract
Operator_SubtractRight
. Operator_Multiply
Operator_MultiplyRight
/ Operator_Divide
Operator_DivideRight
\ Operator_IntegerDivide
Operator_IntegerDivideRight
Mod Operator_Modulo
Operator_ModuloRight
Operator_And
And Operator_AndRight
Or Operator_Or
Operator_OrRight
Not Operator_Not
= <, >, <=, >= Operator_Compare
(lookup) Operator_Lookup
(negation) Operator_Negate
(convert) Operator_Convert
Subscript Operator_Subscript
Redim Operator_Redim
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método que no existe obtienes un error de compilacion.

El Operador de Busqueda (Operator Lookup) es un método
especial de clase que se llama cuando se utiliza cualquier
I “-”

elemento tras e que no sea una propiedad o método

definidos en la clase.

Un uso de esta caracteristica consiste en buscar un valor que
puede no ser conocido hasta que se encuentre en tiempo de
ejecuciéon. Supongamos que estas creando una clase de
Preferencias que se utilizara para guardar las preferencias de tu
aplicacién. Normalmente tendrias que crear una propiedad para
cada preferencia que quieras guardar. Si encuentras que tienes
un nuevo valor de preferencia, tendras que volver a la clase y
anadir la propiedad antes de que puedas usarla.

Pero puedes utilizar el operador de busqueda como alternativa.

Con el operador de busqueda deberias utilizar el método para
comprobar qué se ha escrito tras el “.” y tratarlo como el nombre
de la preferencia. El valor asignado puede almacenarse entonces

(quiza utilizando un Dictionary).

Tu cddigo para guardar un valor puede ser como el siguiente:

Sub Operator_Lookup(name As String, Assigns value As
String)
If mPreferenceDict = Nil Then
mPreferenceDict = New Dictionary
End If
mPreferenceDict.Value(name) = value
End Sub

Y el codigo para obtener el valor puede ser como este:

Function Operator_Lookup(name As String) As String
If mPreferenceDict = Nil Then Return ""

If mPreferenceDict.HasKey(name) Then
Return mPreferenceDict.Value(name)
End If
End Sub

Con esto definido, ahora puedes escribir cddigo para guardar
preferencias incluso aunque nunca hayas definido propiedades o
meétodos especificos para dicha preferencia. En la clase App,
anade una propiedad denominada Prefs as Preferences. En el
vento App.Open, inicializa esta propiedad:

Prefs = New Preferences
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Ahora, en cualquier parte de tu proyecto puedes escribir codigo
como este para almacenar un valor de preferencia:

App.Prefs.UserName = "Bob Roberts"
App.Prefs.UserEmail = "bob@gmail.com"

Y cddigo como este para obtener el valor de una preferencia:

Dim userName As String
userName = App.Prefs.UserName

Atributos

Los atributos son una caracteristica de clase avanzada que te
permiten dar a una clase un valor que pueda comprobarse en
tiempo de ejecucién mediante la introspeccién. Esta
caracteristica se trata en el capitulo Avanzado de la Guia del
Framework.

Casting

Un modo extremadamente potente de crear cddigo genérico y
reutilizable es sacando provecho de la capacidad de convertir
una instancia de una clase en una instancia de su subclase.

La idea se comprende mejor mediante el uso de un ejemplo.
Dado que los objetos creados son subclases de clases base,

siempre puedes probar si un objeto es miembro de una subclase

concreta. Para ello se utiliza el operador IsA.

Con el operador IsA puedes probar si un objeto es de una clase
concreta y, si lo es, proyectarlo como tipo de algo especifico. Se
proyecta un objeto mediante el uso del nombre de la clase como
funcion que opera sobre la instancia.

Cuando proyectas una instancia, la comprobacion de errores en
tiempo de compilacién no garantiza que estés haciendo el
casting a un objeto legal. La instancia que estés proyectando
debe ser del tipo especificado. Esta técnica sélo indica a tu
codigo que trate al objeto como instancia de la clase a la que se
proyecta. No lo convierte de una clase a otra. Si haces un cast
incorrecto, obtendras un lllegalCastException en tiempo de
ejecucion.

Este es un ejemplo que utiliza un bucle For para iterar todos los
controles de una ventana. Comprueba cada control para ver si es
una Label y, en tal caso, hace un cast sobre el control y muestra
Su texto:
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Dim labelText As String
// itera por los controles de la ventana
For i As Integer = 0 To Self.ControlCount-1
If Self.Control(i) IsA Label Then
// Cast del control a Label
// y obtiene su propiedad Text

labelText = Label(control(i)).Text
MsgBox (labelText)
End If
Next

Como puedes ver, el codigo no hace referencia a ventanas,
Labels o cualquier otro elemento concreto. Por tanto, puedes
escribir esta rutina una vez y utilizarla en cualquier ventana del
proyecto.

Variables Estaticas
Una variable estatica (Static) es una variable global que tiene el

ambito de una variable local.

Se declara en un método vy, a diferencia de lo que sucede con
una variable local normal, el valor se retiene la proxima vez que
se invoca el método que la contiene. Este valor se retiene para el
método en todas las instancias de la clase, tanto si ya existen
COMo Si se crean posteriormente.

Puedes declarar una variable estatica usando la palabra clave
Static en vez de Dim:

Static myValue As Integer
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Capitulo 6

Estructura de
la Aplicacion

Tus aplicaciones han de tener una estructura
general que determina como funcionan. Este
capitulo te explica la estructura de las aplicaciones
de escritorio, web, iIOS y de consola.

W,
o

6. Estructura de la Aplicacion

6.1.

6.2.

6.3.

6.4.

6.5.

Aplicaciones de Escritorio
Aplicaciones Web
Aplicaciones de Consola
Aplicaciones iOS

Editor de Icono



Seccion 1

Aplicaciones Desktop

Las aplicaciones Desktop tienen una interfaz grafica de usuario y
se ejecutan directamente en el ordenador del usuario.

La clase Application
La clase Application se utiliza para crear una subclase que

representa a tu aplicacion. Cuando creas un nuevo proyecto
Desktop, se anade

automaticamente al proyecto una  Figura 6.1. Propiedades

clase basada en la clase de Aplicacion.

Application. Esta es la clase App B

en el Navigator. El Inspector Name  App |

indica que su Super es SRl Avviicaton |

Application. Scope | 3
Interfaces

En esta subclase de App es Appearance

donde indicas la ventana que se DefaultWindow ~( Window1 )

MenuBar [ MainMenuBar

a
—/

mostrara por defecto al abrir la
aplicacion, la barra de menus por Icon
defecto utilizada por la aplicacion

y los iconos de la aplicacion.

Si lo deseas puedes incluso crear una subclase de App. Al
hacerlo la nueva subclase obtiene las propiedades para la
ventana por defecto, la barra de menus por defecto y el icono.

Manejadores de Evento

La clase Application para una aplicacion de escritorio tiene estos
manejadores de evento:

- Open: Este es el manejador de evento que se llama cuando se
ejecuta la aplicacidon por primera vez, ya sea ejecutando la
aplicacion directamente (en modo de depuracién) o bien
ejecutando una aplicacion ya desplegada.

« Close: Se llama al evento close cuando el usuario sale de la
aplicacion.

 NewDocument: Este evento se llama cuando se ejecuta la
aplicacion compilada sin proporcionar un documento.

« OpenDocument: Se llama a este evento cuando se hace doble
clic en el escritorio sobre uno de los documentos generados
por la aplicacion causando el arranque de la aplicacién.
También se invoca si sueltas un documento en la aplicacion.
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- EnableMenultems: Se llama a este evento cuando el usuario
hace clic en la barra de menus pero antes de que se muestren
los items de menu propiamente dichos. El manejador de
eventos EnableMenultems se ejecuta después de que se haya
invocado el manejador de evento EnableMenultems de
cualquier clase con instancias en la ventana que esté situada
en primer plano y tras el manejador de evento
EnableMenultems de la ventana. Este es el manejador de
evento que deberia de utilizarse para activar los items de menu
que deban de estar activos independientemente de que esté
abierta una ventana o no (esta capacidad existe en las
aplicaciones de OS X). Ten en cuenta que si un item de menu
ha de estar activo siempre, deberias de utilizar su propiedad
AutoEnable en vez del manejador de evento EnableMenultems.

- HandleAppleEvent: Se ejecuta cuando se recibe un
AppleEvent por parte de la aplicacion.

- Activate: Se esta activando la aplicacion. Esto ocurre cuando la

aplicacion se esta abriendo y cuando pasa a primer plano.

- Deactivate: Se esta desactivando la aplicacion. Esto ocurre
cuando es otra la aplicacion que pasa a primer plano o cuando
se sale de la aplicacion.

- UnhandledException: Llamado cuando ocurre un error en
tiempo de ejecucion y no es recogido por el codigo. Este
evento te da una “ultima oportunidad” de atrapar los errores en

tiempo de ejecucion antes de que provoquen la salida
inesperada de la aplicacion.

Propiedades

- DefaultWindow: Esta es la ventana que se abre
automaticamente cuando se inicia la aplicacion.

- MenuBar: Esta es la barra de menus principal para la
aplicacion. Se utiliza como barra de menus por defecto para las
ventanas recién creadas. Esta propiedad es accesible mediante
la funcidn App (ver proxima seccion).

« lcon: Esto abre el Editor de Iconos y te permite indicar los
diversos tamaios de icono utilizados por la aplicacién.

Ambito de las Propiedades, Métodos y Constantes de Ila
Clase App

Puedes definir el ambito de las propiedades, métodos y
constantes de la subclase App utilizando las mismas reglas que
aplican a cualquier clase (consulta el capitulo 5).

La funcion global App te proporciona una referencia a la clase
App en tu proyecto para que puedas acceder a sus propiedades,
métodos y constantes publicos. Si has creados una subclase de
App, entonces la funcion App se corresponde con una referencia
a la subclase.

Para acceder una propiedad publica desde cualquier parte en tu
proyecto, deberias de escribir algo asi:
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value = App.MyProperty

Ajustes de Compilacion
La seccion Build Settings del Navegador

contiene ajustes especificos para tu aplicacion.
Puedes activar la casilla de verificacion proxima
a cada destino para compilar una aplicacion
para dicha plataforma.

Nota: Las propiedades de esta seccion que son
accesibles mediante la funcion App cuentan con un “*”
tras sus nombres.

Compartidos

El Inspector para los ajustes compartidos
(Shared) contiene estas propiedades:

- Major Version*: La version Mayor de tu
aplicacion. Los numeros de version se suelen
escribir como 1.2.3.4, donde “1” es la version
mayor.

« Minor Version*: La version Menor de tu
aplicacion. Los numeros de versidn se suelen
escribir como 1.2.3.4, donde “2” es la version

- Bug Version*: La version de Bug para tu aplicacion. Los

numeros de version se suelen escribir como 1.2.3.4, donde “3”

es la version de bug.

Figura 6.2. Ajustes

Compartidos de
compilacion.

Version

Major Version
Minor Version
Bug Version

Stage Code

Non Release Version

Auto Increment Version Info

1

0

0

| Development + |

0
() oFF

Short Version '

Long Version '

Package Info '

Build

Use Builds Folder

Include Function Names

Language

Debug

Command Line Arguments

Destination

menor.

N/A | 2]

-Stage Code*: Utilizado para indicar el tipo de
aplicacion que estas compilando (Desarrollo, Alfa,
Beta, Final).

‘Non Release Version*: La version de No Revision
(build) para tu aplicacion. Los niumeros de version
se escriben generalmente como 1.2.3.4, donde “4”
es el nUmero de no revision.

«Auto Increment Version Info: Cuando esta a ON,
se incrementa en uno el ajuste Non Release
Version cada vez que se hace una compilacion
(Build, y no un Run).

-Short Version*: Un texto breve de descripcion
para tu aplicacion. Por lo general contiene solo el
numero de version (como 1.2.3.4) y es mostrado
por algunos sistemas operativos en las ventanas
de Obtener Informacién o Propiedades para la
aplicacion.

- Long Version*: Un texto mas largo de descripcion para tu

aplicacion. Generalmente contiene el nombre de la aplicacion,

copyright, version y otra informacion. Esta es mostrada por
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algunos sistemas operativos en las ventanas Obtener
Informacion y Propiedades de la aplicacion.

Package Info*: Una descripcion de texto para tu aplicacion y
que puede ser mostrada por algunos sistemas operativos en las
ventanas Obtener Informacion y Propiedades de la aplicacion.

Use Builds Folder: Cuando esta a ON, se situa una carpeta
adicional junto con el archivo de proyecto. Cada una de las
plataformas compiladas (OS X, Windows, Linux) también
genera su propia subcarpeta dentro de esta carpeta.

Include Function Names: Cuando esta a ON, se embeben los
nombres reales de las llamadas a las funciones en la aplicacion
compilada. Esto resulta util con propdsitos de depuracion y
para obtener las tramas de la pila.

Language: Te permite indicar Figura 6.3. Ajustes de

el lenguaje a usar para resolver ~ compilacion OS X.

las constantes dinamicas. '

Mac App Name | URLManager |
Command Line Arguments: Framework | Cocoa :
Estos son los argumentos de la Creator Code | |
linea de comandos que se File Types [ Choose...

Build

pasan a la aplicacién cuando la

o [ ]
Bundle Identifier | com.mycompany.urlmanager

ejecutas en modo Depuracion.

Destination: Indica la ruta en la que se ubica la aplicacion junto
con el archivo de proyecto en modo de Depuracion. Si no se

0S X

La seccion OS X especifica los ajustes ~ aceptados.
utilizados cuando se compila la
aplicacion para OS X. e—

« Mac App Name: El nombre de

indica, entonces la aplicacién se situa junto con el archivo de
proyecto.

Figura 6.4. Ventana
de Tipos de Archivo

Select which file types your application will accept as
file drops under Mac OS.

Type Role
() FileTypes1.Rtf Editor v

archivo real para tu aplicacion OS X.
Si no se indica, se afade
automaticamente el sufijo “.app”

durante la compilacién de la (o) —

aplicacion.

File Types: Abre el dialogo de Tipos

de Archivo Aceptados y que permite

indicar los tipos de archivo soportados por tu aplicacion.
Puedes indicar el role para cada uno de los tipos como
Ninguno, Visor, Editor o Shell.

« None: Tu app no puede gestionar el tipo de archivo.

- Viewer: Tu app puede abrir y leer el tipo de archivo, pero no
guardarlo.

- Editor: Tu app puede abrir, editar y escribir el tipo de archivo.
Esto es lo que querras seleccionar, por lo general.
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« Shell: No documentado por Apple. « Product Name: El nombre del producto tal y como se instala

o : . . en el menu Inicio » Todos los Programas. También aparece en
- Bundle Identifier: El identificador de bundle es utilizado por OS

: - L . “Nombre de Producto” en la pestafa Detalles de la aplicacion.
X como descriptor unico para tu aplicacion. Se indica

generalmente como un nombre de dominio inverso, como en - Internal Name: Este es Util cuando tu producto tiene un
com.xojo.myapplication. Este es afiadido a la seccion nombre interno distinto del nombre externo. Este no aparece en
CFBundleldentifier del plist la pestafa Detalles de las propiedades.
de la aplicacion. Figura 6.5. Ventana de
Un identificador de bundle  Ajustes de Compilacion. - MDI: Cuando esta activado ON, las ventanas de la aplicacion
es requerido para las ID estaran contenidas en la ventana MDI “padre”. MDI significa
aplicaciones Cocoa. Windows App Name | My Application.exe Multiple Document Interface (Interfaz de Multiples
Company Name | My Company Documentos). Aunque contintia soportado por Windows, no se
Windows Product Name | suele utilizar.
La seccion Windows indica Internal Name |
los ajustes usados cuando o (TorE - MDI Caption: Si MDI esta a ON, puedes introducir el texto que
se compila la aplicacion para MDI Caption | ' aparecera en la barra de titulo de la ventana MDI.
Windows. Use GOI Plus (MY GFe ) _ .
4 « Use GDI Plus*: Cuando esta a ON, activa el nuevo subsistema
- Windows App Name: El grafico GDI+ que soporta la transparencia.

nombre real del archivo para la aplicacion Windows. Si no se

- - " . . : Linux
indica, se anade automaticamente el sufijo “.exe” al compilar la

app. La seccion Linux especifica los ajustes utilizados cuando se

compila la aplicacién para Linux.
- Company Name: En Windows 7, el “Nombre de Empresa” o
aparece en la seccion Copyright de las propiedades de la « Linux App Name: El nombre real para la aplicacion Linux.

aplicacion en la pestafa Detalles. This Computer

La seccidon This Computer muestra la seccion adecuada (OS X,
Windows o Linux) para la plataforma utilizada en ese momento.
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Por ejemplo, si estas usando Xojo en OS X, entonces This
Computer muestra los ajustes OS X.

Despliegue
Las aplicaciones desktop se desplegan instalandolas en un
ordenador y ejecutandolas en el ordenador.

0S X

Las aplicaciones OS X se denominan “bundles”. Un bundle es
una carpeta especial que actia como una aplicacién. Dado que
puedes incluir archivos de soporte, las aplicaciones OS X se
despliegan generalmente como un unico archivo de bundle que el
usuario arrastra hacia su carpeta Aplicaciones.

También puedes crear instaladores en OS X, si bien no es comun.
Apple incluye la herramienta PackageMaker entre sus
herramientas de desarrollo para crear instaladores.

Las aplicaciones OS X creadas también pueden venderse y
distribuirse a través de la Mac App Store.

Nota: Cuando compilas una aplicacion OS X en Windows, la aplicacion
resultante se crea como archivo tar. Puedes transferir este archivo a OS X
para expandirlo de modo que pueda ser ejecutado.

Windows

Las aplicaciones Windows tienen un minimo de dos partes: el
ejecutable principal y sus librerias (contenidas en la carpeta Libs
correspondiente). Se requiere de ambas partes para ejecutar la
aplicacion. También es posible que exista una carpeta Resources

que contenga archivos de localizacion (o bien otros archivos que
hayas escogido alojar en dicha ubicacion mediante la
Automatizacion de Compilacion).

Nota: La carpeta Resources puede renombrarse a “AppName Resources”,
donde AppName es el nombre de la app. Esto puede ser util en el caso de
que quieras empaquetar varias apps en una unica carpeta.

Por lo general deberias de utilizar un instalador para desplegar
tus aplicaciones Windows. Con un instalador puedes crear atajos
en el menu Inicio o en el Escritorio y copiar los archivos a las
ubicaciones adecuadas. Son varios los productos existentes que
permiten crear instaladores para las aplicaciones Windows. Dos
que funcionan bien con las aplicaciones xojo son InnoSetup y
Advanced Installer.

Para necesidades simples también puedes comprimir como un
zip la aplicacién de Windows junto con la carpeta Lib.

Linux

Las aplicaciones Linux también tienen dos partes: el ejecutable
principal y sus librerias (contenidas en la correspondiente carpeta
Libs). Se requiere de ambas partes para ejecutar la aplicacion.

El modo en el que despliegues una aplicacién Linux varia en
funcion de las distribuciones Linux soportadas. Diferentes
distribuciones tienen formatos de paquetes diferentes.

Para necesidades simples, puedes limitarte a crear un archivo zip
de la aplicacién Linux y la carpeta Lib correspondiente.
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Seccion 2

Aplicaciones Web

Las aplicaciones web tienen una interfaz de usuario grafica que Manejadores de Evento

funciona dentro de un navegador web y una aplicacion servidor La clase WebApplication de una aplicacién web tiene

asociada que funciona sobre (o como) un servidor web. manejadores de evento. Estos son:

« Close: Se invoca el evento close cuando se sale de la

La clase WebApplication

La clase WebApplication se utiliza para crear una subclase que
representa tu aplicacion web. Cuando creas un nuevo proyecto
web, se afnade automaticamente una subclase basada en la
clase WebApplication. Esta es la clase App en el Navegador. El
Inspector indica que su Super es WebApplication.

En esta subclase App es donde indicas las propiedades para la
aplicacién, como la pagina web por defecto que se abre al
iniciarse la aplicacion web, el mensaje de ejecucion utilizado por
defecto por la aplicacion, el mensaje de desconexién por
defecto, la cabecera HTML y el icono.

Si lo deseas, puedes crear incluso una subclase de App. Al
hacerlo, tu nueva subclase obtiene acceso a las propiedades de
la aplicacion.

aplicacion.

- HandleSpecialURL.:

Se ejecuta este evento cuando se accede a la aplicacion web
utilizando el URL espacial, /valor/especial. en el parametro
Request puedes obtener informacidn sobre el URL y devuelve
la informacion. Se puede usar para implementar servicios web
en tus aplicaciones web.

El URL “/api/valor” también esta soportado y resultara en la
llamada a este evento.

Open: Se invoca este manejador de evento cuando la
aplicacion se ejecuta por primera vez.

UnhandledException: Llamado cuando ocurre un error en
tiempo de ejecucion que no ha sido capturado por el cédigo.
Este evento te proporciona una “Ultima oportunidad” para
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atrapar los errores en tiempo de ejecucion antes de que causen
la salida inesperada de la aplicacion.

Propiedades

- DefaultWebPage: Esta es la pagina web que se muestra
automaticamente cuando se inicia la aplicacion.

- LaunchMessage: En la pantalla de carga de la aplicacion
apareceran una barra de progreso, el icono de la aplicacion vy el
mensaje de arranque.

- DisconnectMessage: Este mensaje aparecera cuando el
cliente ha perdido su conexién con el servidor.

- HTMLHeader: Puede utilizarse para afadir codigo HTML
estatico a cada pagina.

« lcon: Esto abre el Editor de Icono y te permite especificar los
varios tamanos de icono utilizados por la aplicacion. Estos
iconos se usan por la pantalla de carga y para el favicon del
navegador.

Ambito de las Propiedades, Métodos y Constantes de la
clase App

Puedes definir el ambito de las propiedades, métodos y
constantes de la subclase App utilizando las mismas reglas que
también son validas para cualquier clase (consulta el capitulo 5).

Necesitas una referencia para la clase App de modo que puedas
acceder a las propiedades, métodos y constantes publicos. La
funcion global App te proporciona dicha referencia a la clase app.
Si has creado una subclase de App, entonces la funcién App te
proporciona una referencia a la subclase.

De modo que para acceder a la propiedad publica desde
cualquier parte del proyecto, podrias escribir un cédigo como
este:

value = App.MyProperty
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Consideraciones en el Diseno de
Aplicaciones Web

Cliente/Servidor

Todas las aplicaciones web usan un disefno cliente/servidor. Esto
significa que una aplicacién web tiene dos partes: la interfaz de
usuario cliente y la aplicacion que funciona sobre el servidor.

El cliente es la parte con la que interactla el usuario. Para una
aplicacion web, esta es la interfaz de usuario que funciona en un
navegador web. Las aplicaciones web soportan las versiones
recientes de los navegadores web modernos como Safari,
Chrome, Firefox e Internet Explorer.

La aplicacién es donde se ejecuta el codigo y funciona
generalmente sobre un servidor. Los componentes cliente y la
aplicacién web pueden residir en el mismo ordenador, pero
suelen ser ordenadores diferentes: el ordenador del usuario para
el navegador web/interfaz de usuario, y el servidor que esta
ejecutando la aplicacion.

Latencia

Cuando estas probando aplicaciones web localmente, tanto el
cliente (navegador web) como el servidor (aplicacion) estan
funcionando en tu ordenador. Esto significa que la comunicacion
entre ellos es rapida. Pero cuando despliegas a un servidor web,
puede experimentarse un mayor retardo dado que el navegador
web ha de comunicarse con la aplicacién en el servidor a través

de Internet. Este retardo se denomina latencia y tiene una gran
cantidad de factores, incluyendo la velocidad de la conexion a
Internet del usuario, la congestidn general de Internet y la
capacidad de respuesta del servidor.

Cuando se disefa la aplicacion es importante tener la latencia en
mente.

Usuarios multiples y Sesiones

Una aplicacion web tiene por lo general multiples usuarios
conectados de forma simultanea. Esto es gestionado mediante
un concepto denominado Sesiones. Session es una subclase de
WebSession y se aflade automaticamente en todos los proyectos
web. Cada usuario que se conecta a tu aplicacion web obtiene su
propia subclase Session a la que puedes acceder usando la
funcion global Session.

Cookies

Las Cookies son una caracteristica del navegador que te permite
guardar informacion especifica de la sesidn. Las aplicaciones
web tienen soporte de serie para las Cookies como métodos de
la clase WebSession.

Session

Eventos

AllowUnsupportedBrowser
Llamado cuando se conecta a la aplicacion web un navegador no
soportado.
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Close
Llamado cuando se esta cerrando la sesion.

HashTagChanged
Llamado cuando se ha cambiado un hashtag.

JavaScriptError
Llamado cuando ocurre un error JavaScript.

Open
Llamado cuando se inicia una sesion.

PrepareSession
Llamado cuando se conecta el navegador por primera vez a la
aplicacién web.

TimedOut
Llamado cuando el navegador ha estado en espera por el tiempo
especificado en la propiedad TimeOut.

UnhandledException
Usado para atrapar las excepciones no gestionadas mediante
otras vias.

Propiedades

ActiveConnectionCount
Devuelve |la cantidad de conexiones activas, como subidas de
archivo, descargas o peticiones.

Browser
Identifica los navegadores que se estan utilizando para esta
sesion. Los tipos son:

- Safari

- Chrome

- Firefox

- Internet Explorer
« Opera

« ChromeOS

- SafariMobile

- Android

- Blackberry

« Unknown

ClientTime

Devuelve una fecha que contiene la hora del usuario. Esta puede
ser distinta a la hora del servidor dado que el usuario puede
conectar a la aplicacidon web desde cualquier parte.

ConfirmMessage
Cuando se cierra una aplicacion web, el navegador mostrara una
advertencia al usuario con este mensaje.
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CurrentPage
Te permite obtener o definir la pagina web actual.

GMTOffset
Devuelve el GMTOffset para la zona horaria en la que se
encuentra el usuario.

HashTag
Te permite obtener o definir un hashtag.

HeaderCount
Devuelve la cantidad de cabeceras HTTP enviadas cuando se ha
creado la sesion.

Identifier
Devuelve una cadena de identificador de sesion Unica.

PageCount
Devuelve la cantidad de paginas abiertas en la sesion.

Platform
Identifica la plataforma usada por el navegador. Los tipos son:

- Macintosh
- Windows
« Linux

« Wii

- Playstation

iPhone

iPod touch

iPad

Blackberry

WebOS

Unknown

RemoteAddress
La direccion IP del cliente.

RenderingEngine
Identifica el motor de renderizado usado por el navegador. Los
tipos son:

« WebKit

- Gecko

- Trident

« Presto

« Unknown

Secure
Obtiene el estado SSL de la pagina web.
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StatusMessage
Este mensaje se muestra en la barra de estado de los
navegadores soportados.

Timeout

La cantidad de segundos que el navegador ha estado en espera
antes de que se haya llamado el evento TimedOut. Definelo a 0
para desactivar el tiempo maximo.

Title
Obtiene o define el titulo en el navegador. Esto sobreescribe el
titulo de pagina web.

URL
Devuelve el URL de la sesion.

Meétodos

Header, HeaderName
Usado para acceder a la informacion de la cabecera HTTP.

PageAtindex, PageWithID, PageWithName
Usado para buscar paginas web en la sesion.

Quit
Finaliza la sesion.

URLParameter, URLParameterCount, URLParameterExists,
URLParameterName

Utilizado para realizar la busqueda de los parametros de URL
(cadenas de consulta).

Métodos Compartidos

Available

Usado para comprobar si esta disponible una sesién. Una sesion
puede estar disponible o no para el codigo que se ejecuta en
WebApplication, por ejemplo.
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Cookies
Las Cookies son una via estandar para que los navegadores web

puedan retener la informacidn correspondiente a una sesién. Por
ejemplo, si tu aplicacidon web tiene usuarios que se conectan
utilizando un UserID, puedes guardar el UserID como una cookie.
La préxima vez que abran la app web, puedes buscar la cookie v,
si esta disponible, rellenar el nombre UserlD automaticamente.

Asi es como defines el valor de una cookie:

Session.Cookies.Set("UserName", "BobRoberts")

Y asi es como recuperas el valor de una cookie:

Dim userName As String
userName = Session.Cookies.Value("UserName")

Etiquetas Hash

Las etiquetas Hash son un modo de identificar diferentes areas
de la aplicacién web. Las aplicaciones web siempre muestran el
mismo URL de navegador, incluso aunque navegues a diferentes
paginas web. Puedes usar la Etiqueta Hash para identificar las
diferentes paginas (o informacion) para que el usuario pueda
volver a ella posteriormente.

Las etiquetas Hash se escriben usando un caracter “#” como en:

http://www.mywebsite.com/#details

El evento Session.HashTagChanged se llama cuando se cambia
la etiqueta hash por el usuario. En este evento puedes obtener el
nuevo valor y elegir si navegas a una pagina diferente o bien
mostrar una informacion distinta.

Ajuste de Compilacion

La seccion Build Settings del Navegador contiene los ajustes
especificos de compilacion para tu aplicacién. Puedes activar la
casilla de verificacidon asociada a cada destino para compilar la
aplicacion para dicha plataforma.

Compartido

El Inspector para los ajustes compartidos (Shared) contiene estas
propiedades:

- Major Version: La versién Mayor de tu aplicacion. Los numeros
de versidn se escriben generalmente como 1.2.3.4, donde “1”
es la versidn mayor.

« Minor Version: La version Menor de la aplicacion. Los niumeros
de version se escriben generalmente como 1.2.3.4, donde “2”
es la version menor.
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http://www.mywebsite.com/#
http://www.mywebsite.com/#

Bug Version: La version de Bug para tu aplicaciéon. Los
numeros de version se escriben por lo general como 1.2.3.4,
donde “3” es la version de bug.

Stage Code: Usada para indicar el tipo de aplicacion que estas
compilando (Desarrollo, Alfa, Beta, Final).

Non Release Version: La version de No Revision (compilacion)
para tu aplicacion. Los niumeros de version se escriben
generalmente como 1.2.3.4, donde “4” es la version de No
Revision.

Auto Increment Version Info: Cuando esta a ON, la Versidn de
No Revisién aumenta su valor en uno cada vez que haces un
Build.

Short Version: Una breve descripcion de texto para tu
aplicacion. Por lo general contiene sélo el niUmero de version
(como por ejemplo 1.2.3.4) y es mostrada por algunos sistemas
operativos en las ventanas Obtener Informacion y Propiedades
de la aplicacion.

Long Version: Una descripcion de texto mayor para la
aplicacion. Por lo general contiene el nombre de la aplicacién,
el copyright, version y otra informacion. Esta se muestra por
algunos sistemas operativos en las ventanas Obtener
Informacion y Propiedades de la aplicacion.

- Package Info: Una descripcion de texto para tu aplicacién y

que puede ser mostrada por algunos sistemas operativos en las

ventanas de Obtener Informacion o Propiedades de la

aplicacion.

Use Builds Folder: Cuando
esta a ON, la compilaciones
se situan como una carpeta
adjunta al archivo de
proyecto. Cada plataforma
(OS X, Windows, Windows,
Linux) también genera su
propia subcarpeta dentro
de esta carpeta de
compilacion.

Include Function Names:
Cuando esta a ON, se
incluyen en la compilacion
de la aplicacién los
nombres reales de las
funciones. Esto es util con
propositos de depuracion y
para obtener las tramas de
la pila.

- Language: Te permite

Figura 6.6. Ajustes de
Compilacion Compartida.

Version

Major Version
Minor Version
Bug Version

Stage Code

Non Release Version

1

0

0

| Development 3 |

0

Auto Increment Version Info (‘ OFF
Short Version
Long Version
Package Info
Build
Use Builds Folder ‘
Include Function Names

Language
Deployment Type
Port

Application Identifier

Debug

| Default s |

[ Cal s

| Choose Aut... + |

com.example.my:

Command Line Arguments
Destination

Debug Port

N/A | 2]

8080
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indicar el lenguaje con el cual se resolveran las constantes
dinamicas.

- Deployment Type: Las aplicaciones web pueden desplegarse
como CGO o como aplicaciones autbnomas.

- Port: Selecciona el puerto especifico a usar para conectar con
la aplicacién web o deja que la aplicacion web seleccione
automaticamente el puerto.

« Application Identifier: Requerido para las aplicaciones CGl,
este es el identificador Unico para la aplicacion web.

« Command Line Arguments: Estos son los argumentos de la
linea de comandos pasados a la aplicaciéon cuando se ejecuta
en modo Depuracion.

- Destination: Indica la ruta en la que esta ubicada la aplicacion
cuando la ejecutas en modo Depuracién. Si no se indica,
entonces la aplicacion se situa junto con el archivo de proyecto.

« Debug Port: Este es el puerto usado cuando se ejecutas tus
aplicaciones web en modo Depuracion.
Nota: Si tienes dificultades depurando tus aplicaciones web,
asegurate de que el puerto de depuracién no esté siendo ya
utilizado por otra aplicacion.

Xojo Cloud

La seccién Xojo Cloud se utiliza para desplegar tu app web a tu
servidor Xojo Cloud. Puedes comprar un servidor Xojo Cloud en
la Xojo Store.

Application Name: El nombre de la aplicaciéon web. Tu app web
se desplegara en una carpeta con este nombre.

Server: El servidor Xojo Cloud sobre el cual realizar el
despliegue. Tendras que haber comprado un servidor Xojo
Cloud y estar conectado en tu cuenta Xojo para ver tus
servidores.

0SS X

La seccidon OS X te permite especificar los ajustes para las
aplicaciones OS X.

- Mac App Name: El nombre real del archivo para tu aplicacion
oS X.

Windows

La seccidon Windows contiene los ajustes de compilacion para tus
aplicaciones Windows.

« Windows App Name: El nombre de archivo real para la
aplicacion Windows.

« Company Name: En Windows 7, el “Nombre de Empresa”
aparece en la seccidn Copyright de las propiedades de la
aplicacién en la pestana Detalles.
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« Product Name: El nombre de producto tal y como se instala en Despliegue
el menu Inicio » Todos los Programas de Windows. Este Hay dos modos de desplegar tus aplicaciones web: Standalone y

también figura en “Nombre de producto” en la pestafia Detalles CGl.

de las propiedades de la aplicacion. _ - o
Nota: No has de preocuparte sobre la informacion de esta seccion si haces

) el despliegue con Xojo Cloud.
Linux

L . . G Standalone
La seccion Linux contiene los ajustes de compilacion para tus

aplicaciones Linux. Una aplicacion web Standalone o autonoma es una aplicacion

que ejecutas manualmente en tu servidor. Has de iniciar la
« Linux App Name: El nombre de archivo real para la aplicacion aplicacion (generalmente desde la linea de comandos) y dejarla
Linux. funcionando para que los usuarios puedan acceder a la
aplicacion web. Ademas, se accede a la aplicacion web
autonoma mediante un puerto, indicado cuando se compila la
app. Esencialmente, las aplicaciones web autbnomas consisten
tanto del servidor web como de la aplicacion web.

Una aplicacion web desplegada como autonoma presenta un
URL como el siguiente:

http://www.mywebsite.com:8080

Por lo general querras ejecutar una aplicacién web autbnoma en
segundo plano, y que puedes hacer en OS X o Linux ejecutando
la aplicacion web autobnoma como daemon. En Windows puedes
ejecutar tus aplicaciones web autbnomas como un servicio para
que funcionen en segundo plano.
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CGI

Una aplicacién web compilada para usar CGl (Common Gateway
Interface) utiliza un servidor web existente (generalmente Apache)
como su servidor web. El servidor web se comunica entonces
con tu aplicacién web usando CGl. Para facilitarlo, un guion Perl
asociado (suministrado al compilar la aplicacion) se encarga de la
comunicacion entre el servidor web y tu aplicacion web.

Algunos navegadores web (especialmente Safari) siguen
mostrando un indicador de carga incluso una vez que la pagina
ha terminado de cargarse. Este es el resultado del método
utilizado por el servidor web para comunicarse con tu aplicacion.

Dado que un despliegue CGl usa tu software servidor web
existente, no has de indicar un puerto cuando accedes a la tu
aplicacion web. Un URL tipico suele presentar esta forma:

http://www.mywebsite.com/cgi-bin/mywebapp.cgi

Plataformas

Tu aplicacién web puede compilarse para cualquiera de las
plataformas de escritorio. Cuando se trata de servidores web,
Linux es el sistema operativo mas utilizado, seguido de Windows
y finalmente de OS X.

LINUX

En una situacién completamente opuesta a lo que sucede en el
ambito del escritorio, la mayoria de los servidores web utilizan
algun tipo de Linux.

Para desplegar tu aplicacién web, esta ha de estar hospedad en
un servidor. Los dos tipos de alojamiento mas comunes son el
compartido y el VPS (Virtual Private Server). El hospedaje
compartido cuesta generalmente menos, pero también cuenta
con mas restricciones. La mayoria de los proveedores de
alojamiento comparido funcionan mejor con sitios web estaticos
o con herramientas preconfiguradas (como pueda ser WordPress)
y no permiten ejecutar en ellos, por lo general, aplicaciones de
proposito general. Raramente suponen una buena opcion para
una aplicacién web Xojo.

Tu mejor apuesta es el uso de un VPS (Virtual Private Server) para
alojar tus aplicaciones web. Un VPS te proporciona tu propio
servidor, generalmente ejecutando el servidor web Apache, con
sus propias specificaciones funcionando bajo una Maquina
Virtual (VM). Con un VPS tienes un control completo sobre el
servidor y su configuracion para ejecutar tus aplicaciones web
Xojo.

Dirigete a la documentacion en el wiki para obtener en todo
momento la informacion mas reciente sobre como configurar
adecuadamente el software servidor Apache para ejecutar
aplicaciones Web.
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WINDOWS

Los servidores web Windows utilizan principalmente IS
(Microsoft Internet Information Services). Los servidores Windows
son mucho menos comunes que los servidores Linux. También
hay menos proveedores de alojamiento que ofrezcan servidores
Windows y también suelen ser mas caros. IS también puede
resultar mas dificil de configurar en comparacion con Apache.

OS X

Los servidores web OS X utilizan generalmente Apache y su
configuracion es muy parecida a Linux. Hay incluso menos
servidores OS X que Windows, pero los servidores OS X pueden
ser mas sencillos de configurar. No hay muchas companias de
hospedaje conocidas que ofrezcan hospedaje OS X, pero si hay
varias que ofrecen servicios de housing, de modo que puedas
instalar tu propio hardware Mac para que actie como servidor.

Dirigete a la documentacion en el wiki para acceder a la
informacidn mas reciente con los detalles sobre la configuracion
de Apache para ejecutar aplicaciones Web.
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Seccion 3

Aplicaciones de Consola

A diferencia de las aplicaciones de escritorio y de las
aplicaciones web, las aplicaciones de consola no estan basadas
en eventos. Las aplicaciones de Consola no tienen interfaz de
usuario grafica y estan disefiadas para ejecutarlas desde el
terminal, linea de comandos o como proceso en segundo plano.

La Clase ConsoleApplication
La clase ConsoleApplication se utiliza para crear una subclase

que representa tu aplicaciéon. Cuando creas un nuevo proyecto
de consola, se afade automaticamente al proyecto una subclase
basada en ConsoleApplication. Esta es la clase App del
Navegador. El Inspector indica que su Super es
ConsoleApplication.

Si lo deseas, puedes crear una subclase de App.

Manejadores de Evento

La clase Application de una aplicacién de consola tiene
manejadores de evento. Estos son los siguientes:

« Run: Este es el manejador de evento que se llama cuando se
ejecuta la aplicacion, ya sea desde Xojo o cuando se ejecuta la

aplicacion compilada. Tu aplicacion sale cuando se abandona
el evento Run.

- UnhandledException: Se ejecuta cuando tiene lugar un error
no capturado por tu codigo. Este evento te proporciona una
“Ultima oportunidad” para atrapar los errores en tiempo de
ejecucion antes de que provoguen una salida inesperada de la
aplicacion.

Ambito de las Propiedades, Métodos y Constantes de la
Clase App

Puedes definir el ambito de las propiedades, métodos y
constantes de la subclase App usando las mismas reglas que se
aplican para cualquier clase (consulta el capitulo 5).

Necesitas una referencia a tu clase App para acceder a sus
propiedades, métodos y constantes publicos. La funcidn global
App te proporciona una referencia a la clase App de tu proyecto.
Si has creado una subclase de App en tu proyecto, entonces la
funcion App te proporciona una referencia a la subclase.
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De modo que para acceder a una propiedad publica desde
cualquier parte de tu proyecto, podrias escribir un cédigo como
este:

App.MyProperty

Aplicaciones en segundo plano
Las aplicaciones de Consola se usan con frecuencia para crear

aplicaciones en segundo plano. En OS Xy Linux, las aplicaciones
en segundo plano se denominan daemons (demonios). En
Windows, las aplicaciones en segundo plano se denominan
servicios.

Daemon

Para convertir tu aplicacion de consola en un daemon que pueda
funcionar en segundo plano, solo has de llamar al método
Daemonize de la clase ConsoleApplication.

También puedes utilizar el método Daemonize en OS X, pero
Apple preferira que utilices launchd para iniciar los procesos
daemon.

ServiceApplication

Para crear una aplicacion de consola que pueda funcionar como
servicio necesitaras usar la clase ServiceApplication. Cuando
creas una aplicacion de consola, cambia el Super de la App de
ConsoleApplication a ServiceApplication. De forma alternativa

puedes elegir ServiceApplication de entre las Plantillas en el
Selector de Proyecto.

Una aplicacidn de servicio te proporciona eventos adicionales
que te permiten gestionar cosas como el inicio del servicio, su
parada o finalizacién. Dirigete a la Referencial del Lenguaje para
obtener mas informacion sobre estos eventos.

Ajustes de Compilacion
La seccidn Build Settings del Navegador contiene los ajustes

especificos de compilacion para tu aplicacién. Puedes activar la
casilla de verificacidn asociada a cada destino para compilar una
aplicaciéon para cada plataforma.

Compartido

El Inspector para los ajustes Shared (compartidos) contiene las
siguientes propiedades:

- Major Version: La versién Mayor de tu aplicacién. Los niUmeros
de version se escriben generalmente como 1.2.3.4, donde “1”
es la version mayor.

« Minor Version: La version Menor de tu aplicacién. Los niumeros
de version se escriben generalmente como 1.2.3.4, donde “2”
es la versién menor.

- Bug Version: La version de Bug para tu aplicacion. Los
numeros de version se escriben generalmente como 1.2.3.4,
donde “3” es la version de bug.
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Stage Code: Usado para indicar el tipo de aplicacién que estas
compilando (Desarrollo, Alfa, Beta, Final).

Non Release Version: la versién No de Revision (compilacion)
para tu aplicacion. Los numeros de version se escriben
generalmente como 1.2.3.4, donde “4” es la version no de
revision.

Auto Increment Version Info: Cuando esta a ON, la version No
de Revision se incrementa en uno cada vez que haces una
compilacion (Build).

Short Version: Una descripcion de texto breve de tu aplicacion.

Generalmente esto contiene sélo el nimero de version (como
1.2.3.4) y se muestra por algunos sistemas operativos en las
ventana de Obtener informacién o Propiedades para la
aplicacion.

Long Version: Un texto de descripcidén mas largo para tu
aplicacion. Generalmente contiene el nombre de la aplicacion,
el copyright, la version y otra infofrmacion. Esta es mostrada
por algunos sistemas operativos en las ventana de Obtener
informacién o Propiedades para la aplicacion.

Package Info: Una descripcién de texto de tu aplicaciéon que
puede ser mostrada por algunos sistemas operativos en las
ventanas de Obtener informacion y Propiedades para la
aplicacion.

- Use Builds Folder: Cuando esta a ON, se crea una carpeta
adicional junto con el archivo de proyecto. Cada plataforma (OS
X, Windows, Linux) también crea su propia subcarpeta dentro
de esta carpeta de compilacion.

« Include Function Names: Cuando esta a ON, se incluyen los
nombres actuales de las funciones en la aplicacion compilada.
Esto es util con propdsitos de depuracion y para obtener las
tramas de la pila.

« Command Line Arguments: Estos son los argumentos de la
linea de comandos que se pasan a tu aplicacién cuando se
ejecuta desde Xojo.

- Destination: Indica la ruta donde se ubica la aplicacion
ejecutada. Normalmente se ubica junto con el proyecto, pero
puedes escoger una ubicacién diferente.

OS X

La seccion OS X te permite indicar los ajustes para las
aplicaciones OS X.

- Mac App Name: El nombre real del archivo para tu aplicacion
OS X.

Windows

La seccidon Windows contiene los ajustes de compilacion para tus
aplicaciones Windows.
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« Windows App Name: El nombre real del archivo para la
aplicaciéon Windows.

- Company Name: En Windows 7, el “Nombre de Empresa”
aparece en la seccidn Copyright de las propiedades de
aplicacion en la pestafa Detalles.

- Product Name: El nombre del producto tal y como se instala
en el menu Inicio » Todos los Programas. Esto también

aparecera en el “Nombre de Producto” en la pestafa Detalles
de propiedades de la aplicacién.

- Internal Name: Esto es Util cuando tu producto tiene un
nombre interno diferente sobre el nombre externo. Este no se
muestra en la pestana Detalles de las propiedades de la
aplicacion.

Linux

La seccidn Linux contiene ajustes de compilacion para tus
aplicaciones Linux.

- Linux App Name: El nombre de archivo real para tu aplicacion

Linux.

This Computer

La seccion This Computer te muestra los ajustes apropiados (OS

X, Windows o Linux) para la plataforma que estés utilizando en

ese momento. Por ejemplo, si estas usando Xojo en OS X,
entonces This Computer mostrara los ajustes OS X.

Despliegue
Las aplicaciones de Consola se despliegan instalandolas en un
ordenador y ejecutandolas en el ordenador.

Las aplicaciones de Consola tienen dos partes: el ejecutable
principal y sus librerias (contenidas en la carpeta Libs). Se
requiere de ambas partes para que funcione la aplicacion.

Puedes crear un archivo comprimido Zip para la aplicacion de
consola, facilitando asi su distribucion.
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Seccion 4

Aplicaciones iOS

Las aplicaciones iOS funcionan en dispositivos iOS como los
iPhone y iPad.

La clase IOSApplication

La clase IOSApplication se utiliza para crear una subclase que
representa a tu aplicacion iOS. Cuando creas un nuevo proyecto
iOS se afade automaticamente una subclase basada en la clase
IOSApplication. Esta es la clase App en el Navegador. El
Inspector indica que su Super es IOSApplication.

Si lo deseas, puedes crear una subclase de App.

Manejadores de Eventos

La clase Application para una aplicacién iOS tiene manejadores
de eventos. Estos son:

- LowMemoryWarning: Llamado cuando el iOS indica a tu app
que hay poca memoria. Tu app deberia de intentar liberar
memoria borrando cualquier caché o estructuras de datos que
puedan estar consumiendo una cantidad de memoria
significativa.

- Open: Llamado cuando se inicia la aplicacion.

« UnhandledException: Llamado cuando ocurre un error en
tiempo de ejecucidon que no ha sido tratado por tu cédigo. Este
evento te proporciona una “Ultima oportunidad” para atrabajo
los errores en tiempo de ejecucién antes de estos causen la
salida inesperada de la aplicacion.

Ambito de las Propiedades, Métodos y Constantes de Ia
clase App

Puedes definir el ambito de las propiedades, métodos y
constantes de la subclase App utilizando las mismas reglas que
se aplican para el resto de las clases (consulta el capitulo 5).

Necesitas una referencia a tu clase App para acceder a las
propiedades, métodos y constantes publicos. La funcion global
App te proporciona una referencia a la clase App en tu proyecto.
Si has creado una subclase de App, entonces la funcién App te
da una referencia a la subclase.

Por tanto, para acceder una propiedad publica desde cualquier
parte de tu proyecto, deberias escribir algo como esto:
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App .MyProperty

Figura 6.7. Propiedades de Aplicacion en el

Inspector.
ID
Name |App ‘
Super | IOSApplication | m
Interfaces |  Choose... |

a»

Default iPhone Screen | Screenl

a»

Default iPad Screen | Screenl

Pantallas

En el Inspector de la Aplicacion puedes especificar las pantallas
por defecto que utilizara la app cuando se ejecute sobre un
iPhone o iPad.

Una pantalla es un elemento de proyecto que indica el tipo de
plantilla y las orientaciones soportadas. Screen1 se afade al
proyecto por defecto. Puedes definir cualquiera de las pantallas
por defecto a None (pero no ambas) en el caso de que no quieras
una pantalla para ese dispositivo. Si defines Default iPhone
Screen a None entonces tu app no funcionara sobre un iPhone.
Si defines Default iPad Screen a None, entonces la app
funcionara en la pantalla del iPhone pero no en la pantalla del
iPad.

Figura 6.8. Disefno de Pantalla y las
propiedades de Orientaciones Soportadas.

Screen Layout

4

Content | Viewl

Supported Orientations
Portrait (Home on Bottom)

Landscape (Home on Left)

Landscape (Home on Right)

1384

Portrait (Home on Top)

Ver Pantallas

Cuando haces clic en la Pantalla (Screen) obtienes una
previsualizacién de como se veria en un iPhone en modo retrato.
Puedes cambiar el previo usando los botones de la barra de
herramientas, tanto para la orientacion como para el tipo de
dispositivo:

- Orientacion: Haciendo clic en el boton cambia entre retrato y
apaisado.

- Tipo de Dispositivo: Al hacer clic en “Device Type” muestra un
menu donde puedes elegir entre “View as iPhone” (ver como
iPhone) o “View as iPad” (ver como iPad).

En el Inspector puedes especificar el Disefio de Pantalla y las
Orientaciones Soportadas.
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Figura 6.9. Propiedades de Disefio de
Pantalla para el modo Split.

Screen Layout

a»

Content | Split

a»

Left (Main) | MasterView

a»

Right (Detail) | DetailView

Propiedades de Pantalla

El disefio de pantalla esta definido por defecto a View1, pero
puedes elegir cualquier otra Vista en tu proyecto. También
puedes elegir Split o Tabs:

SPLIT

Un Split se utiliza en los iPad en modo apaisado para mostrar un
area maestra a la izquierda y el area de detalle a la derecha,
similar a como funciona la app Mail.

Cuando eliges Split, se muestran dos propiedades adicionales en

el Inspector
(Left - . . L

Figura 6.10. Propiedades de Disefno de
Master y Pantalla para las Pestanas.
Right - Screen Layout
Detail). Content | Split :
Utiliza estas Left (Main) | MasterView s |

propiedades Right (Detail) | Tabs

a»

para indicar Tabs: | Edit |

qué ver en Right Tab 0 Content | Viewl

a»

cada seccioén

(Vistas o Pestanas). Si eliges Tabs, aparecen propiedades
adicionales (ver a continuacion).

TABS

Los Tabs son botones en la parte inferior de la pantalla y que se
pueden usar para mostrar otras vistas (Views) SplitViews. Cuando
seleccionas Tabs, se muestran las propiedades Tabs y Tab 0
Content en el Inspector. La propiedad Tabs tiene un boton Edit
sobre el que puedes hacer clic para acceder al Tab Editor. Aqui
puedes gestionar las pestanas a mostrar, incluyendo sus
nombres, orden e iconos. Haz clic en cada pestana de la Pantalla
para definir la vista (o SplitView) que deberia de mostrarse.

Orientaciones Soportadas

También puedes especificar las orientaciones validas para tu
pantalla. Estas son simplemente interruptores ON/OFF:

+ Portrait (Home on Bottom)

- Landscape (Home on Left)
- Landscape (Home on Right)
+ Portrait (Home on Top)

No todos los ajustes tienen sentido para tu app; de modo que
desactiva aquellos que no necesites soportar.
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Por ejemplo, si desactivas todo salvo “Portrait (Home on
Bottom)”, tu aplicacién no rotara la pantalla cuando se gire el
dispositivo.

Ajustes de Compilacion
La seccion Build Settings del Navegador contiene los ajustes de

compilacién especificos para la aplicacion. Puedes activar la
casilla de verificacion asociada a cada uno de los destinos para
los que quieras compilar.

Compartidos

El Inspector de ajustes Shared contiene estas propiedades:

- Major Version: La version Mayor de tu aplicacion. Los nUmeros
de version se escriben generalmente como 1.2.3.4, donde “1”
es la version mayor.

- Minor Version: La version Menor de tu aplicacion. Los nimeros
de version se escriben generalmente como 1.2.3.4, donde “2”
es la version menor.

- Bug Version: La versidn de Bug para tu aplicacion. Los
numeros de version se escriben generalmente como 1.2.3.4,
donde “3” es la version de bug.

- Stage Code: Utilizado para indicar el tipo de aplicacion
compilada (Desarrollo, Alfa, Beta, Final).

- Non Release Version: La version de No Revision (compilacion)

para tu aplicacion. Los numeros de version se escriben
generalmente como 1.2.3.4, donde “4” es la version de no
revision.

- Auto Increment Version Info: Cuando esta a ON, la Version de

No Revisién se aumenta en uno cada vez que haces una
compilacion (Build).

Short Version: Una descripcion de texto breve de tu aplicacion.
Generalmente esto contiene sdlo el nimero de version (como
1.2.3.4) y se muestra por algunos sistemas operativos en las
ventana de Obtener informacion o Propiedades para la
aplicacion.

Long Version: Un texto de descripcidn mas largo para tu
aplicacion. Generalmente contiene el nombre de la aplicacion,
el copyright, la versidn y otra infofrmacion. Esta es mostrada
por algunos sistemas operativos en las ventana de Obtener
informacién o Propiedades para la aplicacion.

Package Info: Una descripcion de texto de tu aplicacién que
puede ser mostrada por algunos sistemas operativos en las
ventanas de Obtener informacién y Propiedades para la
aplicacion.

Use Builds Folder: Cuando esta a ON, se crea una carpeta
adicional junto con el archivo de proyecto. Cada plataforma (OS
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X, Windows, Linux) también crea su propia subcarpeta dentro FIRMADO DE CODIGO

de esta carpeta de compilacion. . Team: Aqui puedes indicar el Team que tiene los Provisioning

« Include Function Names: Cuando esta a ON, se incluyen los Profiles para desplegar tu app.

nombres actuales de las funciones en la aplicacién compilada. - Entitlements: Indica un archivo plist que contiene los

Esto es util con propdsitos de depuracion y para obtener las entitlements para tu app.

tramas de la pila.

- Build for App Store: Activa esta opcion para crear un archivo

- Command Line Arguments: Estos son los argumentos de la IPA (i0S App Archive) para su envio a la App Store mediante

linea de comandos que se pasan a tu aplicacion cuando se iTunes Connect.

ejecuta desde Xojo.

DEPURACION 10S

- Destination: Indica la ruta donde se ubica la aplicacion

_ o - Simulator Device: Selecciona el tipo de dispositivo en el
ejecutada. Normalmente se ubica junto con el proyecto, pero

N Simulador e inicia la depuracion.
puedes escoger una ubicacion diferente.

i0OS
La seccion iOS te permite especificar ajustes para la app iOS.

- i0OS App Name: El nombre real de la aplicacién iOS. Este es el
nombre que aparece en el icono del Springboard.

- Bundle Identifier: El identificador de bundle utiliado por iOS
como descriptor Unico de tu aplicacion. Se indica generalmente
como un nombre de dominio inverso, como en
com.xojo.myapplication. Este debe usar tu App ID para la
distribucion en la App Store.
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Seccion 5

Editor de Codigo

Icon Editor
El editor de icono se utiliza para afiadir iconos a la aplicacion.

Las aplicaciones web utilizan el icono como parte de su pantalla
de carga.

] _ Para abrir el Editor de Icono,
Figura 6.11. El Ajuste

de Icono en el Inspector. selecciona el objeto App en el

D Navegador y selecciona a
Name |App l continuacion el icono en el
Super lAppIication |v] |nSpeCt0r.
Scope | :
interfaces Cuando abres el Editor de Icono,
Appearance
una ventana muestra los
DefaultWindow | Windowl =
MenuBar | MainMenuBar ;) diferentes tamanos de los iconos.
on Puedes arrastrar archivos de

icono a dichas areas para definir

el icono para dicho tamano.
También puedes copiar y pegar iconos entre los tamanio,
escalandose automaticamente para ti.

Usa el control Images/Masks/Preview para mostrar los diversos
componentes de las imagenes de icono. Si arrastras un icono

Figura 6.12. Editor de Icono.

@

48 (32 bit)

128

32 (32 bit)

16 (32 bit)

que tiene tanto la imagen como la mascara (como ocurre en la
mayoria de los archivos PNG), entonces se afiaden tanto la
imagen como la mascara.

Para obtener mejores resultados, asegurate de afadir iconos (y
mascaras) para cada uno de los tamanos disponibles. Diferentes

199



plataformas utilizan tamanos diferentes. Los iconos no
apareceran en algunas plataformas si falta la mascara.

También puedes arrastrar un archivo ICNS sobre el fondo de la
ventana (en vez de sobre el area de imagen) para cargar y poblar
todos los tamanos de imagen de una vez.
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